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1 What's new?

Geographic Imager is a powerful suite of tools and functions for Adobe Photoshop that

enables spatial imagery to be opened, edited, transformed and saved while retaining all

the spatial properties of the image. Geographic Imager expands the amount of formats

Adobe Photoshop is able to open. In addition to ensuring a safe and trouble-free

editing environment for your geospatial images, Geographic Imager offers specialized

tools for performing spatial operations on the image beyond the standard Adobe

Photoshop image editing tools. Geographic Imager provides smart support for most

image level operations and tracks the changes made to images while updating the

reference information accordingly.

Geographic Imager 5.0 is a full release that includes support for Adobe Photoshop CC

2015, enhanced functionality, stability improvements, and additional format support.

Geographic Imager 5.0 introduces many new features. Export your images to map

packages that are compatible with the PDF Maps app with an option to upload them

directly to the PDF Maps Store in only a few steps. A new Event Log captures

operations, errors, and messages. Most Geographic Imager tools link directly to a new

and interactive online help system.

Other enhancements in Geographic Imager 5.0 include a redesigned Georeference tool

that makes it easier to reference or rectify images, redesigned Geographic Imager

preferences with new options, and higher quality web tiles created by Export to Web

Tiles feature. You can now export to BIL and ArcInfo ASCII Grid formats.

The following summarizes new features and enhancements in Geographic Imager 5.0:

Adobe Photoshop Creative Cloud 2015 support

Fully compatible with Geographic Imager 5.0 for Adobe Photoshop Creative Cloud

2015.

Georeference

Redesigned Georeference tool includes the ability to interactively match control

points with world coordinates from a web map. New ability for the Georeference

tool to detect appropriate image coordinate systems depending on requirement to

reference or rectify the image.
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Additional export formats

Included BIL and ArcInfo ASCII Grid as export DEM formats.

Online help 

New Geographic Imager help system is now online. Browse help topics for tools,

features, and tutorials using an interactive web interface. Most Geographic Imager

dialog boxes now link directly to help topics. Help files are also available locally.

Export and Upload to PDF Maps

New ability to export a map package compatible with the PDF Maps app and upload

it directly to the PDF Maps Store.

Event Log

New ability to record Geographic Imager operations, errors, and messages to an

event log.

Mosaic options

New mosaic options including ability to apply blending mode and place mosaic

layers above destination layer.

Web Tiles optimization

Export to Web Tile optimized and with higher quality. Now includes Adobe

Photoshop image interpolation methods and support for OpenStreetMap and TileMill

formats.

Scripting

Enhanced scripting support now includes WMS import.

Redesigned Geographic Imager Preferences

New Geographic Imager Preferences interface.

And more...

Various bug fixes and user experience enhancements.
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2 Introduction

Geographic Imager 5.0 is the latest version of Avenza's mapping plug-in for the

desktop graphics environment of Adobe Photoshop.

Combined with Adobe Photoshop, Geographic Imager revolutionizes the way spatial

imagery is created, edited and maintained by allowing spatial image files to be created,

edited and managed in the familiar and widely-used Adobe Photoshop environment.

Geographic Imager allows the most common spatial imaging tasks to be performed

where they should be done, in a powerful raster editing environment, and adds the

dozens of powerful Adobe Photoshop tools and operations to those that one can

perform on such imagery.

Geographic Imager is comprised of a series of geospatial tools for Adobe Photoshop

that will continually improve on each previous version by adding additional file support,

tools and improvements to existing tools. Geographic Imager is also the perfect

companion suite for MAPublisher and Adobe Illustrator users.

This help system assumes that you are familiar with Adobe Photoshop and have at

least a basic understanding of geographic information systems (GIS) terminology and

concepts. Refer to your Adobe Photoshop user guide for more information on using the

features of Adobe Photoshop. Refer to the Avenza Projections Guide for more
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information on the projections supported in Geographic Imager (the guide is included in

the Help and Tutorial Data folder).

By referring to this help system, you'll learn how to work with spatial imagery using the

Geographic Imager tools in Adobe Photoshop. This help covers the concepts necessary

to open, edit, and save spatial images with Geographic Imager. A variety of sample

spatial images have been included with the installation of Geographic Imager for use

with the help and tutorials. You're encouraged to experiment with your own data to

gain additional experience with Geographic Imager tools and functions.

2.1 Features Overview

The following is a brief overview of the features and tools included in Geographic

Imager.

Open/Save spatial imagery

When opening geographic imagery, Geographic Imager automatically recognizes GIS

raster formats and attempts to locate matching reference files. This information is

displayed in the Geographic Imager panel. When saving a geographic image using

the native Adobe Photoshop save commands, Geographic Imager automatically

creates a corresponding reference file or GeoTIFF header information. All Adobe

Photoshop image export formats are supported by Geographic Imager including the

native Adobe Photoshop PSD format and the Adobe Acrobat PDF format. Most

formats other than GeoTIFF will be referenced using an external reference file (e.g.

a world file). Certain image formats such as MrSID, JPG2000 and DEMs cannot be

opened by Adobe Photoshop without Geographic Imager installed. Certain formats

cannot be saved to their original format and must be saved to another format such

as GeoTIFF. Learn more about Opening Spatial Images.

Transform

Geographic Imager uses GeoTransform technology, a sophisticated image

reprojection engine, that includes extensive support for thousands of geodetic and

projected coordinate systems that allow spatial imagery to be projected and

transformed in Adobe Photoshop. Support for customized projections as well as the

ability to save custom definitions for later use is also included. Learn more about 

Transforming Spatial Images.

Georeference and rectify images
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Geographic Imager adds a world coordinate grid to the page and pixel grid systems

native to Adobe Photoshop. It allow you to create and maintain image-to-world

relationship throughout Adobe Photoshop operations so that the correct

georeferencing is preserved when saving images. Specifically, Geographic Imager

provides smart support for most image level operations, such as crop and resize,

and tracks the changes to the image geometry, updating the reference information

accordingly. Geographic Imager allows the referencing of non referenced images,

rectification and image correction using known control points by the pixel value,

geodetic coordinate, and projected coordinate. Learn more about Georeferencing

Images.

Tile

Geographic Imager allows Adobe Photoshop to automatically divide or tile spatial

imagery into multiple smaller spatial images while retaining the georeferencing

properties in each smaller image. Multiple options are available for determining how

the tiled images will be created. Learn more about Tiling Images.

Mosaic

Geographic Imager allows Adobe Photoshop to automatically combine multiple

geographic images to create image mosaics while retaining the georeferencing

properties in the new larger image. Create a seamless image from individual image

files. Learn more about Mosaicking Images.

GeoCrop

Use GeoCrop to crop georeferenced images based on defined crop areas. A very

useful tool to trim images to an area of interest. Learn more about GeoCropping

Images.

Advanced Import

Advanced Import can import multiple files of differing types and includes many tools

including crop/resample, channel management, DEM Schema, Mosaic. Learn more

about Opening Images with Advanced Import.

DEM Schema

DEMs provide an effective method of storing information for a continuous surface.

DEM data needs to be rendered so it can be displayed visually. Depending on what

type of DEM data it is and how it should look, the type of rendering schema needs

to be customized or automatically assigned. Also, support for elevation display and
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mosaicking of DEM images imported with the same schema. Learn more about 

Opening DEMs.

Terrain Shader

The Terrain Shader tool dynamically applies terrain shading and color maps to

digital elevation models within Adobe Photoshop. Import a DEM and easily and

quickly apply colours and shades based on elevation and even apply a specific light

source position and intensity to achieve a specific shading effect. Easily generate

custom colour maps or import existing Adobe Photoshop gradients to use as colour

maps. Learn more about Terrain Shading DEMs.

Channel Management

Geographic Imager Channel Management allows you to control channel mapping and

assignment of channel color roles for false-composite multiband imagery. Learn

more about Channel Management.

Automate Tools

All Geographic Imager commands are fully compatible with scripts and actions.

Easily create custom scripts and actions to automate repetitive tasks. Geographic

Imager JavaScript functions can be fully configured with comprehensive

parameters. Learn more about Automating Geographic Imager.

Export to many geospatial formats

Geographic Imager is able to save to all supported Adobe Photoshop image file

formats. When saving a georeferenced image to a non-geospatial format (e.g.

JPEG), Geographic Imager creates an external reference file (e.g. World File).

Geographic Imager can also save to files that contain internal reference, such as:

GeoTIFF, BigTIFF, DEM TIFF, Geospatial PDF, ERDAS IMAGINE Raster, ECW, MrSID,

and NITF. See more about supported spatial image formats. Learn more about 

Exporting Spatial Images.

Export to PDF Maps

Use Export to PDF Maps to generate map packages and directly upload them to the

PDF Maps Store, an in-app map store for the PDF Maps app on iOS, Android, and

Windows Phone. The quickest way to get maps from the desktop to mobile. Learn

more about Exporting to PDF Maps.

Licence management
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Easily manage license options including commercial, academic, multi-user and

floating. Activation maintains customer privacy and does not change the terms of

the existing Product License Agreement.

Geographic Imager offers a floating license option which enables licenses to be

shared across a network by multiple users. In such a scenario, the Geographic

Imager client software can be installed on an unlimited number of computers while

concurrent use is limited by the number of floating licenses purchased. This multi-

platform solution offers support for Windows, Mac and Linux servers alike and

includes the ability to check-out a license for remote use on a laptop computer as

well as Internet-enable access for remote users. Floating licenses are a wonderful

cost-effective way of sharing software amongst multiple users in a network

environment. Learn more about License Management.
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3 Getting Started

Before using Geographic Imager please read this section thoroughly to ensure that you

have a suitable hardware setup, become familiar with the installation and licensing

procedure, and adequately prepare your workspace. In particular, review the

Compatibility with Adobe Photoshop section to ensure your system is 

Topics covered in this section

System Requirements

Compatibility

Installing Geographic Imager

License Management

The User Interface

Uninstalling Geographic Imager

3.1 System Requirements

Before installing Geographic Imager, ensure that these minimum system requirements

are met (recommended requirements are mentioned as necessary):

Windows

Adobe Photoshop CS6 / CC 2014 / CC 2015 (all including 64-bit)

2 GHz or faster Intel Pentium 4 processor (Intel Core 2 Duo or better recommended)

Windows 7 or Windows 8 (compatible with 64-bit versions)

4 GB RAM (8 GB or higher recommended)

300 MB of available hard-disk space for installation

DVD-ROM drive (for DVD version)

1024x768 display (1280x800 recommended)

Mac
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Adobe Photoshop CS6 / CC 2014 / CC 2015

Multicore Intel processor

Mac OS X 10.8 or higher

4 GB of RAM (8 GB or higher recommended)

300 MB of available hard-disk space for installation

DVD-ROM drive (for DVD version)

1024x768 display (1280x800 recommended)

 Adobe Photoshop CS5 and CC are officially deprecated in Geographic

Imager 5.0. 

 Mac OS X 10.7 is officially deprecated and Windows XP and Windows

Vista are officially unsupported in Geographic Imager 5.0.

 Not all foreign language versions of Adobe Photoshop may be supported.

Contact support@avenza.com for more information.

Memory Recommendations

Occasional Users

A minimum of 4 GB RAM is required. These are graphics or GIS users who use

Geographic Imager with medium sized data sets including some low-resolution or

small coverage raster images.

Power Users

The recommended memory for a power user is 8 GB RAM or more. These are

professional cartographers and GIS users who use Geographic Imager daily and

works with large image files.

Memory Usage

Why is so much RAM needed to operate Geographic Imager? Adobe Photoshop
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requires a significant amount of RAM itself in order to run smoothly. In addition,

image data sets are often large which increases the need for RAM even further.

Image data sets contain raster data which must be stored in memory. Since

Geographic Imager is adding georeferencing properties to Adobe Photoshop, this

increases the file size, which increases the RAM requirements. In addition, Adobe

Photoshop loads the entire file into memory rather than just reading it from disk,

thus more RAM memory is required.

When importing a large number of files into Adobe Photoshop using Geographic

Imager, notice that the amount of available memory will decrease rapidly and the

computer may lose performance. This is due to the memory management.

Geographic Imager reserves a fairly large amount of memory for each action, which

may not properly returned when the procedure is done. The solution is simple: save

your file, close it and open it again. It’s not even necessary to close Adobe

Photoshop itself. By closing the file, the reserved memory is properly returned.

Memory Saving Tips

Many raster data files are large and when a series of such files is opened, you may

find that the program starts to run more slowly. This is because scratch and

memory allocations are being used up. The best solution is to periodically save your

work, quit out of Adobe Photoshop and then restart. This will free up the available

scratch memory.

The minimum number of undos can be reduced (since they all reside in memory).

You can set a primary and secondary scratch disk in Adobe Photoshop Preferences

(menu Edit > Preferences > Performance) in order to draw additional storage from a

partitioned or multi-drive environment.

3.2 Compatibility

Geographic Imager 5.0 is compatible with Adobe Photoshop CS6, CC 2014, and CC

2015. If you are running multiple versions of Adobe Photoshop on your system, please

ensure that you have installed Geographic Imager to the appropriate Adobe Photoshop

plug-ins folder(s).

 Adobe Photoshop CC 2014 (2014.1 and 2014.2) for Mac has a
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compatibility issue with Geographic Imager. We recommend using Adobe

Photoshop CC 2015 for Mac which is fully compatible. More information can

be found at http://www.avenza.com/support/compatibility/gi-cc.

The operations of concern are primarily the ones that affect the image size, pixel size

and orientation of the image. Most of the Adobe Photoshop functions that are involved

in these operations, such as Crop, are supported. Pixel-level operations, including the

majority of plug-ins (e.g. cut and paste), are transparent to Geographic Imager and

are assumed not to modify georeferencing. These operations are treated as simple

image modifications.

Every attempt has been made to ensure compatibility with Adobe Photoshop. Avenza,

as third-party developers, acknowledges that due to various limitations within the

Adobe Photoshop development environment, certain notifications and parameters are

unable to be received from several native Adobe Photoshop operations. There are also

a limited number of procedures within Adobe Photoshop that, when invoked, may

adversely affect the georeferencing of a spatial image. A warning message will be

displayed whenever an operation is performed and may cause data loss, render

georeferencing invalid, closes a document without saving, or in any other way may

silently affect the georeferencing of the image document.

Unsupported Tasks and Operations

The following native Adobe Photoshop tasks or operations are not supported by

Geographic Imager and may damage image georeferencing if performed.

Task or Operation Description

File > Save for Web

and Devices

Save for Web and Devices will create new

files without any georeferencing.

File > Export >

Export As

Export As will create new files without any

georeferencing.

File > Export >

Quick Export as

PNG

Quick Export as PNG will create new files

without any georeferencing.

http://www.avenza.com/support/compatibility/gi-cc
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Task or Operation Description

File > Generate >

Image Assets 

(Adobe Photoshop

CC)

When enabled, the Adobe Generator will

create new files without any georeferencing.

Image > Reveal All Reveal is not supported and will result in lost

georeferencing.

Image > Trim

(Partially

supported)

Trim works in modes when pixels are trimmed

only in one horizontal and/or one vertical

direction (e.g. top and left is acceptable, but

top and bottom is not). To perform trim for all

directions, trim top and left first, followed by

bottom and right.

Select > Focus

Area

Output To option set to New Document

creates a new file without any

georeferencing.

Save on application

Quit (Mac only)

This issue only affects CC 2014.1 and 2014.2.

Due to an existing bug in Adobe Photoshop,

modified georeferenced images will not retain

spatial referencing when quitting the

application and saving when prompted. It is

recommended to save all modified

georeferenced files prior to quitting the

application. More information can be found

at http://www.avenza.com/support/

compatibility/gi-cc.

Measurement The Measurement feature is not available in

Photoshop CS6. It is only available on

Photoshop CS6 Extended or higher.

Unsupported Automate Tools: Scripting and Actions

The following Adobe Photoshop scripts or actions are not supported by Geographic

Imager and may damage image georeferencing if performed.

http://www.avenza.com/support/compatibility/gi-cc
http://www.avenza.com/support/compatibility/gi-cc
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Script or Action Description

File > Automate >

Batch (Limitation)

When the Destination drop-down list is

Folder, the new image will not be

georeferenced.

File > Scripts >

Script Event

Manager

Performing actions or scripts that change the

document’s geometry using the Script Event

Manager are not supported and will not

update georeferencing. Instead, run the

script from the Actions panel or run it directly

(choose File > Scripts > Browse).

Action Panel >

Insert Menu Item

Insert Menu Item from the Actions panel will

create incorrect results with some menu

items.

File > Import >

Geographic Imager:

Advanced Import

Accessing Advanced Import through the File

menu is not recordable by an Action.

Document

switching

(Limitation)

Recording document switching actions

(through the Window menu or pressing Ctrl

+Tab or Command+Tab) may cause incorrect

results when using a combination of

Geographic Imager tools such as

Georeference and Mosaic.

When using any automate tools, Adobe Photoshop must already be open to ensure

correct functionality. In some cases the script will trigger events before Adobe

Photoshop has been initialized and the event will not be registered by Geographic

Imager. This could result in the georeferencing not being updated. 

If starting a debug session with Adobe ExtendScript Toolkit (by holding the Alt or

Cmd (Mac) key during Adobe Photoshop startup), Adobe Photoshop will need to be

restarted to fully initialize Geographic Imager.

To record Geographic Imager events using ScriptListener or actions, choose File >

Automate > Geographic Imager [function] instead of using Geographic Imager panel

buttons and menu items. Due to Adobe Photoshop API limitations, Geographic
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Imager functions triggered by the panel will not be recorded.

Due to Adobe Photoshop API limitations, Geographic Imager does not automatically

read georeferencing from a geospatial PDF when it is opened using a script or

action.

The File > Automate > Create Droplet function is supported when: the destination

set to none and the destination is save and close. At this time, it is not supported

when the destination is saving to a folder.

Other Special Notes

The following are some additional compatibility and procedural notes to be aware of in

order to properly and effectively use Geographic Imager.

Transforming Coordinate Systems

When transforming an image the background layer will be converted to a layer.

This may introduce transparency so when saving to a format that doesn’t

support transparency be aware the image will be flattened.

Transformations always results in a north-up affinely referenced image.

Multiple transformations may introduce an accumulative loss of precision due to

the resampling needed when transforming images. It is recommend to transform

images only once to the final source coordinate system. To avoid this problem,

keep a copy of the original image if it will be needed in another coordinate

system.

In order for Geographic Imager to interpret all transformation parameters it may

be necessary to maintain the ArcGIS exported AUX file and store it in the same

location as the ARC generated GeoTIFF file. Not including the AUX file may result

in WKT parsing errors.

An image transformed into Azimuthal Equidistant (spherical) may be recognized as

"none" when opened in ArcGIS because of a conflict between the ellipsoidal and

spherical datums. Furthermore, when an image in WGS84 is transformed into

WGS84/Azimuthal Equidistant in ArcGIS, it actually uses a spherical datum.

Georeferencing
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Geographic Imager continuously maintains the proper georeferencing information

for all georeferenced image files throughout the duration of the Adobe Photoshop

session, as well as during a Save procedure. Documents may become implicitly

georeferenced upon the file open process if Geographic Imager can locate proper

georeferencing information (reference file with same name as opened image).

Geographic Imager continuously maintains the proper georeferencing information

for all georeferenced image files throughout the duration of the Adobe Photoshop

session, as well as during a Save command. Documents may become implicitly

georeferenced upon the file open process if Geographic Imager can locate proper

georeferencing information. For example, a GeoTIFF stores georeference

information internally as metadata within a header while other formats store

georeference in an external reference file. When using an external reference file

(e.g. TFW or JGW world file) the associated image should have the same name.

Otherwise the external reference file can be specified manually.

Coordinate system information can not always be stored in the reference file.

World files only contain image reference data and will never maintain the

coordinate system. Some projections and coordinate systems are not supported

in GeoTIFF. MapInfo TAB files also contain the same limitation and in absence of

the coordinate system information some MapInfo-based program may in fact

assume WGS 84 Coordinate System. ER Mapper ERS files must contain an ER

Mapper identifier within the coordinate system definition to save the coordinate

system with the file. See more about spatial image formats.

Blue Marble RSF and MapInfo TAB files save the complete reference (point list

information) so that it can be loaded again in the future. Esri world files contain a

computed relationship between the source image coordinates and the reference

coordinates and not the complete reference point information, therefore,

reference points cannot be reloaded from an Esri World file. When an Esri world

file is loaded into the reference point list the four corners of the source image are

recalculated using the world file parameters, and displayed as reference points. If

you’d like to keep the original point list, it is recommended to save a MapInfo TAB

file so that the raw reference point information can be recalled at a later date.

New documents created within Adobe Photoshop are never georeferenced unless

they are based on georeferenced documents. However, in cases where a new

document has been created, a reference file for the newly created document

may be specified or created using Geographic Imager.
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When rotating an image in GCP mode, all control points will be lost. A warning will

appear when attempting these operations: Crop with rotate, Rotate, Image Size,

Transform, and Advanced Import / Resample.

Color Modes

Most color modes are supported for Geographic Imager operations, however,

when exporting files some formats only support certain color modes.

Support for the various image color modes available within Adobe Photoshop are

identical across the various functions and operations available in Geographic

Imager except as indicated below.

Support for transforming 32-bit per channel images is currently limited while work

continues to expand 32-bit per channel support within Geographic Imager. User

experiences may vary depending upon image sources and workflows. Contact

Avenza for more details.

With color modes that are not supported by all of Geographic Imager operations,

the bit per channel information will not be displayed on the panel (e.g. Bitmap,

Indexed color and multichannel) and the appropriate buttons will be disabled.

Mosaicking

Adobe Photoshop allows for duplicate layer names. Therefore, if an image is

mosaicked multiple times new layer groups will be generated with the same name

within Adobe Photoshop.

Adobe Photoshop start-up

It is not recommended to use Alt+Tab keyboard command (Option + Tab for Mac)

to switch between programs during Adobe Photoshop start-up. Geographic

Imager runs a series of scripts that can be interrupted by the Adobe Photoshop

debugging tool if this command is used. Using these keys during start-up may

interrupt normal application execution and even cause the application to appear

unresponsive.

Save Adobe PDF

Modifying settings in the Save Adobe PDF dialog box may trigger error messages
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or may generate a corrupt PDF file. It is recommended to use Quick Save To

Format. If necessary, use Adobe Acrobat to adjust PDF document properties

(e.g. description, security, etc.).

Saving documents in background (CS6 only)

Adobe Photoshop CS6 has the ability to save documents in the background.

Geographic Imager supports this feature, however, georeferencing may not be

stored when saving a document "as a copy". This may affect additional third-

party format writers and the Adobe JPEG2000 writer. If you’re experiencing

Geographic Imager warnings about reference not being stored, you may want to:

1) change your workflow to avoid renaming files on save; 2) choose a different

file format; or 3) disable saving in background (Preferences -> File Handling).

Opening multiple files using Open With (CS5 only)

Due to an Adobe Photoshop CS5 limitation, Geographic Imager cannot open

multiple files using the Open With shortcut. Instead, use File > Open, drag and

drop, or Advanced Import.

Compatibility with MAPublisher and Other Applications

MAPublisher for Adobe Illustrator

Geographic Imager ability to transform images is a compliment to MAPublisher which

can't transform images. Most image formats exported from Adobe Photoshop using

Geographic Imager are compatible with Adobe Illustrator using MAPublisher.

However, some features such as channels are not supported and should be avoided

when creating images for use with MAPublisher.

The two environments employ slightly different methods for handling, encoding, and

reading GeoTIFF headers and world files. In some rare instances, the

georeferencing data created by Geographic Imager may be incorrectly interpreted

by MAPublisher. In severe cases, the image may not be properly registered within

Adobe Illustrator even after being recognized as a GeoTIFF. It is recommended to

export a world file from Geographic Imager and use it for image registration in

MAPublisher if GeoTIFF proves difficult or unsuccessful.

The Adobe Photoshop Export > Paths to Illustrator function creates an Adobe
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Illustrator file. To achieve compatibility with MAPublisher, Geographic Imager

creates an RSF file upon export. Use the New MAP View for Photoshop Paths in

MAPublisher to create a new MAP View based on the exported Adobe Illustrator file

and RSF.

Other Third-party Plug-ins

All efforts have been made to develop and engineer Geographic Imager in

accordance with the Adobe Photoshop SDK and third-party development schema.

However, Avenza cannot verify and validate compliance and compatibility with

other third-party plug-in products that may be installed on any particular system

and cannot guarantee that the use of Geographic Imager will perform as expected

in such environments and will not clash with other plug-ins. Furthermore, Avenza

can neither confirm nor guarantee that the use of any particular third-party plug-

in, action or script will not damage the georeference data of any spatial image in

use with Geographic Imager.

When third-party plug-ins are installed to read the same files as Geographic

Imager, conflicts in reading image formats may occur. It is recommended to disable

or remove third-party plug-ins before using Geographic Imager.

The use of any other third-party plug-in that in any way alters the geometry of a

georeferenced image will damage the georeferencing of the image due to the fact

that Geographic Imager has no way of knowing a) that the other plug-in exists; b)

that it has been invoked; and c) what it has actually done to the image.

In most instances third-party plug-ins that do not alter the geometry of the image

will not have an adverse effect on image georeference data.

Reset Adobe Photoshop Preferences

If you experience uncommon or abnormal results with Adobe Photoshop, try deleting

the Adobe Photoshop preference file, Adobe Photoshop [version] Prefs.psp. To do

this, hold the Ctr+Alt+Shift (Option+Command+Shift for Mac) keys immediately on

Adobe Photoshop start-up. Alternatively, manually delete the preference file. A new

preference file will be generated the next time Adobe Photoshop is run. The

preference file is located in:

Windows 7/8: C:\Users\[user]\AppData\Roaming\Adobe\Adobe Photoshop [version]

\Adobe Photoshop [version] Settings
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Mac OS X: /Users/[user]/Library/Preferences/Adobe Photoshop [version] Settings

3.3 Installing Geographic Imager

Geographic Imager is licensed for use on a single computer and, once activated, will be

node-locked and will only function on that computer. Therefore, before proceeding

with installation and activation, ensure that Geographic Imager is installed on the

appropriate computer.

Only one version of Geographic Imager can be installed at a time even if different

versions of Adobe Photoshop are installed.

Windows

1. Make sure that a compatible version of Adobe Photoshop is installed on your

computer. If Adobe Photoshop is running, exit the program.

2. Ensure that you have administrative privileges for the installation process. If you

are unsure whether you have the proper privileges, please consult with your IT

department.

Downloaded version: Extract the contents of GI50win.zip. When you have

unzipped the files, proceed to the Geographic Imager directory and double-click 

Setup.exe.

DVD version: Insert the Geographic Imager DVD into your DVD-ROM drive. If

Autorun is disabled on your system, navigate to the Geographic Imager for

Windows directory on the DVD, and double-click Setup.exe.

3. Proceed through the installation screens as instructed. Note that you will have

options to install documentation and tutorial data. If you choose to install these

components these files can be subsequently be found in the \Program Files\Avenza

\Geographic Imager directory. Additionally you may access the documentation from

the Windows Start menu (All Programs > Avenza > Geographic Imager folder).

4. Launch Adobe Photoshop. See the License Management section for product

activation details.
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 The Lizardtech GeoExpress 8 installer is only available for 64-bit versions

of Windows. This install is required only if you need to export to MrSID

format.

Mac

1. Make sure that you have a compatible version of Adobe Photoshop installed on

your computer. If Adobe Photoshop is running, exit the program.

2. Ensure that you have administrative privileges for the installation process. If you

are unsure whether you have the proper privileges, please consult with your IT

department.

Downloaded version: Mount the GI50mac.dmg file if this operation has not

been completed automatically. Then proceed to the Geographic Imager 5.0

mounted disk image and double-click Geographic Imager Installer 5.0.pkg.

DVD version: Insert the Geographic Imager DVD into your DVD-ROM drive.

Navigate to the Geographic Imager for Mac directory on the DVD, and double-click 

Geographic Imager Installer 5.0.pkg.

3. Proceed through the installation screens as instructed. Note that documentation

and tutorial data may also be installed at your option. After installation, these files

can be found in the /Applications/Avenza/Geographic Imager directory.

4. Launch Adobe Photoshop. See the License Management section for product

activation details.

Geographic Imager License File Directory

The Geographic Imager license file must be located as follows:

Windows 7/8 (32-bit and 64-bit)

C:\ProgramData\Avenza\Geographic Imager

Mac

/Applications/Avenza/Geographic Imager/Geographic Imager Plug-In
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* English versions only. Location may differ in other Adobe Photoshop language

versions.

Geographic Imager Help and Tutorial Files

Help and tutorial files are installed in the following locations:

Windows 7/8 (32-bit and 64-bit)

Help: C:\Users\Public\Documents\Avenza\Geographic Imager\Help and Tutorial Data

\

Tutorial files: C:\Users\Public\Documents\Avenza\Geographic Imager\Help and

Tutorial Data\Tutorial Data\

Sample Scripts: C:\Users\Public\Documents\Avenza\Geographic Imager\Help and

Tutorial Data\Tutorial Data\Sample Scripts

Mac

Help: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Help and

Tutorial Data

Tutorial files: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/

Help and Tutorial Data/Tutorial Data

Sample Scripts: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-

in/Help and Tutorial Data/Tutorial Data/Sample Scripts

Adobe Photoshop Plug-Ins Directory

The Geographic Imager plug-in is installed in the following directory:

Windows 7/8:

English: C:\Program Files\Adobe\Adobe Photoshop [CS version]\Plug-Ins

Dutch: C:\Program Files\Adobe\Adobe Photoshop [CS version]\Insteekmodules

French: C:\Program Files\Adobe\Adobe Photoshop [CS version]\Modules externes

German: C:\Programme\Adobe\Adobe Photoshop [CS version]\Zusatzmodule

Italian: C:\Programmi\Adobe\Adobe Photoshop [CS version]\Plug-In

Mac

/Applications/Adobe Photoshop [CS version]/Plug-Ins
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Related topics

Uninstalling Geographic Imager

3.4 License Management

Both single-user fixed licenses (Basic and Full) and floating licenses of Geographic

Imager are available.  

Fixed licenses require activation in order to run. Once activated, they are node-locked

or fixed to that particular computer based on a unique Machine ID number. Before

completing the activation process, be certain that Geographic Imager is installed on

the intended computer of use.

Floating licenses are designed to allow an organization to deploy a specific number of

licenses that can be used and shared on any number of computers over a network.

 IMPORTANT: Laptop users with a docking station must activate

Geographic Imager in the undocked state. All users with wireless and fixed

NIC’s should disable the wireless NIC temporarily before activating

Geographic Imager and then activate using a wired internet connection.

Other devices such as mobile phones, GPS devices and microphones should

be disconnected as well.

After successfully installing Geographic Imager, launch Adobe Photoshop. The

Geographic Imager welcome screen provides four licensing options: Evaluate, Register,

Retrieve and Floating. 
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MAPublisher Welcome dialog box

Alternatively, open the License Management dialog box from the Geographic Imager
panel options menu.



Geographic Imager 5.0 Help30

© 2015 Avenza Systems Inc.

MAPublisher License Management dialog box

Related topics

Activate an Evaluation of Geographic Imager

Register a Purchased Copy of Geographic Imager

Retrieve a Geographic Imager License

Basic License

Floating License

License Troubleshooting

3.4.1 Fixed License

Activate an Evaluation of Geographic Imager

To activate an evaluation version of Geographic Imager, click the Evaluate button in

either the License Management dialog box or Welcome Screen. Complete the form and

click Evaluate.
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 A Geographic Imager evaluation is fully functional. There are no

limitations except that an evaluation license is valid for 14 days from the

day of activation.

Register a Purchased Copy of Geographic Imager

To register a purchased copy of Geographic Imager, click the Register button in

either the License Management dialog box or Welcome Screen. Enter the license key

that was provided when the product was purchased. Complete the form and click

Register.
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  The license key for Geographic Imager 5.x starts with "GI-" (e.g. GI-

9168B5E2DB7D3841).

Retrieve a Geographic Imager License

To retrieve an activated Geographic Imager license, click the Retrieve button in either

the License Management dialog box or Welcome Screen. Confirm that you want to

retrieve available licenses from the Avenza Systems licensing server.
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3.4.2 Basic License

The Geographic Imager Basic license is suitable for occasional users who need to

import geospatial images in Adobe Photoshop for editing. Quickly import your imagery

or scanned unreferenced maps into Adobe Photoshop and reference them with the

easy-to-use Georeference tool that includes coordinate system detection. Enhance

images using powerful Adobe Photoshop tools and export to standard industry formats

such as GeoTIFF or publish online using PDF Maps App format. The Basic license is is

also suitable for QA/QC who review images and need to save to specific image formats

to maintain georeference. Below is a table that compares the Basic and Full licenses of

Geographic Imager.

The Geographic Imager Basic license is available for Photoshop CS5, CS6 and Creative

Cloud (CC) and does not include maintenance. The table below reflects features

available in Geographic Imager 5.0. An upgrade to a Geographic Imager Full license is

available at any time. See pricing and availability for more information about obtaining

a license. Contact sales@avenza.com for further inquiries.

Feature Basic Full

Open Geospatial Image Formats *

Web Map Service (WMS)

Advanced Import

Reference File

Source Coordinate System

Channel Management

DEM Schema

Image Extents - Crop/Resample

Mosaic All Files

Georeference **

Transform

Mosaic

Tile
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Feature Basic Full

GeoCrop

Terrain Shader

Channel Management

Export to PDF Maps

Upload to PDF Maps Store

Panel Options Menu

Specify Reference File

Export Reference File

Specify DEM Schema

Quick Save to Format ***

Specify Coordinate System

Export Coordinate System

Save to GIS Image Format

BigTIFF

GeoTIFF

Adobe Photoshop native formats

Geospatial PDF

MrSID

NITF

IMG

DEM

ECW (Maximum export size of 500 MB)

Other Geographic Imager provided

formats
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* Up to 1 GB file size on Geographic Imager provided formats. Native Adobe

Photoshop formats (e.g. TIFF) are not limited.

** Rectify functionality is not available with a Basic license because it

requires Transform.

*** Only several formats available for Quick Save to Format: BigTIFF, DEM

TIFF, GeoTIFF, and Geospatial PDF.

 
Basic License can import images up to 1 gigapixel.

3.4.3 Floating License

System Requirements

Prior to installing your Geographic Imager Floating License for Windows, Mac or Linux

servers, ensure that you have sufficient system resources as outlined below:

Windows Server computer

•  Windows 2000 with Service Pack 3, Windows XP, Windows Vista, Windows 7,

Windows 8

•  Intel Pentium 3, 4 processor or better

•  1GB of RAM

•  300 MB of available hard-disk space

•  Valid TCP/IP network connection from license server to client computers

Mac Server computer

•  Mac OS X 10.4 or higher

•  1GB of RAM

•  300 MB of available hard-disk space

•  Valid TCP/IP network connection from license server to client computers

On the client computers

•  Geographic Imager 4.0 or higher installed on the appropriate version of Adobe

Photoshop

Preparing for the License Server Installation
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The Avenza_FloatingLicense_RLMv9.zip installation package contains the following

executables:

Package file Reference file format

extension

avenza.exe The Geographic Imager

specific portion (service) of

RLM

rlm.exe The RLM license server

rlmutil.exe A tool to get all the required

information for the floating

license

Extract Avenza_FloatingLicense_RLMv9.zip to a convenient location on your hard

drive. This will be the folder from which the program will run.

Obtaining a License File for Avenza Products

To obtain a floating license file (GeographicImager.lic), send the following information

to activation@avenza.com:

Machine ID of your server machine

Name of your server machine

IP address of your server machine

 Important Note: A new license file for the server machine must be

obtained from Avenza for all new purchases of MAPublisher, MAPublisher

LabelPro, MAPubilsher FME Auto, or Geographic Imager.

Collecting required information (Windows)

1.Open the command prompt window (Start > Run, then type CMD).

2.Navigate to the directory where the rlmutil and other binaries are located. 

3. To obtain the Machine ID, type rlmutil rlmhostid ether and press the Enter key. 

4. To obtain the server name, type rlmutil rlmhostid host and press the Enter key.

mailto:activation@avenza.com
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5. To obtain the IP address, type rlmutil rlmhostid internet and press the Enter key.

Collecting required information (Mac or Linux)

1.Open a Terminal window (Application > Utility, then find Terminal).

2.Navigate to the directory where the rlmutil and other binaries are located. 

3. To obtain the Machine ID, type ./rlmutil rlmhostid ether, and press the Enter

key. 

4. To obtain the server name, type ./rlmutil rlmhostid host, and press the Enter

key.

5. To obtain the IP address, type ./rlmutil rlmhostid internet, and press the Enter

key.

Related topics

Installing the License Server on Windows

Installing the License Server on Mac/Linux

Floating License Management on Client Machine

Managing the License Server

Frequently Asked Questions

3.4.3.1 Installing the License Server on Windows

After receiving the product license file(s) from Avenza Activation, extract the license

file and place it in the same folder as the RLM binary files. Installing and configuring

RLM will require access to the command prompt. If you have multiple license files for

multiple products, place all of the license files in the same folder where the RLM

binaries are stored.

Running RLM by clicking the executable

1.Double-click rlm to start the license server.

2. If a security warning message appears, click run to go to the next step.
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3.As soon as you click the run button, a new command prompt window will appear.

Using Command Prompt

1. Extract Avenza_FloatingLicense_RLMv9.zip to a convenient location on your hard

drive. This will be the folder from which the program will run.

2.Open the Command Prompt window (Start > Run, then type CMD).

3.Navigate to the directory where all the binaries and the license file are stored.

4. Type rlm.

 Make sure that avenza, rlm, and all of the license files are placed in

the same directory.

 Ensure that the license file has the .lic extension (e.g.

GeographicImager.lic).

Installing RLM as a Service

Installing RLM as a service can be performed in a command window. RLM will remain

running until it is explicitly deleted as a service. Installing RLM as a service does not

start RLM; RLM running as a service must be started from the “Services window

(Windows Services control panel)”.

To install RLM as a service, run it in the command line with specific arguments below:

rlm –install_service –dlog (path to the log file) [-service_name

sname]

(path to the log file) must be entered (e.g. c:\RLM_MAPublisher\RLM_Log.log) 

[-service_name sname] is an optional argument (e.g. –service_name

RLMMPublisher).  

If the service name is not specified, the service name will be “rlm”.

An example of the full line argument is:
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This will install service with a service name “rlm” and create a log file in the directory:

“c:\RLM_MAPublisher\RLM_Log.log” and the log file name is “RLM_Log.log”.

Starting the RLM Service (Windows)

After pressing the enter key at the end of the install command, nothing visible will be

displayed in the command prompt window. 

To start The RLM service:

1.Go to Start > Control Panel > Administrative Tools > Services to open the

Services dialog box.

2. Find the service named rlm from the list. (If a service name was specified in the

command line, find the specified service name from the list. Double-click the

service name to open the Service Property dialog box.)

3. If you want RLM to start whenever Windows starts, choose Automatic from the

Startup type drop-down.

4. To start RLM, click the Start button.

Once RLM is started as a service, RLM server will not have to be run from the

command prompt again.

Troubleshooting RLM Server Setup

When setting up RLM, its behaviour may be observed from the log file if RLM is

running. The following is a brief list of troubleshooting tips regarding error or warning

messages that may appear in the server log.

Issue Possible Solution

Warning:

No license file for

this host (Server

name); The host

name in the license

file(s) may be

incorrect.

A possible cause of this issue is that the license file does not

have the appropriate extension (.lic).  Please ensure that the

license file has the correct extension (.lic) at the end of the file

name.
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Issue Possible Solution

RLM Version:

What is the

appropriate version

of RLM for

Geographic Imager

5.x?  

The appropriate version of RLM for Geographic Imager 5.x is RLM

version 9.x. The version number can be indicated in one of the

server log lines, e.g. “01/06 12:17 (rlm) RLM License Server

Version 9.3BL2”

Error:

(rlm) Port 5053 in

use, waiting...

This log line appears when port 5053 is used by other

application. RLM version 9.x uses port 5053 (TCP/IP) by default.

In order to solve this problem, a port number can be specified in

the license file. Enter the port number at the end of the HOST

line in the license file. As this port number is not included in the

encryption code, any encryption process from Avenza Activation

Department will not be required.  However, please ensure that

the license file has the file extension .lic after saving the file.

The example below shows that the port number 5055 is

specified.

Error:

(rlm) Cannot bind

Web Server port

5054, existing...

A web browser is required to access the RLM administrator page

(shown on page 14 “Managing the license server”). This log line

appears when port 5054 is used by other application. RLM

version 9.x uses port 5054 for the web server port by default.  

In order to solve this problem, a port number can be specified

with a command prompt line when running RLM (as a service).

The argument word to be used to specify the web port number

is -ws <port number>; the examples below show the web server

port number specified as 5555.

When running RLM 
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Issue Possible Solution

rlm -ws 5555

When running RLM as a service

rlm -ws 5555 -install_service –dlog (path to the

log file) [-service_name sname]

3.4.3.2 Installing the License Server on Mac/Linux

After receiving the product license file(s) from Avenza Activation, extract the license

file and place it in the same folder as the RLM binary files. Installing and configuring

RLM will require access to the command prompt. If you have multiple license files for

multiple products, place all of the license files in the same folder where the RLM

binaries are stored.

After receiving the license file(s) from Avenza Activation department, extract the

license file and place it in the same folder as the other binary files. Setting up RLM will

require access the terminal window.  

Using Terminal

1. Extract Avenza_FloatingLicense_RLMv9.zip to a convenient location on your hard

drive. This will be the folder from which the program will run.

2.Open the Terminal Window (go to Applications / Utilities, then select Terminal).

3.Navigate to the directory where all the binaries and the license file are stored.

4. Type ./rlm

For example, this line indicates that your server is running properly for Geographic

Imager and other Avenza products. Depending on how many product licenses you
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have, this line may be different.

 Make sure that avenza, rlm, and all of the license files are placed in

the same directory.

 Ensure that the license file has the .lic extension (e.g.

GeographicImager.lic).

Troubleshooting RLM Server Setup

When setting up RLM, its behaviour may be observed from the log file if RLM is

running. The following is a brief list of troubleshooting tips regarding error or warning

messages that may appear in the server log.

Issue Possible Solution

Warning: No license file

for this host (Server

name); The host name

in the license file(s)

may be incorrect.

A possible cause of this issue is that the license file

does not have the appropriate extension (.lic). 

Please ensure that the license file has the correct

extension (.lic) at the end of the file name.

RLM Version: What is

the appropriate version

of RLM for Geographic

Imager 5.x?  

The appropriate version of RLM for Geographic Imager

5.x is RLM version 9.x. The version number can be

indicated in one of the server log lines, e.g. “01/06

12:17 (rlm) RLM License Server Version 9.3BL2”

Error: (rlm) Port 5053

in use, waiting...

This log line appears when port 5053 is used by other

application. RLM version 9.x uses port 5053 (TCP/IP)

by default. In order to solve this problem, a port

number can be specified in the license file. Enter the

port number at the end of the HOST line in the license

file. As this port number is not included in the

encryption code, any encryption process from Avenza

Activation Department will not be required.  However,

please ensure that the license file has the file

extension .lic after saving the file. The example below

shows that the port number 5055 is specified.
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Issue Possible Solution

Another cause of this issue is that RLM is already

running. Check whether or not the RLM is running in

the Activity Monitor (/Applications/Utility/Activity

Monitor). When RLM is running, rlm and avenza will be

listed.

Error: (rlm) Cannot

bind Web Server port

5054, existing...

A web browser is required to access the RLM

administrator page. This log line appears when port

5054 is used by other application. RLM version 9.x

uses port 5054 for the web server port by default.  

In order to solve this problem, a port number can be

specified with a command prompt line when running

RLM (as a service). The argument word to be used to

specify the web port number is -ws <port number>;

the examples below show the web server port number

specified as 5555.

When running RLM 

./rlm -ws 5555

Error:

(avenza) problem with

executable - unable to

start . . .

This error message appears when the binary file

“avenza” does not have appropriate permission to

execute when running “RLM”. In order to solve this,

the file must be assigned an appropriate privilege to
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Issue Possible Solution

(rlm) avenza

executable path:

avenza

the avenza binary file as suggested below.

When running RLM 

chmod a+x avenza

This line above can be interpreted as add a permission

of executable to all the users on the "avenza" binary

file. Run rlm (./rlm) after the privileges of the avenza

binary file is modified.

Error:

(avenza) cannot set

server lock - exiting

(rlm) avenza - lockfile

problems

This error only affect Mac/Linux

This error message appears when the lock file named

.rlmlockavenza is interfering with RLM. The solution to

this problem is to delete the lock file with a command

in the Terminal window. 

Before the lock file is deleted, both rlm and avenza

must be stopped. Otherwise, it is not going to allow

to delete the lock file. This process can be stopped

from the Activity monitor (/Applications/Utility/

Activity Monitor) or command line. 

1. Open the Activity Monitor (/Applications/Utility/

Activity Monitor).

2. Find the name rlm, then click Quit process.  When

prompted, select Force quit.

3. Repeat the same step for the process name

avenza.

4. Open the terminal window and navigate to the

location of the.rlmlockavenza file 

    by typing: cd /private/var/temp/

5. The .rlmlockavenza file is a hidden file. In order to

view the file in the directory, type ls -la.

6. Remove the .rlmlockavenza file by typing: rm

.rlmlockavenza

7. Navigate to the directory where all the RLM
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Issue Possible Solution

binaries and the license file are stored.

8. Run rlm.

3.4.3.3 Floating License Management on Client Machine

Setting up and checking out a license from a server can be performed on the client

machine from the Geographic Imager Welcome Screen or License Management dialog

box 
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MAPublisher License Management dialog box

Floating license setup

1.On the Welcome dialog box or License Management dialog box, click the Floating

button.

2. Enter the server name and port number that was specified during RLM

installation.

3. Click the Check Settings button to verify the connection to the license server.
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Checkout a license

1.Make sure the floating license server is running and setup properly.

2.On the Welcome dialog box or License Management dialog box, click the 

Checkout button. Enable the Automatically checkout license check box so

that the floating license is checked out every time Adobe Photoshop is launched.

The license status updates to Licensed from server when a successful connection

is made.

Checkin a license

Click the Checkin button to return the floating license to the server.

Borrowing a Roaming License

Geographic Imager 5.x allows client machines to borrow licenses from the license

server. This is ideal if a computer will be disconnected from the license server for a

period of time, such as for traveling, working in the field, or working from home with a

laptop computer. Roaming licenses can be allowed from the Floating License Setup

dialog box.

Borrowing a roaming license

1.On the Welcome dialog box or License Management dialog box, click the Floating

button.

2. Click the Allow roaming licenses check box and click OK.
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3.When you checkin a license, the User roaming license option will be enabled.

4. Click the User roaming license check box and adjust the duration of borrow (in

days).

 The borrowing period begins when you disconnect from the network.

 If a floating license has already been checked out (i.e. Geographic

Imager is being used), the checked out license must be returned

(checked in) prior to starting to roam with a floating license.

 The roaming license can be returned to the server before the time
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expires.  Connect to the network, click the Return Early button and the

roaming license will be returned to the server.

3.4.3.4 Managing the License Server

To manage the rlm server itself, use the Reprise License Server Administration site. In

a web browser, enter http://localhost:5054 (localhost is the server name specified

during installation and 5054 is the default port).

For more detailed information on RLM administration, refer to the RLM End-User Manual

at http://www.reprisesoftware.com/RLM_Enduser.html. You can also access the RLM

Manual from the  Reprise License Server Administration page.

Checking the Server Status

http://www.reprisesoftware.com/RLM_Enduser.html
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1.Open the Reprise License Server Administration web page.

2. Click the Status button on the left frame.

If any other applications use the RLM Floating License Server system, you will also

see the other applications in the status tables.

3. In order to check the server status for Geographic Imager, click the avenza button

in the Server Status field.

On the following page, product information including the name and its version, the

number of the floating license you purchased for the product, and any other

information related to your floating licenses using the RLM floating license

management system will be displayed.
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Stopping and Restarting the License Server

1.Open the Reprise License Server Administration web page.

2. Click the Status button on the left frame.

3. To stop the license server, click the Shutdown button on the left pane or click

the avenza button in the SHUTDOWN field on the Server Status page.

4. To restart the license server, click the Reread/Restart Servers button on the left

pane or click the avenza button in the REREAD/RESTART field on the Server Status

page.

Using the Command Prompt to Manage the License Server

Below are the commonly used commands and brief descriptions to manage the RLM

License Server.  For further information, please refer to the RLM End User Manual at 

http://www.reprisesoftware.com/RLM_Enduser.html. Open another command prompt

window and navigate to the directory where all the binaries are stored.

Command

(Windows)

Command

(Mac/Linux)

Description

rlm ./rlm Start the RLM server

rlmutil

rlmreread

./rlmutil

rlmreread

Stop and restart the server

http://www.reprisesoftware.com/RLM_Enduser.html
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Command

(Windows)

Command

(Mac/Linux)

Description

avenza avenza

rlmutil

rlmdown

avenza

./rlmutil

rlmdown

avenza

Shut down the server. (It may

take for a few minutes to shut

down RLM)

rlmutil

rlmstat -a

./rlmutil

rlmstat -a

See RLM server information

rlmutil

rlmstat -

avail avenza

./rlmutil

rlmstat -

avail avenza

Check license availability

3.4.3.5 Frequently Asked Questions

Below is a list of the most commonly asked questions when receiving license files for

Avenza RLM license servers.  If you have any questions, please do not hesitate to

contact Avenza Activation (activation@avenza.com) and Avenza Technical Support

(support@avenza.com).

Geographic Imager stopped working since Geographic Imager was upgraded

to the 5.x version on client machines. Why does this happen?

When upgrading Geographic Imager to the most recent version, please ensure that

the license file on the server is upgraded as well as Geographic Imager installed on

the client machines. The new license file can be requested from Avenza Activation

(activation@avenza.com). After receiving the license file, simply replace the old

license file with the new one.

The license file for the server was upgraded to Geographic Imager 5.x.

However, it will be a while before upgrading to a newer version of Geographic

Imager on the client machines. Can these client machines check out an older

license of Geographic Imager from the license server with a Geographic

Imager 5.x license file?

Yes, Avenza RLM floating license server is flexible for older versions of Geographic

Imager. When the server machine has the newest version of Geographic Imager,

the client machine with an earlier version of those products may check out a

license from the server.

mailto:activation@avenza.com
mailto:support@avenza.com)
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I have been using Geographic Imager 5.x for a while. We recently purchased

both MAPublisher 9.x and MAPublisher FME Auto and received a license file for

each product. Can I just place the three license files in the same folder for the

RLM server binary?

Yes, you have three separate license files: one for Geograhpic Imager 5.x, one for

MAPublisher 9.x, and one for MAPublisher FME Auto. If your RLM floating license

server is running, stop the process, then place all three license files in one folder in

the RLM parent folder , and restart RLM. Upon restart, RLM automatically detects

all available license files in the RLM folder and indicates on the RLM log which

products are available with the floating license system.

I purchased Geographic Imager 5.x, MAPublisher 9.x, and MAPublisher FME

Auto, but only received one license file. Does the license file contain all the

license information for the products I purchased?

Yes, you have received a license file with all the necessary license information for

all three products. Depending on when and method of purchase, Avenza Activation

will give you a single license file or separate license files for the purchased

products. When running RLM server, the products included in the license file will be

displayed in the RLM log file.

3.4.4 License Troubleshooting

If you cannot register or retrieve an evaluation or purchased license from within

Geographic Imager (e.g. firewall limitations), visit the Avenza Systems website

(www.avenza.com/activation) and provide the Machine ID displayed in the License

Management dialog box. A zipped license file attachment will be sent to the registered

email address on record. Unzip this attachment and save the .lic file to the appropriate

folder*:

Windows 7/8: C:\ProgramData\Avenza\Geographic Imager

Mac OS X: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-In

* English versions only. Location may differ in other Adobe Photoshop language

versions.

After placing the license file in the appropriate directory, restart Adobe Photoshop so

that Geographic Imager will recognize any new licenses.

To quickly access the Geographic Imager license file folder, right-click a row in the

http://www.avenza.com/activation
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License Management dialog box and click Browse to license folder. Copy or move

Geographic Imager license files directly into this location.

Geographic Imager License Management dialog box (right-click  to access context menu)

3.5 The User Interface

The Geographic Imager panel, which provides access to all Geographic Imager tools,

appears automatically when Adobe Photoshop is first opened (unless it was previously

closed).
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Adobe Photoshop with the Geographic Imager panel docked.

Geographic Imager features and tools can be accessed from the File Menu and from

the Geographic Imager panel.

The File Menu

The File menu provides access to all Geographic Imager tools including features

such as Upload to PDF Maps and Event Log that are not accessible from the

Geographic Imager panel.

The Geographic Imager Panel

The Geographic Imager panel provides access to all the main Geographic Imager

tools including Georeference, Transform, Mosaic, Tile, GeoCrop, Terrain Shader,

Channel Management, Export Web Tiles, and Advanced Import.

3.5.1 The File Menu

To access Geographic Imager tools and features through the File menu, go to File >

Automate. Menu items listed with a GI: prefix are Geographic Imager tools and

features.
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 When recording actions, it is required to use the File > Automate menu.

To access Geographic Imager export tools and features, go to File > Export. Menu
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items listed with a GI: prefix are Geographic Imager tools and features.

See more about Export to PDF Maps.

See more about Export Web Tiles.

3.5.2 The Geographic Imager Panel

To show or hide the Geographic Imager panel, go to Window > Extensions >

Geographic Imager.
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The Geographic Imager panel provides access to all the main Geographic Imager tools

and displays image information.

But

ton

Tool Description

Georeferen

ce

Reference or rectify an image using control points.

Transform Transform an image into a different coordinate system,

change pixel size, and modify pixel dimensions.
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Mosaic Assemble multiple images together into a larger one.

Tile Split an image into multiple smaller ones by size or

number of tiles required.

GeoCrop Crop images based on location by specifying coordinates

of the output image.

Terrain

Shader

Apply a color gradient or hill shade to digital elevation

models or images.

Channel

Manageme

nt

Adjust color mode and channel role.

Export

Web Tiles

Export an image as web tiles and an HTML file compatible

with online map services.

Advanced

Import

Import multiple images of various formats and apply

settings all at once.

Panel

Options

Menu

Access additional Geographic Imager features including 

License Management.

The Panel Options Menu is accessed different depending

on Adobe Photoshop version.

CC 2014 and CC 2015: The Panel Options Menu is

accessed through the button on the Geographic Imager

panel.
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CS6: There is no Panel Options Menu button. Instead,

use the standard panel options menu that is native to

the panel (upper-right corner of the panel).
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Reference File / Coordinate System Links

These links display the location of the geographic reference file of the image and

the current coordinate system of the image as defined in the Geographic Imager

coordinate system database. Click the respective link to choose a new reference

file or specify a different coordinate system. Note that this doesn't transform the

image and only changes the coordinate system which may cause unpredictable

affects on your map. Use Transform to transform the image to a different

coordinate system.

Reference File

A geographic reference file contains data that relates the image in pixels to the

earth in real world coordinates. Along with other parameters, this file contains

either the mathematical transformation information or an explicit list of reference

points and the coordinate system (optional).
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Coordinate System

Indicates the current coordinate system of the image. Click the Coordinate System

information button to open the Geodetic Coordinate System Viewer which shows

more detailed information about it.

Mode

The Mode indicator displays whether the image is in GCP or Standard mode. GCP

mode means the image requires referencing or rectifying before some Geographic

Imager tools and operations can be performed. Standard mode means the image is

ready for editing with Geographic Imager tools.

Image Mode

The Image Mode indicator displays information about the current image color mode

and bit depth (in bits per channel). For example, RGB | 8 means the image color

mode is RGB with 8-bit depth.

Rotation Angle

The Rotation indicator shows the angle of rotation of the image from north being

straight up. A negative value indicates a clockwise rotation and a positive value

indicates a counterclockwise rotation.

Information Tabs

General

Geodetic Format: The current geodetic display format (click to change).

Image Size: The image size in pixels (x,y pixels).

Image Extents: The geographical extent of the image (x,y world units or units of

coordinate system).

Geodetic Extents: The geodetic extent of the image (x,y degrees).

Pixel Size: The relative size of each pixel (x,y world units or units of coordinate

system ).
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Copy to Clipboard button: Click to copy information values to the clipboard.

 Certain world projections may not provide proper values for areas

outside of the its extents. This may cause the Geodetic Extents to

display N/A.

Corners

Geodetic images are displayed in degrees. 

Projected images are displayed in units of coordinate system.

Top Left: The projected coordinate of the northwest corner of the image.

(Long, Lat): The geographic coordinate of the northwest corner of the image in

WGS 84.

Bottom Right: The projected coordinate of the southeast corner of the image.

(Long, Lat): The geographic coordinate of the southeast corner of the image in

WGS 84.

Copy to Clipboard button: Click to copy coordinate values to the clipboard.

DEM

Schema Name: Schema used to map elevation data to grayscale color space.

Schema Range: Range specified in the DEM schema. The actual range value

displayed in parenthesis.

Range: Range of values of the current DEM in specified units. The actual range
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value displayed in parenthesis.

Average: The average elevation value of the DEM.

StdDev: The standard deviation value of the DEM.

Calculate button: Click Calculate to obtain values for the cropped DEM.

Copy to Clipboard button: Click to copy statistic values to the clipboard.

 Hide the Terrain Shader and Shaded Relief Layers before clicking the

Calculate button. The Statistics calculation may be inaccurate if layers

above the elevation layer are not hidden.

 Statistics are calculated based on what is viewable on the canvas.

Survey

Use the Color Sampler Tool to identify up to ten points on the image.

All points: Choose to view all points or individual points (not all points can be

viewed at once).

Measurement units: Choose from Ground, Geodetic, WGS84, Pixel, and DEM. The

reported coordinate is the center of the pixel. 

Copy to Clipboard button: Click to copy measurement values to the clipboard.

 The Color Sampler Tool can be used to choose up to ten points on

the image. Drag and drop individual points with the left mouse button

pressed to change their location. Use Ctrl (Win) or Command (Mac) to

delete individual points or right-click for additional options.

 Up to 4 points with CS6. Up to 10 points with CC and CC2014.

Ruler
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Use the Ruler Tool to identify measure up to two segments. Hold the Alt (Win) or

Option (Mac) key and hover over the end point of the first segment to begin

measuring the second segment. Click the Update button in the Ruler tab to view

measurement values including total distance and angle.

Panel Options Menu

Menu Item Description

Preferences Adjust Geographic Imager Preferences. See 

Preferences.

License Management Opens the Geographic Imager License

Management dialog box. View the Machine ID,

evaluate, register, retrieve, or checkout/in

floating licenses. See License Management.

Welcome Screen Opens the Geographic Imager Welcome Screen.

Check For Updates Check to see if there is a newer version of

Geographic Imager.

Ask Avenza A Question Opens the Avenza Support page in an Internet

browser.

Load Custom Coordinate

System

Load a custom coordinate system data source.

See Load Custom Coordinate Systems.

Edit Custom Coordinate

System

Edit a custom coordinate system data source.

See Edit Custom Coordinate Systems.

Specify Reference File Specify a reference file for the current image.

See Specifying a Reference File.

Export Reference File Export the defined coordinate system of an image
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Menu Item Description

to a reference file. See Exporting a Reference

File.

Specify Coordinate

System

Specify a coordinate system for the image.

Opens the Specify Coordinate System dialog box.

See Specifying a Coordinate System.

Export Coordinate

System

Export the coordinate system of the image to a

WKT Definition File or Esri PRJ file. See Exporting

a Coordinate System.

Quick Rectify Automatically rectify a rotated image to a north/

south alignment. This option is enabled when an

image has a rotation. View the Geographic

Imager panel rotation angle status.

Quick Save To Format

(not available with Basic

license)

Save a referenced image to BigTIFF, DEM TIFF,

USGS DEM, Geospatial PDF, GeoTIFF, NITF, or

ECW/ER Mapper. See Quick Save to Format.

Specify DEM Schema Specify a DEM schema for the current image.

Opens the Specify DEM Schema dialog box.

See Opening DEMs. 

Export to PDF Maps Export a map package that is compatible with the

PDF Maps app. See Export to PDF Maps. 

Upload to Store Upload a map package directly to the PDF Maps

Store. See Upload to PDF Maps. 

Event Log View errors, warnings, and system messages.

See Event Log.

3.5.3 Event Log

The Geographic Imager Event Log records information about which Geographic Imager

tools are used, when they were used, and on which documents. To view the log, go to

the Geographic Imager panel options menu and choose Event Log.
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When a Geographic Imager tool is used, information such as the tool used, inputs,

outputs, warnings and errors are recorded into the log. The log also displays when

tools were executed and which layers were involved. Currently, these Geographic

Imager tools are logged:

Georeference

Transform

Mosaic

Tile

GeoCrop

PDF Maps Upload and Export

Advanced Import

The Show toggles filter information, warning and critical messages. 

To export recorded log entries, click the Export button to save a text file.

To clear the entire log, click the Clear button. This is permanent and cannot be

undone.



Geographic Imager 5.0 Help68

© 2015 Avenza Systems Inc.

 
A maximum of 10,000 messages can be logged.

3.5.4 Geographic Imager Preferences

Geographic Imager Preferences are options that allow users to customize panels and

editors, including those for layer ordering, font for attribute data display and panel

style. Settings are available for the following categories:

General

Georeference

Image Formats

MAPublisher Integration

Online Maps

PDF Maps

Panel

Geographic Imager Preferences are saved in an Adobe Photoshop preference file called 

Adobe Photoshop [version] Prefs.psp or Adobe Photoshop [version] Prefs.psp

(for Creative Suite users, where X is the version). The preference file is launched each

time Adobe Photoshop is started. The Adobe Photoshop preference file is located in

following directory:

Windows 7/8: C:\Users\[user]\AppData\Roaming\Adobe\Adobe Photoshop [version]

\Adobe Photoshop [version] Settings

Mac: /Users/[user]/Library/Preferences/Adobe Photoshop [version] Settings

Open Geographic Imager Preferences

Open Geographic Imager Preferences from the Geographic Imager panel options menu.
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3.5.4.1 General Preferences

Log notification level The types of notifications that are recorded in

the log

Locale Use the system locale or a different one

Format numbers for

display purposes and

other operations based on

locale

Adjusts numbers based on locale settings above

Check for Geographic

Imager updates

Automatically checks for updates on start-up

3.5.4.2 Georeference Preferences
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Default external reference

format

Lists supported reference file formats (excluding

GeoTIFF). When multiple reference files are

found in the same directory, the Reference File

Ambiguity dialog box appears. 

Open/New: use internal

format if available

This option overrides the chosen default external

reference format when any internal reference is

detected. This option is checked by default.

Format change: use

internal format if available

This option overrides the chosen Default

Reference Format when any internal reference is

detected. This option is checked by default.

GeoTIFF:  pixel

registration method

When saving a GeoTIFF, keep existing pixel

reference point of current image or override by

choosing: Pixel-As-Area (upper left corner) or

Pixel-As-Point (center of the pixel)

The default external reference formats are World, MapInfo TAB, Blue Marble Reference,

and ERS. 

When multiple reference files are found in the same directory, the Reference File

Ambiguity dialog box will appear and will list the multiple reference files. The default

reference format will be selected in the list. Clicking the Always use the default

reference format if available check box will prevent the Reference File Ambiguity dialog

box from appearing again and ensure that the default reference format is used.

 Only reference files with the same name as the image are listed in the

Reference File Ambiguity dialog box. Reference files with a different name

than the associated image will have to be specified manually.

When the Open/New: use internal format if available check box is checked,

Geographic Imager uses any internal reference files (such as GeoTIFF) as the default

and overrides the format from the Default external reference format drop-down list.

When georeferencing an image, the format chosen in the Default external reference

format drop-down list will be created.
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3.5.4.2.1  Georeference Editor Preferences

Show errors greater than

number of standard

deviations

Lists supported reference file formats (excluding

GeoTIFF). When multiple reference files are

found in the same directory, the Reference File

Ambiguity dialog box appears. 

Point label colour Colour of the control point label.

Selected point colour Colour of the selected control point.

Reference point colour Colour of existing reference control points.

User entered point colour Colour of assigned control points.

Unassigned point colour Colour of unassigned control points.

Geodetic value to display The default geodetic value to display: WGS84 or

Geodetic Base.

Lat/Long Format The default latitude and longitude format to

display. 

See Coordinate Formats.

Geodetic Precision The number of decimals a geodetic coordinate

displays.

Projected precision The number of decimals a projected coordinate

displays. The default decimal precision is 6.
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3.5.4.3 Image Formats Preferences

MrSID: path to Lizardtech

encoder utility

The directory of the LizardTech MrSID encoder

utility.

3.5.4.4 MAPublisher Integration Preferences

Georeference .ai file on

Export-> Path to

Illustrator

Include georeference with Adobe Illustrator file

when Export > Paths to Illustrator is used. This

option is checked by default.
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3.5.4.5 Online Maps Preferences

Online map HTML file Specify an HTML file that points to a different

online map service. Leaving this blank will use

the default online map service.

3.5.4.6 PDF Maps Preferences

These preferences affect how images are exported to be compatible with the Avenza

PDF Maps app.

 

Tiling timeout (sec) How many seconds it takes before the tiling

process will timeout
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3.5.4.7 Panel Preferences

Default panel

communication port

The Geographic Imager panel communication

port. Only change if you are experiencing a

problem with the Geographic Imager panel not

loading properly. Contact Avenza Support for

more information.

3.6 Uninstalling Geographic Imager

To uninstall Geographic Imager, follow the instructions for your operating system:

Windows

1. If Adobe Photoshop is running, exit the program.

2.Click the Start button, point to All Programs, click Avenza, click Geographic Imager

and click Uninstall.

3. If the User Account Control dialog box appears, click Allow.

4. In the Geographic Imager Uninstall Confirmation dialog box, click Uninstall.

5. A message prompts that all files will be removed from the Geographic Imager

program folder. To save custom XML datasource files in the Applications folder, click

Yes. To delete them, click No.

Mac
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1. If Adobe Photoshop is running, exit the program.

2. In Finder, browse to /Applications/Avenza/Geographic Imager

3. To save the custom XML datasources, move the Data Source Backup folder to a

different location. These are files backed up from the last version of GI installed.

4.Delete the entire Geographic Imager folder or delete only the Geographic Imager

Plug-In folder to keep the other files (documentation, tutorials, etc.).

 On Mac, installing Geographic Imager again (new or previous version) will

copy all custom files to the data source backup folder.

Files to back up

You may want to backup certain files so that they can be used again.

File Description

customsystems.xvw This view file stores the organization and folder

structure of your custom coordinate systems within

the geodetic data source.

customsystems.xml This file stores custom coordinate system definitions.

avenza.xsp This file contains Avenza-specific supplementary

coordinate systems.

geocalc.xsd This file must be included when loading a custom

coordinate system.

geodata.xml This file stores an unlimited number of custom linear

and angular units, ellipsoids, datums, datum shifts

and coordinate systems. Also referred to as the

geodetic data source.

customeDEMschema

.xml

This file stores custom DEM schema information.

customecolormappin

gs.xml

This file stores custom color maps that are used with 

Terrain Shader.
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These files are located in:

Windows: C:\Program Files\Avenza\Geographic Imager\Data Source Files

Mac: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in

Related topics

The Geodetic Data Source
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4 Spatial Image Formats

Image formats that can be opened and displayed by Adobe Photoshop can form the

basis for a spatial image. This includes, but is not limited to, the following common

formats: TIF, JPG, BMP, PSD, GIF and PNG. With Geographic Imager installed, these

common formats can be paired with a reference file that stores spatial information.

This provides images that are not traditionally referenced to be fully referenced.

Geographic Imager also provides the ability to read many spatial formats that are

unavailable with just Adobe Photoshop (see table below). Formats listed below are

supported on both Windows and Mac versions of Geographic Imager, unless otherwise

indicated.

Note that although any image, in any color mode, can be georeferenced and

recognized by Geographic Imager, the performance of some Geographic Imager

functions are restricted to certain color modes/bit depths.

Supported Raster/Reference Formats

Format Extension Supported since Read Write

BigTIFF *.tfw, *.tifw, *.wld,

*.jgw,

*.pgw, *.sdw,

*.eww,

*.blw, *.dmw, *.bpw

Read: 3.0, Write: 3.4

BSB *.kap 4.1 -

ERDAS

IMAGINE

Raster

*.img Read: 3.4, Write: 3.5

ER Mapper

ECW

*.ecw Read: 2.5, Write: 3.4 †

Geospatial

PDF

*.pdf 3.2

GeoPDF *.pdf 3.2 -

GeoTIFF *.tif, *.tiff 1.0
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JPEG 2000 *.jp2,

*.j2k,*.jpx,*.jpc,

*.j2c,*.jpf

Read: 2.5, Write: 3.2

LizardTech

MrSID

*.sid Read: 2.5, Write: 4.1 *

MrSID/MG4

LiDAR

*.sid 3.4 -

NITF *.ntf Read: 3.0, Write: 3.4

PCI EASI/

PACE

*.pix 2.5 -

SGI Image

format

*.rgb, *.rgba, *.int,

*.inta, *.bw 

2.5 -

Web Map

Service

(WMS) 

*.tiff, *.png, *.jpg,

*.gif

3.4 -

* Windows only

† Maximum export size of 500 MB

Supported DEM Formats

Format Extension Supported since Read Write

Esri ArcInfo

ASCII Grid

*.agr, *.asc Read: 2.5, Write: 5.0

Esri ArcInfo

Binary Grid

*.adf 2.5 -

Esri ArcInfo

Floating Grid

*.flt 3.4 -

BIL *.bil Read: 3.0, Write: 5.0

ERDAS

IMAGINE

*.img 3.4 -
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Grayscale

GeoTIFF

DEM

*.tiff Read: 3.4, Write: 4.2

Military

Elevation

Data / DTED

*.dt0, *.dt1, *.dt2 2.5 -

USGS SDTS *.ddf 2.5 -

USGS DEM *.dem Read: 2.5, Write: 4.3

SRTM *.hgt 2.5 -

Supported External Reference Formats

Format Extension Supported since Read Write

World Files *.tfw, *.tifw, *.wld,

*.jgw,

*.pgw, *.sdw,

*.eww,

*.blw, *.dmw, *.bpw,

*.gfw

1.0

Blue Marble

Reference

*.rsf 1.0

MapInfo

TAB

*.tab 1.0

ER Mapper *.ers 1.0

Supported Web Tile Formats

Format Extension Supported since Read Write

Google

Maps

*.html, *.png 4.2 -

Bing Maps *.html, *.png 4.2 -
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OpenStreet

Map (OSM)

*.html, *.png 5.0 -

Tile Map

Service

*.xml, *.png 5.0 -

Mapbox

TileMill

*.mbtiles 5.0 -

4.1 Supported Raster/Reference Formats

Adobe Geospatial PDF, TerraGo GeoPDF® (pdf)

Read and Write

The geospatial PDF is considered an Adobe Acrobat Portable Document Format

(following the PDF 1.7 specification) that contains information that is required to

georeference location data. It is an open specification developed and maintained

by Adobe Systems. See detailed specifications in Section 8.3 at http://

www.adobe.com/devnet/acrobat/pdfs/PDF32000_2008.pdf. The TerraGo GeoPDF is

a proprietary format that is compatible with Geographic Imager, but with

limitations.

The Adobe PDF file format cannot reference non-PDF images; it can only reference

other PDF images.

BigTIFF (tif, tiff)

Read and Write (write not available with Basic license)

BigTIFF extends the original TIFF file format specification to support 64-bit (for

images larger than 4 GB). It is the result of work by a variety of parties including

Adobe Systems. BigTIFF is expected to be useful for people and vendors that are

confronted with unusually large images and still seek to use an open, simple, and

extendable format. BigTIFF is not yet an official standard and is still awaiting final

approval.

BSB (kap)

Read only

The BSB file format is a compressed raster format used for distributing raster

nautical charts by various organizations in North America, most notably the NOAA.

KAP file contains the content/image and the BSB file contains text information
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about the image. A BSB file can store many control points and should be

referenced with Georeference prior to use.

ERDAS IMAGINE Raster (img)

Read and Write (write not available with Basic license)

ERDAS IMAGINE uses IMG files to store raster data. These files use the ERDAS

IMAGINE Hierarchal File Format (HFA) structure. A tiled format is used to store

raster layers. This allows raster layers to be displayed and resampled quickly. Each

raster layer within an IMG file has its own ancillary data, including the following

parameters: height and width (rows and columns), layer type (continuous or

thematic), data type, compression, and lock size.

Enhanced Compression Wavelet (ecw)

Read and Write

ECW is a proprietary wavelet compression image format optimized for aerial and

satellite imagery. It was originally developed by Earth Resource Mapping. The lossy

compression format efficiently compresses very large images with fine alternating

contrast.

 Geographic Imager can only export ECW files up to 500 MB in raw size.

There is no limit on import.

GeoTIFF File (tif, tiff)

Read and Write

Tagged Image File Format (TIFF or TIF) is a common raster graphic file format and

one of the most common geospatial image formats (in the form of GeoTIFF). A

GeoTIFF is a TIFF file with embedded geographic information such as position and

scale in world coordinates, affine transformation or an explicit list of control points.

Many raster geographic images from GIS systems are stored in this format.

Unlike other georeferenced image formats discussed in this section, a GeoTIFF does

not require a separate reference file. Geographic information is automatically

detected when a GeoTIFF is opened in Geographic Imager. When saving a

georeferenced image to the TIF or TIFF format, Geographic Imager writes the

appropriate georeference header information into the file. It also supports storage

of coordinate system information and control points.
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Supported projections when saving a coordinate system to GeoTIFF:

Albers Equal-Area Conic

Azimuthal Equidistant

Cassini-Soldner

Cylindrical Equal Area

Eckert IV

Eckert VI

Equidistant Conic

Equidistant Cylindrical

Equirectangular

Gall Stereographic

Gnomonic

Hotine Oblique Mercator

Laborde Oblique

Mercator

Lambert Azimuthal Equal

Area

Lambert Conic Conformal

(1SP)

Lambert Conic Conformal

(2SP)

Lambert Conic Conformal

(2SP Belgium) Lambert

Cylindrical Equal Area

Mercator

Miller Cylindrical

Mollweide

New Zealand Map Grid

Oblique Mercator 

Oblique Stereographic

Orthographic

Polar Stereographic

Polyconic

Robinson

Rosenmund Oblique

Mercator

Sinusoidal 

Stereographic

Swiss Oblique Cylindrical

Swiss Oblique Mercator

Transverse Mercator

Transverse Mercator

(modified Alaska)

Transverse Mercator

(South Oriented)

Tunisia Mining Grid

VanDerGrinten

 Geographic Imager supports every coordinate system it can write,

regardless of projection. However, this does not guarantee that a third-

party GIS software will recognize all coordinate systems or projections.

 When a GeoTIFF contains rotation or the coordinate system direction is

reversed, it may not open in legacy applications.

 Images in a multichannel color mode are not supported when using Save

or Quick Save To Format to save to GeoTIFF. Saving layers and extra

channels is supported.

 It is recommended to open 12-bit TIFF images with Advanced Import,

otherwise it will not open.

JPEG 2000 (jp2, j2k, jpx, jpc, j2c, jpf)

Read and Write

JPEG 2000 is a wavelet-based image compression standard. It was created by the
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Joint Photographic Experts Group committee in the year 2000 with the intention of

superseding their original discrete cosine transform-based JPEG standard (created

1992). The standardized filename extension is JP2 for ISO/IEC 15444-1 conforming

files and JPX for the extended part-2 specifications, published as ISO/IEC 15444-2,

while the MIME type is image/JP2.

 Adobe Photoshop can only save JPEG 2000 files less than 2 GB in size.

LizardTech MrSID* and MrSID/MG4 LiDAR (sid)

Read and Write* (write not available with Basic license)

Multi-resolution Seamless Image Database (MrSID) is a powerful wavelet-based

image compressor, viewer and file format for large raster images. Developed by

LizardTech Inc., MrSID enables instantaneous viewing and manipulation of images

locally and over networks. Features include high and efficient compression ratios

while maintaining true multiple resolutions, selective decompression, seamless

mosaicking and browsing. Files in the MrSID/MG4 compressed LiDAR file can be

opened and viewed as a raster DEM. 

 To write MrSID files through Geographic Imager, GeoExpress must also be

installed (unavailable with a trial GeoExpress license). * Write ability for

MrSID on Windows only. For more information, please visit http://

www.avenza.com/geographic-imager/lizardtech-mrsid.

NITF (ntf)

Read and Write (write not available with Basic license)

The National Imagery Transmission Format (NITF) data format is widely used by

geospatial analysts in the defense and intelligence communities. The NITF format

contains imagery and associated metadata in a single file.

PCI EASI/PACE (pix)

Read only

PCIDSK database files are used by PCI EASI/PACE software for image analysis. All

pixel data types, and data organizations (pixel interleaved, band interleaved, file

interleaved and tiled) should be supported, but compressed PCIDSK files are not

supported. Currently LUT and PCT segments are ignored. Overall file, and band

specific metadata should be correctly associated with the image or bands.

http://www.avenza.com/geographic-imager/lizardtech-mrsid
http://www.avenza.com/geographic-imager/lizardtech-mrsid
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Georeferencing is supported though there may be some limitations in support of

datums and ellipsoids. If control point segments are present, the first will be used,

and the rest ignored. Internal overview (pyramid) images will also be correctly read

though newly requested overviews will be built externally as an OVR file.

SGI Image Format (rgb, rgba, int, inta, bw)

Read only

The SGI image file format is part of the SGI image library found on Silicon Graphics

machines. The driver currently supports 1, 2, 3, and 4 band images. The driver

currently supports "8 bit per channel value" images. The driver supports both

uncompressed and run-length encoded (RLE) images for reading, but created files

are always RLE compressed. The *.rgba, *.int, *.inta, and *.bw extensions

supported since Geographic Imager 5.0.

Web Map Service

Read only

Web Map Service is an interface standard designed by the Open Geospatial

Consortium (OGC) for GIS raster data

transactions through http protocol. The Geographic Imager WMS import connects

to servers that use version 1.1.1 of the OGC standard. WMS data formats include

TIFF, GIF, PNG, and JPEG. See Advanced Import.

4.2 Supported DEM Formats

ArcInfo ASCII Grid (agr, asc)

Read and Write

ArcInfo ASCII Grid refers to a specific interchange format developed for ArcInfo

rasters in ASCII format. The format consists of a header that specifies the

geographic domain and resolution, followed by the actual grid cell values. Export  is

supported through the ASC format with an associated PRJ file.

ArcInfo Binary Grid (adf)

Read only

dblbnd.adf, hdr.adf, log, prj.adf, sta.adf, vat.adf, w001001.adf, w001001x.adf

The ArcInfo Binary Grid is formed from a set of the files contained in a directory

(listed above). When loading a raster into ArcGIS, it sees the containing directory

as a single DEM, not as a directory containing other files. Due to software
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limitations, Geographic Imager does not see the whole directory as a single DEM

and instead requires that the appropriate ADF file to be selected for use (navigate

to the directory containing w001001.adf file).

ArcInfo Binary Float Grid (flt)

Read only

The ArcInfo Binary Fload Grid is a binary file that stores floating point data

(topological elevation values) line by line from north to south. It must be used with

an accompanying header file (HDR) that contains the georeferencing information

(both files must be stored in the same directory to function).

BIL (bil)

Read and Write (can be opened as raster with color file)

The BIL format, meaning "band interleaved by line", is an uncompressed file

containing the actual pixel values of an image. Pixel information is stored in

separate bands within the file. It is possible to display one specific band in a multi-

band BIL image. BIL files can consist of black and white, grayscale, pseudocolor,

true color, and multi-spectral images. There are four image description files (ASCII

text file format) that can accompany a BIL file: a header file, a statistics file, a

resolution file, and a color file.

The header file (HDR) provides a description of the data through the use of

keywords and values. The statistics file (STX) is an optional file that describes the

image statistics for each spectral band. It records the minimum and maximum pixel

values, the mean, the standard deviation, and the two linear contrast stretch

parameters. The resolution file (BLW) describes the height and width of each cell

and the coordinate position of the top left cell of the data.  The color file (CLR) is

an optional file that describes the image colormap.

ERDAS IMAGINE DEM (img)

Read only

ERDAS IMAGINE uses IMG files to store raster data. These files use the ERDAS

IMAGINE Hierarchal File Format (HFA) structure. A tiled format is used to store

raster layers. This allows raster layers to be displayed and resampled quickly. Each

raster layer within an IMG file has its own ancillary data, including the following

parameters: height and width (rows and columns), layer type (continuous or

thematic), data type, compression, and lock size.
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Grayscale GeoTIFF DEM (tif, tiff)

Read and Write

GeoTIFF DEM is unique in that it uses a floating point 32-bit data type as opposed

to a more typical signed 16-bit data type for elevation data. GeoTIFF DEM must be

imported using Geographic Imager Advanced Import and is converted from 32-bit to

16-bit on import. Cropping when using Advanced Import will create a new DEM

schema range based on the cropped area’s elevation.

Military Elevation Data / DTED (dt0, dt1, dt2)

Read only

The National Geospatial-Intelligence Agency (NGA) developed a standard digital

dataset called the Digital Terrain Elevation Data (DTED®). It is a dataset of terrain

elevation values that provides basic quantitative data for systems and applications

that require terrain elevation, slope, and/or surface roughness information. DTED

datasets come in three levels: Level 0, Level 1 and Level 2.

DTED Level 0 elevation post spacing is 30-arc-second (nominally one kilometer).

DTED Level 0 was derived from NGA DTED Level 1 to support a federal agency

requirement. DTED Level 1 is a uniform matrix of terrain elevation values with post

spacing every 3-arc-seconds (approximately 100 meters). The information content

is approximately equivalent to the contour information represented on a 1:250,000

scale map. DTED Level 2 is a uniform gridded matrix of terrain elevation values with

post spacing of one-arc-second (approximately 30 meters). The information

content is equivalent to the contour information represented on a 1: 50,000 scale

map.

USGS SDTS (ddf)

Read only

The Spatial Data Transfer Standard (SDTS) is a robust way of transferring earth-

referenced spatial data between dissimilar computer systems with the potential for

no information loss. It is a transfer standard that embraces the philosophy of self-

contained transfers, i.e. spatial data, attribute, georeferencing, data quality

report, data dictionary, and other supporting metadata all included in the transfer.

USGS DEM (dem)

Read and Write

This is the traditional format used by USGS before being replaced by SDTS, and is
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the format used for CDED DEM data products from the Canada. Most popular

variations on USGS DEM files should be supported, including correct recognition of

coordinate system, and georeferenced positioning.

The USGS Digital Elevation Model (DEM) data files are digital representations of

cartographic information in a raster form. DEMs consist of a sampled array of

elevations for a number of ground positions at regularly spaced intervals. These

digital cartographic/geographic data files are produced by the U.S. Geological

Survey (USGS) as part of the National Mapping Program and are available in 7.5-

minute, 15-minute, also known as 30-minute and 1-degree units. The 7.5- and 15-

minute DEMs are included in the large scale category while 30-minute DEMs fall

within the intermediate scale category and 1-degree DEMs fall within the small

scale category.

SRTM (hgt)

Read only

SRTM is an international project spearheaded by the National Geospatial-

Intelligence Agency (NGA) and the National Aeronautics and Space Administration

(NASA). Digital elevation models of the earth’s surface were created with

measurements derived from the return signals received from two radar antennae on

a spacecraft. Each data file covers a one-degree-of-latitude by one-degree-of-

longitude block of the earth’s surface. SRTM consisted of a specially modified radar

system that flew on board the Space Shuttle Endeavour during the 11-day STS-99

mission in February 2000, based on the older Spaceborne Imaging Radar-C/X-band

Synthetic Aperture Radar (SIR-C/X-SAR).

DEM Data Considerations, Limitations and General Information

Geographic Imager imports DEM files into Adobe Photoshop as grayscale 16-bit

files. Currently, Geographic Imager can only save to Grayscale DEM GeoTIFF, USGS

DEM, ASCII Grid, and BIL.

The Raw Data DEM Schema creates a potentially low-contrast image and keeps the

source elevations directly mapped to actual pixel values. Mosaicking DEM files

using Advanced Import is recommended. Geographic Imager will create a DEM

schema to fit the range of the images being imported.

To view DEM values, use the Geographic Imager panel Survey tab. Use the Color
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Sampler Tool to choose up to four points on the image to view its DEM value. Drag

and drop individual points with the left mouse button pressed to change their

location. Use Ctrl (Win) or Command (Mac) and click to select individual points to

move or delete or right-click for additional options. Another way to view DEM

values is to use the Georeference dialog box. The elevation value is displayed

below the preview image.

4.3 Supported External Reference Formats

World File (tfw, tifw, wld, jgw, pgw, sdw, eww, blw, dmw, bpw, gfw)

Read and Write

World files contain the affine relationship between source image coordinates (pixel

locations) and real-world reference coordinates (lat/long or other real-world

coordinate units). World files simply contain a computed relationship between

source image coordinates and reference coordinates. It consists of the pixel sizes

in x and y direction, rotations about x and y axis and x and y coordinates of the

center of the upper left pixel. Reference points cannot be loaded from a world file

because they do not exist in the file. World files do not support storing coordinate

system information. You may export the coordinate system information as an

external WKT or PRJ file using the Export Coordinate System function.

Blue Marble Reference File (rsf)

Read and Write

The Blue Marble Reference Settings File saves the complete reference point list

information such that it can be loaded again in the future. Within a Blue Marble

Reference File, the first line contains the version of the file format (not to be

confused with the version of the software) and the total number of points in the

file. The remaining lines contain, in each line, the point ID, the x (row) pixel, the y

(column) pixel, the z (elevation) value which is usually 0.00, followed by the ground

coordinates expressed as Latitude or Northing (Y), Longitude or Easting (X) and

Elevation (Z). The last value indicates whether the point described on that line is

included in the solution, 0 = not included and 1 = included. Blue Marble Reference

files support storing coordinate system information and control points. Blue Marble

Reference files 

MapInfo TAB File (tab)

Read and Write
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MapInfo Table file formats save the complete reference point list information such

that it can be loaded again in the future. MapInfo TAB files support storing

coordinate system information and control points.

Supported projections when saving a coordinate system to TAB:

Albers Equal-Area 

Azimuthal Equidistant 

Hotine Oblique Mercator

Hotine Oblique Mercator 1pt

Lambert Conic Conformal

New Zealand Map Grid

Polyconic 

Swiss Oblique Mercator

Stereographic Transverse Mercator

ER Mapper Raster File (ers)

Read and Write

The ER Mapper header file is an ASCII file describing the raster data in the data

file. The entire header file holds information about the data source and is contained

in the DatasetHeader block. There are two compulsory sub-blocks, the

CoordinateSpace block (to define the coordinate space and location) and the

RasterInfo block (to define the characteristics of the data in the accompanying

data file). The RasterInfo block my contain a number of optional sub-blocks. To

completely define coordinate information in an ER Mapper header file you need to

include the following data: datum, projection, coordinate type, units, X and Y

dimensions for cell size, registration cell X and Y values, registration cell

coordinates, and possibly null cell value. Coordinate information is frequently, but

not always, given for the upper left corner of an image. This would be registration

cell X and Y values of 0.0 and 0.0. For most projections registration coordinates

are entered as eastings and northings, the coordinate type will be "EN", and units

will be meters (or occasionally feet). If you are using latitude and longitude the

projection is Geodetic, coordinate type will be "LL" and the X and Y dimensions for

the cell size will be in decimal degrees.

ER Mapper files support storing a limited number of pre-defined coordinate systems.

Check the coordinate system details to ensure the ER Mapper identifier exists as

the issuer for the coordinate system to be saved. The file will still be exported

however the coordinate system will not be saved with the reference file.
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ER Mapper reference files do not support rotated images. When attempting to

export a reference file with a rotated image ER Mapper will not be listed.

4.4 Data Considerations and Limitations

When obtaining spatial imagery for use with Geographic Imager, whether from an online

source, commercial vendor, government office or a source within your organization,

there are a number of important considerations to keep in mind. Use the File > Open

command to view the list of reference files supported by Geographic Imager and try to

obtain data in one of the formats supported. In cases where the file format is native

to a particular mapping application and is not supported by Geographic Imager, you

can often request the data provider to export a file in one of the supported formats.

When obtaining data, acquire as much metadata as possible. If an image is received in

any format other than GeoTIFF, obtain a reference file in one of the formats supported

by Geographic Imager. It is important to obtain the name of the projection, the datum

and the units because subsequent reprojection of data relies on this information.

TIFF and BigTIFF files opened using Advanced Import do not support layers, text and

other Adobe Photoshop specific image features. Generally, satellite imagery would not

contain any of these features which are added later using Adobe Photoshop. TIFF files

that are opened using just Adobe Photoshop (e.g. not with Advanced Import) are not

affected.

Opening any files over a cross platform network may increase load times.

Known Adobe Photoshop Limitations

Task or Operation Limitation

Select > Color Range The preview is based on an 8-bit image. The actual

selection on a 16-bit image may be different from the

preview.

Magic Wand tool This tool makes a selection based on an 8-bit image,

even if the image is in 16-bit mode. It is preferable to

select by Color Range.

Filter > Render > This filter only works on 8-bit images. Converting an
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Task or Operation Limitation

Lighting Effects imported DEM from 16-bit to 8-bit incurs data loss in

height resolution, therefore this filter should be used

at the end of a workflow.

Gradient Map

Adjustment Layer

A gradient map adjustment layer can be used to

colorize a DEM. Adobe Photoshop uses the gray scale

value of every pixel to assign a new color. This means

that the gradient map is scaled to (0 to 100) the DEM

elevation range. Applying the same gradient map to

two separate DEM files will give different colors to the

same elevation values. This must be taken into

consideration before using the Geographic Imager

Mosaic function.
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5 Opening Spatial Images

The ability to automatically recognize georeferenced images is at the foundation of

Geographic Imager. 

Opening a spatial image is the main starting point for most users wanting to use

Geographic Imager in Adobe Photoshop.

Geographic Imager supports all the image formats supported by Adobe Photoshop as

well as several formats supported by Geographic Imager.

This section provides information on how to open a spatial image, select and apply a

reference file and coordinate system. 

Topics covered in this section

Opening Images

Specifying a Reference File

Specifying a Coordinate System

Opening an Image with Advanced Import

Opening DEMs

Channel Management

Pixel Registration

5.1 Opening Images

When an image is opened, Geographic Imager will try to read associated spatial

reference information. External reference files that are not named the same will need

to be manually specified.

There are several common ways to open a geospatial image in Adobe Photoshop:

from the Adobe Photoshop File menu

double-click an image in operating system file browser*

by drag-and-drop (drag file to the application icon)*

using Advanced Import
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 * some geospatial image formats may be composed of multiple files. It is

recommended to open images from the Adobe Photoshop File menu or

Advanced Import.

From the Adobe Photoshop menu bar

1. From the Adobe Photoshop menu bar, go to File > Open.

2.Navigate to an image's location, select it, and click Open.

Double-click to open an image

1. In a file system browser, navigate to the image's location.

2.Double-click the document to open it.

 This is assuming the file format being opened is associated with Adobe

Photoshop.

Drag-and-drop into Adobe Photoshop

1. In a file system browser, navigate to the image's location.

2. Select the image and drag it into Adobe Photoshop or drag it onto the Adobe

Photoshop application icon.

Use Advanced Import

Advanced Import provides a way to import multiple images that can comprise of

different formats and different coordinate systems. Advanced Import has settings

to change reference file, source coordinate system, manage color channels,

choose DEM schema, adjust image size and extents and mosaic. It is also useful to

quickly crop large sized images to a specific geographic extent which may have

initially required a long load time.

Check for open image in the Geographic Imager panel

When an image opens, the Geographic Imager panel displays different coordinate

systems. Advanced Import has settings to change reference file, source coordinate
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system, manage color channels, choose DEM schema, adjust image size and

extents and mosaic. It is also useful to quickly crop large sized images to a specific

geographic extent which may have initially required a long load time.

Related topics

The Geographic Imager Panel

Opening Images with Advanced Import

Pixel Registration

5.2 Specifying a Reference File

When a spatial image is opened, Geographic Imager will automatically detect whether

it is georeferenced or not. When an image is recognized as a spatial image, the

Geographic Imager panel displays the name of the reference file and additional

information: the northwest (top left) and southeast (bottom right) corner coordinates,

image size, pixel size and rotation angle. Units are not indicated if no coordinate

system is specified. For a spatial image to be recognized, an external reference file

(e.g. World file) needs to be in the same folder as the image, except for files that have

internal referencing (e.g. GeoTIFF).
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An opened image (GeoTIFF)  has an internal reference
file and is listed as "boston-east.tif"

When a reference file is not found, it may be necessary to manually specify one. Once

a reference file is specified, any changes to an image’s referencing will be reflected in

the reference file when the image is saved.

How to specify a reference file

1.Click the Reference File Specify link in the Geographic Imager panel.
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2.Alternatively, in the Geographic Imager panel options menu, choose Specify

Reference File. In the Choose a Reference File dialog box, browse and select a

reference file of one of the supported external reference formats listed in the File

Type drop-down list.

When multiple reference files match the image name are located in the same folder,

you will be prompted to choose the appropriate reference file. Any changes in

document georeferencing will be saved to the chosen reference file.

If no reference file is available but a collection of point coordinate locations are known

(such as the Top Left corner and Bottom Right corner coordinates), a custom

reference file can be created. See more about Georeferencing.

Related topics

Opening Images with Advanced Import

Georeferencing Images

5.3 Specifying a Coordinate System

When a spatial image is opened, Geographic Imager will automatically detect whether

it has a coordinate system specified in the reference file or not. Before you can

transform an image and perform any spatial related operations (like GeoCrop or

Mosaic), Geographic Imager needs to know the current coordinate system. If the

coordinate system information is not present in the image reference file, it is necessary
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to specify one.

An image without a coordinate system, but with a valid
World reference file.

Specify Source Coordinate System

Category Folders

The area on the left contains the folders of coordinate systems and subcategories

for both recently used coordinate systems and performed searches. Coordinate

systems are organized into two categories: Geodetic (unprojected, in latitude and

longitude) and Projected. Right-click a folder to rename it or create a new

subfolder in it.
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Coordinate System List

The coordinate system list displays the name, horizontal datum, point style units,

EPSG code and envelope of each coordinate system. Columns can be resized and

sorted alphabetically or numerically. Geodetic and Projected coordinate system

categories are sub-divided into world regions (continent/country/state or province)

to ease selection. To set a coordinate system, click the desired folder on the left

and click the desired coordinate system from the list on the right. Right-click a

coordinate system to access a context menu to View Info, Copy Object, Rename

Display Name or create New Object.

Search

All categories and subcategories can be searched by specific or all criteria.

Geodetic coordinate systems can be searched by name, horizontal datum, point

style units, envelope and EPSG code. In addition to the previous criteria, projected

coordinate systems can be searched by geodetic, projection type and projection

name. When searching for a coordinate system, the results are displayed in the

coordinate system list. Note that the search is always relative to the folder

selected category in the coordinate systems folder list. Choose the top level

Coordinate Systems folder to search through all geodetic and projected coordinate

systems.

Three subcategories contain specific information:

All: Displays all of the coordinate systems within that category.

Recent: Displays all of the recently used coordinate systems within that

category.

Search History: Displays all of the search results for that category.

 The subcategories All, Recent and Search cannot be searched.

 To clear the Recent and Search subcategories, right-click and choose

Clear Recent (Search) History.

For a more information on projections and coordinate systems, as well as details on

editing and adding to the coordinate system database and loading and importing a 

coordinate system file or database, see Transformations and Coordinate Systems.

How to specify a coordinate system
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1.Click the Coordinate System link in the Geographic Imager panel or choose

Specify Coordinate System from the panel options menu.

2. The Specify Coordinate System dialog box provides three ways to specify the

coordinate system: From File, Same As, and Specify link. 

To set the coordinate system based on a reference file, click the From File

button. The Import Source Coordinate System From File dialog box appears.

Choose an existing reference file.

To set the coordinate system to be the same as that of another open image with

a coordinate system, click the Same As check box and then choose the image to

match from the drop-down list. This option is disabled if there are no other

referenced images open.

To set a coordinate system from the Geographic Imager data source, click the

coordinate system hyperlink. The Specify Source Coordinate System dialog box

appears and displays the contents of the current coordinate system database.

Navigate the category folders to view available coordinate systems.
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To find more information about the file, click the View coordinate system

information button (enabled when a coordinate system is selected). 

To remove a coordinate system from an image, click the Clear current coordinate

system button. 

An image can't be transformed until the coordinate system is known.

Important Notes

 Mac only: When opening a geospatial PDF and a copy of it (i.e. saved as

a different name) at the same time, the georeferencing will not be read on

the image that is opened second. Referencing will have to be specified

manually. This is due to a limitation in Adobe Photoshop.

Related topics

Transformations and Coordinate Systems

The Geodetic Datasource
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5.4 Opening Images with Advanced Import

Advanced Import provides a way to import multiple images that can comprise of

different formats and different coordinate systems. Advanced Import has settings to

change reference file, source coordinate system, manage color channels, choose DEM

schema, adjust image size and extents and mosaic. It is also useful to quickly crop

large sized images to a specific geographic extent which may have initially required a

long load time. 

Click the Advanced Import button on the Geographic Imager panel.

Advanced Import button

Advanced Import Dialog Box

Format

In the Format drop-down list, select an image format (or leave as <Auto detect
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format>) then click Browse. Alternatively, drag and drop files into the file list. These

supported formats are compatible with Advanced Import:

Web Map Service GeoTIFF*/BigTIFF/TIFF

(including GeoTIFF DEM)

MrSID

ArcInfo ASCII

Grid

USGS DEM NITF

ArcInfo Binary

Grid

ECW PCI EASI/PACE

ArcInfo Binary

Float Grid

ERDAS IMAGINE Raster SDTS Transfer

BIL JPEG 2000 SGI

BSB Military Elevations Data/DTED SRTM

* Adobe Photoshop layers are not supported when imported through

Advanced Import. Multi-layer GeoTIFF files will be flattened.

Multiple images of varying formats can be imported at a time and are shown in the

Import File List. Additional information including coordinate system, DEM schema (if

applicable), and image dimensions are shown in the list. When a file is selected in the

list, it enables or updates the Reference File, Source Coordinate System, Channel

Management (if applicable), DEM Schema (if applicable), and Image Extents areas

below it. As settings in the dialog box are changed, the file list will update. To remove

a file from the list, click to select it, then click the Delete button.

Reference File

The associated reference file is displayed in this section (e.g. Rocky Mountains.tif).

To change the reference file, click Specify and browse for a new one. See Specifying

a Reference File.

Source Coordinate System

The coordinate system used in the reference file is displayed in this section (e.g.
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NAD27). To specify a new a new coordinate system, click the coordinate system

hyperlink to open the Specify Source Coordinate system dialog box (see Specifying a

Coordinate System). Alternatively, choose a coordinate system from a file or assign a

coordinate system from an existing image in the File Import List.

Channel Management

The color mode is displayed in this section (e.g. RGB Color - 3 channel). To edit how

the color mode channels are assigned, click the Modify button to open the Channel

Management dialog box (see Channel Management). Change the Color Mode in the

drop-down list. Click a channel role color drop-down list to assign that specific

channel a new color. To create image transparency based on a channel, click the

according check box in the Transparency column. These changes are displayed in the

list and will be reflected in the Adobe Photoshop Channels panel. For multiple selected

files that have same number of bands and color mode, the Modify button will be

enabled to allow for channel management modifications.

DEM Schema

The DEM schema is displayed in this section (e.g. Auto-stretched) and is only

applicable to DEM files. To change the schema, click the Specify button to open the

Import DEM file dialog box (see DEM Schema). The Import DEM file dialog box provides

options to apply a schema (custom , preset or saved) based on the statistics of the

raster data set. Use the Include DEM value range as part of the Auto-stretch schema

setting when importing multiple files that may be of similar data range or geographic

location. This will find the minimum and maximum values of all DEM files and use a

broader range than just a single file (indicated in the DEM Schema as Combined.) To

apply the same DEM schema to all files, ensure that the Apply to all DEM files in



Geographic Imager 5.0 Help104

© 2015 Avenza Systems Inc.

import list is checked.

Image Extents, Crop and Resample

The image extents of the selected file is displayed in this area (in pixels). Also

displayed are its scale and raw file size. There are two options available here: Crop

and Resample. Click the Crop button to open the GeoCrop dialog box to crop the

image. Click the Resample button to open the Resample Image dialog box to adjust

the size of the image by width/height or percentage value.

 When a crop is performed on a DEM with Auto-stretched schema type,

the DEM schema in the file list will update to specify it as Crop auto-

stretched.

 To crop WMS data, use the Crop tool in the Select Web Map Layer dialog

box when choosing a WMS layer.

Mosaic

When an image is already open or more than one image is listed in the Advanced

Import dialog box, the Mosaic all files to the destination document option will be

available. Enable the option and choose the appropriate destination document to

mosaic into (either an existing open document or one of the images listed). The

destination document changes depending on which listed image is selected. The

images will mosaic upon import. See more about Mosaic.
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 It is not recommended to mosaic DEMs with different schemas. Enable

the Combine DEM value range in new schema option before mosaicking.

 Mosaic is not available with Basic license.

Mosaic Options

The mosaic options available in the Advanced Import dialog box are the same as

the mosaic options in the Mosaic dialog box. See Mosaic Options.

Advanced Import Notes

  Any image with multiple layers will be flattened. As a result of this, any

transparency that exists on layers is lost, however, channels are preserved.

To maintain transparency, use the File > Open command instead.

  If you're using a custom DEM schema and use GeoCrop, the cropped

result will still use the custom schema. It is recommended to use an Auto-

stretched schema when using Geocrop so that the new schema range for

the cropped result will be "Crop auto-stretched".

  Image rotation may not be read with some files exported from ArcGIS.

The Angle may display as "N/A" (not available) in the Geographic Imager

panel.

  When importing data using a Web Map Service, the "Set Background

Transparent" option is only a suggestion for the server to create a

transparent background. The WMS server may ignore this request, which

will result in an opaque background.

  When using drag and drop to add files, any files contained within

subfolders will not be added. Only files contained in the parent folder will be

added.

 Adobe Photoshop saves TIFF images in a way that channel transparency



Geographic Imager 5.0 Help106

© 2015 Avenza Systems Inc.

information is not compatible with Geographic Imager. A work around is to

save to BigTIFF because channel transparency information in this format is

compatible with Geographic Imager. If required, save it to TIFF since

Geographic Imager had previously written the channel transparency

correctly.

Related topics

Spatial Image Formats

Specifying a Reference File

Specifying a Coordinate System

Channel Management

Opening DEMs

Mosaicking Images

GeoCropping Images

5.5 Opening DEMs

Digital Elevation Models (DEM) and Digital Terrain Models (DTM) provide an effective

method of storing information for continuous surfaces. Measured elevation values of

the earth’s surface is the most common application of DEMs, however, other

applications include measurable phenomena such as rainfall, temperature and density.

DEM data needs to be rendered so it can be displayed visually. Depending on what

type of DEM data it is and how it should look, the type of rendering schema needs to

be customized or automatically assigned.

Requirements

The image must be a supported form of elevation or terrain data to invoke the Import

DEM file dialog box:

ArcInfo ASCII

Grid

BIL USGS DEM
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ArcInfo Binary

Grid

ERDAS IMAGINE USGS SDTS

ArcInfo Binary

Floating Grid

Military Elevation Data / DTED SRTM

See detailed information about each supported DEM format

Import DEM File Dialog Box

Open a supported DEM format using one of the methods described here. A detected

DEM will prompt the Import DEM File dialog box.

The Import DEM file dialog box provides options to apply a schema based on the

statistics of the raster data set. Use a custom DEM schema, an auto-stretched

schema or a raw data schema. A DEM schema increases the visual contrast of the

raster display. Depending on the required appearance of the DEM, apply a schema

suitable for the range of data within it. For example, DEMs may not contain the entire

range of values that can be displayed; therefore, applying an appropriate schema may

result in a sharper image and certain physical features may become easier to see.

Assign a DEM Schema

When a supported DEM is opened, the Import DEM file dialog box appears. To

prevent it from appearing every time, click the Don’t show again check box. This

forces all DEMs to use the last used schema every time. This is only recommended

if you're using Auto-stretched schema all the time. To reset when the Import DEM
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file dialog box appears, click the Reset 'Do not show again' preferences link in

the Geographic Imager Preferences dialog box.

In the Select Schema drop-down list, several schema are available and are

discussed below. To assign a DEM schema, click the OK button to accept the

settings of the Import DEM file dialog box.

Auto-stretched

The Auto-stretched schema displays continuous raster cell

values across a gradual ramp of Adobe Photoshop grayscale

colour space. This schema displays a single band of

continuous data and works well when a large range of

values need to be displayed. Auto-stretched allows for the

best precision preservation and automatically generates

high-contrast images.

 You can’t mosaic files unless they have the

same schema. Use Advanced Import to import

DEMs with different schemas and mosaic them

using a combined value range in a new schema.

Raw Data and Negative Raw Data

These schemas assign elevation data directly to the Adobe

Photoshop grayscale colour space. The Raw Data schema

facilitates mosaicking with other raw imported images. Since

it does not produce a high-contrast image, use Adobe

Photoshop adjustment tools such as Levels and Curves. Use

the Negative Raw Data schema with negative elevation

values. The image preview in the Georeference dialog box or

the Survey tab of the Geographic Imager panel can be used

to view elevation data values. More information on this in

the Important Notes section at the end of this topic.

Custom Schema

Custom schema are designated by blue text (or in its own

list group) in the Select Schema drop-down list. When a

custom schema is chosen, the Remove Schema and Edit
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Schema buttons are enabled.

DEM units and Precision

The default DEM units are displayed during import. To change the default units,

create or edit a DEM schema and click the Change Schema Units button . The

precision of the DEM is displayed but cannot be edited.

Delete a DEM Schema

To remove a DEM schema from the Select Schema drop-down list, click the 

Remove Schema button .

Edit a DEM Schema

To edit a DEM schema, click the Edit Schema button . Geographic Imager

analyzes the DEM to be edited and opens the Edit DEM Schema dialog box.

Creating a DEM Schema

To create a DEM schema, click the Create Schema button. Geographic Imager

analyzes the DEM to be imported and opens the Edit DEM Schema dialog box. The Edit

DEM Schema is populated with information available from the DEM. Any of the boxes

can be edited to customize the schema.

The Lowest Elevation and Highest Elevation values represent the lowest and highest

data values to be mapped in the Adobe Photoshop grayscale colour space. Editing

these values will change how the image is displayed. The File Data Range shows the

lowest and highest data values in the current DEM. Use it as a guide when entering

custom elevation values.
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The Restore Default Data Range Values button is only enabled when either the

Lowest Elevation or Highest Elevation box have a custom value entered. Click the

button to restore the data range as specified in the File Data Range display.

Vertical units is only used for mosaicking. The meter unit is displayed by default,

which is not dependent on the reference file of the current document. To change the

Vertical Unit, click the Change Schema Units button  and choose a new unit in the

Select a unit for the DEM file dialog box.

Advanced DEM Schema Settings

Advanced DEM schema settings must be used in conjunction with a custom schema.

To access the advanced DEM schema settings, click the Advanced button in the

Import DEM file dialog box. These advanced schema settings affect how specific

values in the DEM are displayed.

Display as transparent pixels

For DEM files where a No Data value can not be detected, specify any value to be

displayed as transparent. The unique values list displays any data values specified

to be a transparent pixel. The pixels are not removed or deleted from the DEM

when specified as transparent. A No Data value (-32767.00) is always displayed as

transparency and cannot be removed from this list.

Add and Remove values

Click the Add New Value button to add a new value to the list (range values are
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not supported). Double-click the <new value> item and type in a new value

(displayed with a blue color). To remove a value from the list, select value(s) and

click the Remove Selected Value(s) button.

DEM elevation range

When the Always scan the dataset option is enabled, the whole DEM dataset is

scanned for values when first opened instead of reading a data range from the DEM

header (if it exists). By default, this option is disabled, which improves

performance. However, sometimes the values stored in DEM header may be

incorrect, so this option to scan the entire file will attempt to obtain the correct

DEM elevation range.

Some values in a DEM can be interpreted a positive or a negative integer. If a DEM

dataset doesn't specify whether it is signed or unsigned, the Use signed data

range option can be enabled to specify it as signed. Essentially this option allows

you to change the data type (singed/unsigned) interpreted from DEM.

Important DEM Schema Notes

Mosaic DEM files

When mosaicking DEM files together, each file must have the same DEM schema

and an appropriate Vertical Unit specified. It is important to know the data range

of all the DEM files that will be mosaicked so that a DEM schema can be created

that encompasses the highest and lowest elevation of all the DEM files. It is

recommended to use Advanced Import to mosaic multiple files that have different

DEM schemas.

Esri BIL files

When opening BIL files without a colour table, the Import DEM file dialog box will

show the options to Open as raster image or Open as elevation data. When a

colour table (.clr file) is present in the same folder as the BIL file, it is automatically

opened as a raster image.

View Elevation Values of a DEM

There are two ways to view DEM elevation values. Open the Georeference dialog

box, the actual elevation value is displayed below the image preview. Move the

mouse cursor to any position within the image view to see the values (updated in
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real time).

The other way is to plot points with the Color Sampler Tool and view DEM elevation

values in the Survey tab of the Geographic Imager panel. Up to four different

points can be viewed at a time.

DEM Schema and Scripting

The creation of DEM schema cannot be recorded by Adobe ScriptListener or by

using example scripts. Any DEM schema will have to be created prior to using

automation.

Out of Range DEM Values

A warning is displayed when DEM files that contain low or high elevation values out

of the shema range are imported. These out of range images may import

incorrectly.

Negative Raw Data

The Negative Raw Negative schema only imports negative elevation values. To

work with both positive and negative values,  duplicate the DEM and re-open each

with the appropriate DEM schema.

Related topics

Opening Images with Advanced Import
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Terrain Shading DEMs

5.6 Importing WMS

Import raster data with the Web Map Service (WMS). It accesses web servers that

deliver raster content in a variety of formats. There are no format specific settings

associated with this importer. To access WMS, go to Advanced Import and choose

Web Map Service in the Format drop-down list, then click Browse. 

The Browse Web Map Service dialog box is used to manage web services. Click Load

Services From Avenza to populate the list with a number of services aggregated by

Avenza Systems. To add a new service click the Add button, then add the service

URL. 

 Geographic Imager WMS importer only supports WMS version 1.1.1.

Select Web Map Layer
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Layers

On the Select Web Map Layer dialog box, choose a layer from the layer tree. Only

one layer can be imported at a time. A description and preview provides more

information about the layer and its extents. 

Format

Choose from a variety of formats including: TIFF, GIF, PNG, and JPG.

Number of X pixels

Specify an X pixel (width) to change the imported image size. The Y pixel (height)

is proportional. Depending on the layer, specifying a large X pixel value larger than

the layer will prevent it from being imported.

Crop

Optionally, click Crop to open the GeoCrop dialog box. Use GeoCrop to specify a

crop area.

Related topics

Opening Images with Advanced Import

GeoCropping Images
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5.7 Channel Management

Adobe Photoshop uses channels to store color information about an image. Geographic

Imager Channel Management allows you to control channel mapping and assignment of

channel color roles for false-composite multiband imagery. Channel Management is

available on the Geographic Imager panel and when using Advanced Import.

The Color Mode drop-down list provides available color modes: RGB Color, Lab Color,

Grayscale, and CMYK Color. Each color mode has its own set of channel colors:

Color Mode Color Mode Channels

RGB Color Red, Green, Blue

Lab Color Lightness, A, B

Grayscale Gray

CMYK Color Cyan, Magenta, Yellow, Black

To edit how the color mode channels are assigned, click the Channel Role drop-down

list to assign that channel a new color (such as Red, Green, or Blue, for an RGB color

mode). To change a channel name, double-click one in the Channel Name column and

type a new name. Enable the Live Preview option (Windows only) to see how the

visibility and channel role adjustments affect the image. Enable the Display One

Channel Only option to isolate visibility of a selected channel. When these changes
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are confirmed, they are reflected in the Adobe Photoshop Channels panel.

Important Channel Management Notes

 Live Preview and Display One Channel Only options are not available on

Geographic Imager for Mac.

 By default, if the color mode of an image can't be detected, the color

mode is set to Grayscale Color with alpha channels if it has fewer than

three channels. Otherwise Color Mode is set to RGB Color with alpha

channels.

 Channel management is not compatible with 32-bit images.

 Color Mode is not available for images imported from a Web Map Service.

 Channel name read and write capability is only supported with the IMG

format.

 Changing color modes will flatten layers and any transparencies will be

lost.

 When using Advanced Import, the MrSID encoder (MG4) adds an extra

alpha channel as transparency when it saves an image. This means that

one channel is used as transparency and the total number of alpha channels

is less than is shown in the channel management dialog box.

 You can only apply transparency from a channel using Advanced Import.

Related topics

Opening Images with Advanced Import

5.8 Pixel Registration

The coordinate information shown in a World file (tfw) and the Geographic Imager

panel are different because World files use the center of the pixel to derive coordinate
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information while the Geographic Imager panel uses: 1) the top left corner coordinates

of the pixel placed on the very top left corner of the image; and 2) the bottom right

corner coordinate of the pixel placed at the very bottom right corner of the image. The

second and third values in the World file are zero because there is no rotation or skew.

When saving to GeoTIFF, it is possible to choose a different reference method: Pixel-

As-Area or Pixel-As-Point. Pixel-As-Area uses the upper left corner of a pixel as

registration. Pixel-As-Point uses the center of the pixel as registration. A Geographic

Imager preference allows you to keep existing pixel reference point of current image or

override by choosing Pixel-As-Area or Pixel-As-Point.

Related topics
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The Geographic Imager Panel

Opening Images

5.9 Open Image Tutorials

5.9.1 Open Images and Transform Tutorial

Open Images

Opening a spatial image is similar to opening up any other image in Adobe Photoshop.

1.Make sure you have installed Geographic Imager.

2. In Adobe Photoshop, choose File > Open. Browse to the \Tutorial Data\Americas

folder and open both Americas_1.tif and Americas_4.tif.

Make the Americas_4.tif file the active document and open the Geographic Imager

panel. If the panel is not visible, choose Window > Extensions > Geographic Imager.



Opening Spatial Images 119

© 2015 Avenza Systems Inc.

The Americas_4.tif has no spatial data, however, you can specify reference

information and a coordinate system using the Geographic Imager panel.

A reference file contains coordinates that describe the location, image size, pixel size,

and rotation of an image file. It does not contain actual image data. Next, you'll

specify a reference file for the Americas_4 document.

3.With the Americas_4.tif file as the active document, click the Reference file 

Specify link in the Geographic Imager panel.

4. Select Americas_4_reference.tfw and click Open.
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The reference file Americas_4_reference.tfw (World reference file) is listed in the

Geographic Imager panel. On the General and Corners tab, there is some spatial

information displayed as well, including image extents, pixel size and top-left and

bottom-right coordinates.

The next step is to provide a coordinate system for the image.
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5.Keep these images open for the next tutorial.

Specify a Coordinate System

Some reference files do not store coordinate system information. For example, the

previously used tfw world file does not contain any coordinate system. To continue

the tutorial, you need to specify a source coordinate system. For more information on

reference files, see Specifying a Reference File.

The Americas_4.tif currently has no coordinate system assigned. You’ll specify a

coordinate system similar to the Americas_1.tif using these steps.

1.With the Americas_4.tif file still the active document, click the Coordinate System 

Specify link in the Geographic Imager panel.

You can specify a coordinate system for the active document in one of two ways:

choosing from a database of coordinate systems or choosing one that another open

image has. First, choose from a database of coordinate systems:

2. In the Specify Coordinate System dialog box, click the [No Coordinate System

Specified] link.

3. In the Select Coordinate System dialog box, expand the Coordinate Systems >

Geodetic > World category, select WGS 84 in the coordinate system list and click

OK.
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4.Click OK in the Specify Coordinate System dialog box. 

Alternatively, you could use the Same as option since Americas_1.tif also has a WGS

84 coordinate system.

This assigns the WGS 84 coordinate system to the Americas_4.tif document. The

information is updated on the Geographic Imager panel.
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5.Keep these documents open for the next tutorial.

Transform a Coordinate System

Transforming a coordinate system transforms a georeferenced source image into a

destination georeferenced image with a different coordinate system. In this exercise,

the image will be transformed from WGS 84 coordinate system to British National Grid

coordinate system.

1.With Americas_4.tif still the active document, click the Transform button on the

Geographic Imager panel.
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2. In the Transform dialog box, click the WGS 84 link to select a different destination

coordinate system. 

This is different than specifying a source coordinate system. A destination coordinate

system is the coordinate system of the image after it is transformed.

3. Expand the Coordinate Systems > Projected > North America > United States

category, select United States: Lambert Conformal Conic, meter from the

coordinate system list and click OK. 
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This sets the destination coordinate system that will be used for the transformation.

At this point, Geographic Imager automatically selects an appropriate datum shift to

be performed during the transformation process. If this datum shift needs to be

changed, click the Specify button to open the Specify Datum Shift dialog box and

select the desired datum. See page Geographic Imager user guide for an explanation

of datum shift.
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 Note that the Pixel Size is 7077.28950515 meters. The pixel size can be

changed to any user specified value. This essentially changes the size of

the image as each pixel represents a geographic unit. In this instance, we

will leave the pixel size as the default.

4. Click the Transform button. 

The image is transformed to a Lambert Conformal Conic projected coordinate system.

5.Make the Americas_1.tif file the active document and click the Transform button on

the Geographic Imager panel. 

The panel displays the coordinate system as WGS84. You’ll also transform it to the

Lambert Conformal Conic projected coordinate system.

6.Click the Same As check box and choose Americas_4.tif (United States:

Lambert Conformal Conic, meter) from the drop-down list.

7. Click Update pixel dimensions to match the selected document when

prompted.
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8.Click the Transform button.

Both images are now in the same projected coordinate system (United States:

Lambert Conformal Conic, meter) and have the same pixel size. From here, the images

could be mosaicked together or saved to retain referencing.

5.9.2 Advanced Import Tutorial

Advanced Import allows you to imports images and provides useful settings to change
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reference file, coordinate system, color channel management, DEM schema, adjust

image size and extents and even mosaic. It is also useful for quickly cropping large

sized images to a specific geographic area which may have initially required a long load

time. In this exercise, you’ll import two images of different formats, image sizes, and

coordinate systems and then mosaic them together.

1.On the Geographic Imager panel, click the Advanced Import button. 

2.On the Advanced Import dialog box, choose GeoTIFF/BigTIFF/TIFF from the Format

drop-down list and click Browse.

3.Navigate to the Tutorial Data folder, choose boston-east.tif, and click Open. If

necessary, click OK to close the message box that warns about transparency and

layer effects.

Information about boston-east.tif is displayed in the Import File List and shows that it

has a Massachusetts Mainland Zone coordinate system and an 800 x 800 pixel image

dimension.

4. Choose ECW from the Format drop-down list and click Browse.

5.Navigate to the tutorial data folder, choose boston-west.ecw, and click Open.
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Information about boston-west.ecw is displayed in the list and shows that it has no

coordinate system and a 650 x 650 pixel image dimension. You’ll use the Advanced

Import options to make the images compatible so that they can be used in a mosaic.

6.Make sure boston-west.ecw is highlighted in the file list. Below it, in the Source

Coordinate System frame, click the Same As check box. 

Only boston-east.tif is available in the coordinate system drop-down list because it is

the only other file available in the file list. The coordinate system is updated to

Massachusetts Mainland Zone in the file list for boston-west.ecw. Next, you’ll change

the image dimensions for the GeoTIFF image by entering a resample value.
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7.Make sure boston-east.tif is highlighted in the file list. Below it, in the Image

Extents frame, click the Resample button to open the Resample Image dialog box.

8. Change the Width to 650 pixels. The Keep Aspect Ratio option ensures the height is

also 650.

9. Click OK.

10. The Dimensions column values update to reflect the resample size that you just

entered.

 

The Image Extents frame also updates to reflect the resample size.

Lastly, you’ll setup the mosaic option so that the files can be mosaicked together.

11. At the bottom of the dialog box, click the Mosaic all files to the destination

document check box.
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The boston-east.tif file is shown in the list and will be the destination document for

the mosaic.

12.Click OK to complete the Advanced Import process.

The two image formats are now mosaicked together to create one seamless image.

This is a similar result to a workflow that would have required you to open the images

separately, adjust the coordinate system, change the image size, and then create a

mosaic. 

In the Layers panel, notice that there is only one layer created from the two images.

To maintain separate layers, ensure the Keep source data on separate layers option is

checked in the Advanced Import dialog box.

5.9.3 Advanced Import DEM Tutorial

Advanced Import can also import DEM files and provide DEM schema settings. In this

exercise you’ll also specify coordinates to create a crop of the image. To learn more

about cropping just an image, see the GeoCrop Tutorial.

1.On the Geographic Imager panel, click the Advanced Import button. 
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2.On the Advanced Import dialog box, choose USGS DEM from the Format drop-down

list and click Browse.

3.Navigate to the \Tutorial Data\Mt Olympus 3D Landscape Data folder, choose 

MtOlympus.dem, and click Open.

The Mount Olympus DEM is displayed in the Import File List and shows that it has a

NAD83 / UTM zone 10N coordinate system and an 1047 x 1468 pixel image dimension.

Below the list, in the DEM Schema frame, the schema is displayed (as Yukon Water).

If the DEM Schema is not listed as Auto-stretched, click the Specify button and

choose the Auto-stretched schema. This will help the DEM to be displayed using a

colour ramp that is auto-stretched to it's values.

4. In the Image Extents frame, click the Crop button.

5. Choose Geodetic from the Unit Type drop-down list and choose Decimal degrees

from the Coordinates drop-down list. 

6. In the Top-left Corner frame, enter -123.750 into the Long box and enter 47.790

into the Lat box.

7. In the Bottom-right Corner frame, enter -123.715 into the Long box and enter

47.765 into the Lat box.
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8.Click OK.

The image dimensions are now 519 x 560 pixels (cropped from 1047 x 1468 pixels)

according to the crop coordinates you specified. The DEM Schema also changes to

"Crop auto-stretched" to indicate that not all of the values in the DEM are included in

the schema.
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9. You’ll save the DEM Schema so that it has a proper name and so you can see its

range values.

10. In the DEM Schema frame, click the Specify button.

11. In the Import DEM File dialog box, click the green Create New Schema button.

Enter Rocky Mountains Cropped as the new schema name, then click OK.

The elevation range values for the cropped image are 801 meters (lowest) to 1938

meters (highest). Before the crop, the range was 496 meters to 2429 meters. The

crop cut some of the lower and upper range elevations.

 

12.Click OK to close the dialog box.

The DEM Schema name is updated in the file list and in the DEM Schema frame below.

Its range values are also shown. The image dimensions also updated below in the

Image Extents frame.

13.Click OK to import the DEM.
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6 Transforming Spatial Images

Geographic Imager adds a new dimension to Adobe Photoshop by having the ability to

transform georeferenced images into a common coordinate system. It also allows you

to specify a custom coordinate system for transformation. Transforming spatial images

into another coordinate system is an integral part of Geographic Imager.

Image transformed from WGS 84 to the Winkel-Tripel projection.

Geographic Imager supports many coordinate systems ranging from local US State

Plane projects to world projections.

This section provides information on how to transform a spatial image, select and apply

a coordinate system, and create, load, edit and import a custom coordinate system.

Topics covered in this section

Using Transform

The Geodetic Data Source

Data Source Objects

6.1 Using Transform

The Transform feature reprojects an existing georeferenced image from its original

coordinate system to another one. The resulting transformed or destination image and

associated reference file can be used in many GIS, CAD and desktop mapping systems
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including MAPublisher for Adobe Illustrator.

Transform Dialog Box

When an image has a coordinate system specified, the Transform button in the

Geographic Imager panel will be enabled. Click the Transform button to open the

Transform dialog box—which displays the current geographic parameters of an image

and settings to transform it.

Transform button

Destination Coordinate System

Destination
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To set a destination coordinate system, click the coordinate system hyperlink. The

Specify Destination Coordinate System dialog box opens and displays coordinate

systems and projections available in the Geographic Imager data source. This

dialog box is similar to the Specify Source Coordinate System dialog box, however,

here you are specifying a destination coordinate system instead of a source. The

destination coordinate system is the coordinate system you want to transform the

image to. Explore the categories to find and select the desired destination

coordinate system.

 Coordinate systems are tested upon selection/transformation to

verify its suitability for a referenced image. A warning will appear if the

coordinate system appears to be partially or fully incompatible (based

on the coordinate system envelope).

To set the coordinate system to be the same as that of another currently open

and referenced image, choose the Same As option and the desired image from the

drop-down list. If there are no other referenced images open this option will be

disabled. Modifications to pixel size, resampling method, and strip width are

available as options (explained in detail below). 

Alternatively, click the From File button to use a coordinate system definition from

a coordinate system definition file (.wkt or .prj).
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Datum shift

Geographic Imager automatically selects an appropriate datum shift for the

transformation if required. If the selected datum shift is not the desired one, click

the coordinate system hyperlink to open the Select Datum Shift dialog box. Datum

shift types are displayed in the left category column titled Matching Datum

Transformations.

Each category contains the associated datum shift(s) for that reference network.

To view the information associated with the datum shift(s), click the View Datum

Transformation button. If a second datum shift is necessary, reference networks

will be listed in a subcategory called Using (coordinate system) as Intermediate

Datum. The View Second Datum Transformation button will be enabled to view

the secondary datum shift information.

 Due to the complex nature of performing such transformations, this

process may require extended processing time depending on the original

image size, destination pixel size, strip width, resampling method and

other parameters. For multiple transformations, consider running scripts

or actions to automate tasks.

 Multi-layer transformations can be transformed without flattening the

image, maintaining the original layers. Existing transparency is properly

maintained during transformation. To guarantee a seamless destination

image (i.e. with no gaps between the adjacent layers), make sure there

is a sufficient pixel overlap between the layers (e.g. when tiling the

original image). Using Nearest-Neighbor method or a smaller strip width

may also solve the problem.
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 Multi-spectral images are supported and maintained for

transformations, including support for infrared (RGBI), alpha and spot

channels.

 Layer masks are ignored during the Transformation process. Layers

masks are retained, however they may cause unforeseen errors if used

in a workflow. It is recommended that layers masks be removed before

any transformations are performed.

 When saving an image after a transformation has been performed,

Geographic Imager will update and overwrite the original reference file.

In order to keep the original image and reference files, use the Save As

command with a new file name or file location rather than using the

Save command.

Pixel options

The Pixel Size indicates the pixel resolution as the ground distance covered by each

pixel of the image. The pixel dimension and unit (corresponding to the selected

destination coordinate system) are displayed. Pixels are commonly square for

projected coordinate systems. In a geodetic coordinate system, pixels are not

necessarily square due to a varying size of degree of latitude depending on

geographic location. Therefore, the x-to-y ratio of a pixel could be determined by the

value of the Central Latitude which is commonly estimated by the center of the

image.

Modify Pixel Dimensions

Click the Modify button in the Transformation dialog box to open the Modify Pixel

Dimensions dialog box.
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The following are the available methods to calculate pixel dimensions:

Preserve existing Keeps the pixel dimension ratio the same as in the

source image. It keeps the transformed geographic

extents close to the original.

By center of output

image

Calculate the pixel ratio based on the central

latitude of the outgoing image which will be the

latitude of the true scale. Choose this option to

minimize the distance of distortion.

Keep pixels square Ensures the pixels of the transformed image are

square.

User specified Specify a custom x-to-y ratio. Enables Pixel Size

text boxes above.

 Certain methods such as Preserve existing and By center of output

image methods are not available for all transformations. To use the Preserve

existing method, the transformation needs to be either Geodetic to Geodetic

or Projected to Projected. If the destination image is geodetic, “y” pixel

dimension is effectively determined by the choice of the central latitude

(which is also the latitude of the true scale), therefore the option to set

the pixel ration By center of output image is only available when the
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transformation outcome is indeed Geodetic.

Advanced Options

Resampling Methods

There are several options for resampling the image during transformation:

Nearest Neighbor

(preserve hard

edges)

Takes the value of the pixel that is closest to the

transformed location in the source image. This is

the fastest method in terms of processing time and

is the method to use to preserve a colour panel

during image transformation. It is also the best

method to preserve original colours in some non-RGB

colour modes, such as CMYK, by avoiding the

internal conversion to/from RGB.

Bilinear Takes a weighted average value of the four pixels

closest to the transformed location in the source

image. This method results in a smoother image

than the nearest neighbor method but at the

expense of more processing time.

Bicubic (best for

smooth gradients)

Takes a weighted average value of the sixteen

pixels closest to the transformed location in the

source image. 

 A coordinate system transformation will resample an image, therefore any

image analysis or classification should be performed prior to a
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transformation.

Layers

There are several options to handle layers during transformation:

Leave intact Maintains the original layer structure.

Merge raster layers Combines only raster layers while maintaining vector

layers, for example text and transparency. Choose

this option to guarantee seamless edges between

different layers, especially if they don’t have

overlapping margins.

 Shaded relief effects will be disappear

after transformation is performed using

"Merge raster layers".

Merge layers Combines all layers into one layer, maintaining

transparency.

Trim transparent edges

Enabled by default, this option trims any excess transparency while maintaining the

extents of the image.

Precision and Strip width

To provide necessary transformation performance, Geographic Imager transforms

one horizontal strip of the image at a time. Change the Precision to adjust the strip

width being transformed:

Maximum (slow;

best for World

Projections)

Recommend when performing transformations on

images with the extent of the world.

High Uses a strip width of 10 pixels—high quality results

and slightly slower transformation performance. 

Normal The default setting using a strip width of 50 pixels—

a reasonable value for the majority of raster imagery
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combining good quality results and high

transformation performance. 

Medium (fast) Uses a strip width of 250 pixels—good quality results

and faster transformation performance.

Custom Set a custom strip width.

Some images may be optimized by setting a custom strip width, which may be

especially true when working with very small/world scale data, high latitude/polar

area imagery or projections that introduce severe spatial distortions. If the result

contains visible horizontal stripping artifacts or transparent gaps, choose a smaller

strip width or the Maximum precision setting. Choosing a smaller strip width will

result in a higher-precision transformation, but the transformation process may be

slower. Alternatively, for low-deformation, large-scale data or for a quick preview

of transformation results, a larger strip width can be used. 

For example, if an image being transformed displays a spherical curve, a smaller

strip width may be necessary to maintain a smooth image edge. If a larger strip

width is used there may a be a stepped edge to the image.

Related topics

The Geodetic Data Source

Georeferencing Images

6.2 The Geodetic Datasource

Geographic Imager includes an extensive geodetic parameter database called the

Geodetic Datasource. It contains all the latest updates from the widely used EPSG

Geodetic Parameter Dataset maintained by the Geodesy Subcommittee of OGP

(International Association of Oil and Gas producers) as well as custom systems

maintained by Avenza.

In addition, the Geographic Imager Geodetic Datasource supports your custom

definitions and allows you to import external WKT (Well-Know Text) and PRJ (Esri

projection file) parameter files.

Over 3500 pre-defined coordinates systems are readily available for use in most

cartographic projects. Even though the current list of systems is comprehensive, there
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may be instances where the end users may wish to add a brand new coordinate

system to meet their particular needs, or perhaps to duplicate and modify an existing

definition to

change the units for example. A complementary Avenza Projections Guide is installed

with Geographic Imager. It describes all the projections and datum shifts methods

supported by Geographic Imager, to assist users in the process of creating or editing a

coordinate system.

The default parameters installed with Geographic Imager are stored within read-only

XML database files referred to as the Geodetic Datasource (files named geodata.xml

and avenza.xsp). The base data source files shipped with Geographic Imager are

installed in the Data Source Files folder at the following location:

Windows 7/8: \Program Files\Avenza\Geographic Imager\Data Source Files

Mac: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Data Source

Files

Geographic Imager allows the creation of custom definitions where parameters are

stored in a separate XML file that can be saved or loaded—named 

customsystems.xml by default. It is recommended to use the default name and

default save location as Geographic Imager will have an option to keep a backup of

these files when uninstalling (Windows only) or re-installing. The backup files are

located in:

Windows 7/8: \ProgramData\Avenza\Geographic Imager

Mac: /Applications/Avenza/Geographic Imager/Data Source Backup

Geographic Imager will also create a file called customview.xvw. This view file stores

the organization and folder structure of your custom coordinate systems within the

geodetic data source. This file will also be included in the above locations when

uninstalling (Windows only) or re-installing. 

For Mac users, to restore the geodetic data source, copy the backup files from the

backup folder to the appropriate locations. For Windows users, the custom geodetic

data source is restored automatically if the option to backup files was chosen during

the uninstall process.

Load Custom Coordinate System



Geographic Imager 5.0 Help146

© 2015 Avenza Systems Inc.

A geodetic data source or coordinate system database can be loaded into Geographic

Imager, greatly extending the coordinate systems available for use. From the

Geographic Imager panel options menu, click Load Coordinate Systems and browse for

a geodetic data source.

When loading a custom coordinate system, remember that an accompanied schema

file named geocalc.xsd must be present with the XML file. If not present, the 

geocalc.xsd file can be copied from the Data Source Files folder located in:

Windows 7/8: \Program Files\Avenza\Geographic Imager\Data Source Files

Mac: /Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Data Source

Files

Edit Custom Coordinate System

Geographic Imager can be extended to support custom coordinate systems. By editing

the geodetic data source, it is possible to transform coordinates to and from a

coordinate system that is based on a standard map projection but is not predefined

within Geographic Imager. To edit a custom coordinate system, click Edit Custom

Coordinate Systems in the Geographic Imager panel options menu.

At the top of the Edit Custom Coordinate Systems dialog box, two directory paths are

listed: the geodetic data source path and the custom data path.

 The geodetic data source file is protected (read-only). Any additions or

modifications to coordinate systems are stored in a separate XML file called

customsystems.xml.



Transforming Spatial Images 147

© 2015 Avenza Systems Inc.

On the left-hand side of the dialog box is the data source object folders. To expand a

folder to see its subfolders, click the plus sign (Windows) or arrow (Mac) to the left of

the category name. To see the entries at any particular level of category, click the

category itself. When an object, folder or subfolder is selected, the data source

objects list box to the right displays the information stored within each one. User

defined coordinate system objects can be organized using drag-and-drop between

folders. Columns can be resized and sorted alphabetically/numerically.  Right-click on

a column header to show or hide it. Entries loaded from the main geodetic data source

will be shown in black text, while entries from the custom data file will be shown in

blue.

To create a new folder, click the New Folder button. A new folder will be titled "New

Folder" by default and can be renamed. Subfolders can also be created using the

same method. Only user-defined categories can be deleted using the Delete Folder

button.

Create New Data Source Objects

In the Edit Custom Coordinate Systems dialog box, click the New Object button to

create a new data source object. When creating new data source objects, the

identification information and definition parameters need to be completed. Complete

this information in the respective Identification and Definition tabs.

The Identification tab is used to name the object and associate identification

codes with it (if applicable). It is important to enter an appropriate name for the

object. The Remarks field can be used to add notes on a definition and is optional.

The Identifiers list may be used to add identifying codes for an object that may

come from other databases. The GC code is a unique identifier assigned by

Geographic Imager and should not be altered. To enter additional codes use the

space below it. When using automation, the Issuer and Issuer code are used to

identify coordinate systems. For more a complete list of EPSG codes, visit 

www.spatialreference.org.

The Definition tab is used to define the parameters of an object. Each object has

parameters unique to it. Refer to the list below when creating new objects.

 Refer to the Avenza Projections Guide for more information on

supported projections and their parameters as well as supported datum

http://www.spatialreference.org


Geographic Imager 5.0 Help148

© 2015 Avenza Systems Inc.

transformations methods.

Edit Objects

To edit a custom or user-defined object, click the Edit Object button . Edits may

be made in the respective object editor dialog box. Alternatively, double-click an

object to open the editor dialog box. When a data source object belonging to the

master data set is selected, the Edit Object button  is disabled (because these

objects are read-only). To modify an original object, create a copy of the object

first then edit it.

Delete Objects

When a data source object belonging to the master data set is selected, the 

Delete Object button  is disabled. Only user-defined objects can be deleted.

Copy Objects

Any object can be copied. To create a copy of an object, select an object and

click the Copy Object button . A dialog box will appear with "Copy of:" preceding

the object name in the Name box.

Move Objects

Any user defined object can be moved. Drag-and-drop an object from the Data

Source Objects List to a Data Source Object Folder. A dialog box will prompt you to

move the object or to create a shortcut to it.

Load Coordinate System Definitions

In some instances, the coordinate system of an image is not listed in the geodetic

data source or the reference file format does not support the coordinate system.

In such cases, it may be useful to load custom coordinate system definitions. In

the Geographic Imager panel options menu, click Load Coordinate System.

Geographic Imager can use the following coordinate system file formats: WKT

definitions (.wkt), MapInfo MAP files (.map), MapInfo TAB files (.tab) and Esri

projection files (.prj).

 When a coordinate system is loaded from a file (WKT or PRJ), it is

added to the geodetic data source but not saved. If the loaded file
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matches an existing definition, the original definition will be used and

the loaded definition will not be added. All new definitions are located at

the top level of the appropriate category in the Coordinate Systems

folder list (in either Geodetic or Projected). Before exiting Adobe

Photoshop, be sure to save your geodetic data source if you wish to

use the coordinate system definition again. This can be done through

the Edit Custom Coordinate System option.

6.2.1 Data Source Objects

Working with Data Source Objects

Individual entries in the geodetic data source are known as Data Source Objects.

Geographic Imager can support an unlimited number of custom objects. There are

different types of objects for different types of definition. Objects contained in the

geodetic data source are:

Data object Description

*All* Used to define the orientation of axes used and the

type of units used in the system.

Angular

Units

Type of units for measuring rotation.

Coordinate

Systems

A complete definition needed to express the context

of a set of map data.

Datum

Transforma

tions

Parameters to transform coordinates from one datum

to another.

Ellipsoids An ellipsoid gives a horizontal datum its size and

shape. An ellipsoid does not have an origin and

cannot be used as a base model for coordinates on

its own.

Envelopes Defines a geographic area of use for a particular

object.

Horizontal More commonly referred to as just "datum" is the
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Datums base model maps are built on. All coordinate systems

must have a datum associated with them to be

related to any other map. Without a known datum,

coordinates are meaningless.

Linear Units Units for measuring straight line, Cartesian distances.

Prime

Meridians

Defines longitude values of meridians.

*All*

For coordinate points, specify the coordinate point dimensions in either 2D or 3D.

For Geodetic and Projected Coordinate Points, the Longitude and Latitude style of

units must be entered for all 2D Dimensional Points. The Longitude, Latitude and

Ellipsoid Height style of units must be entered for 3D Dimensional Points.
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Angular Units

For angular units, enter a conversion for the new unit in terms of the scientific

standard Degrees. The Abbreviation is used to identify the unit within the

application interface (Example: The abbreviation for degrees is "deg").
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Coordinate Systems

For Coordinate Systems, select an Envelope defining the appropriate area of use. If

you are unsure of the appropriate envelope, you can leave it set to the default

World envelope. The Point Style is how you will select the style of linear units for

your system. For most projected systems, you will want to select "Projected point

in (units)". Then select the Geodetic model that using the appropriate datum for

your system. When you select the appropriate projection for your system, the

parameters needed to define the system will appear in the table below. Enter the

needed parameters and define the units each parameter is specified in.
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Datum Transformations

For Datum Shifts, select an Envelope (appropriate geographic area of use), Source,

Target and Method. If you are unsure of a more specific envelope, leave it set to

the default "World" Envelope. The Source and Target fields are used to specify the

two geodetic models the Transformation is valid for. The Method specifies the

necessary parameters to define a particular datum transformation. With the proper

method selected, enter the appropriate parameters for your datum transformation.

Be sure to define the appropriate units for each parameter by clicking the Units

button.
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Ellipsoids

For Ellipsoids you must enter the parameters for the Semi-Major Axis and Semi-

Minor Axis (often noted as "a" and "b" respectively) define the linear units the axes

are specified in by selecting a predefined unit in the appropriate fields. The Inverse

Flattening (often noted as "1/f") will automatically calculate in the field below.

Alternately, you can make the Inverse Flattening definitive by enabling the check

box at the bottom. You can then manually enter the Inverse Flattening rather than

the Semi-Minor Axis parameter.



Geographic Imager 5.0 Help158

© 2015 Avenza Systems Inc.

Envelopes

For Envelopes, specify the extents of the envelope (it is not required but

recommended). If the Specify Extents Points check box is checked, it is required to

enter the minimum and maximum points of the envelope and the point style the

value represent.
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Horizontal Datums

For Horizontal datums you must select the Ellipsoid the datum is based on, as well

as the prime meridian used.
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Linear Units

For Linear units, enter a conversion for the new unit in terms of the scientific

standard Meters. The Abbreviation is used to identify the unit within the

application interface (Example: The Abbreviation for Meters is "m")
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Prime Meridians

For Prime Meridians you must enter the longitude value of the Prime Meridian and

the angular unit that value is in.
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7 Georeferencing Images

Use the Georeference feature to reference an image by establishing ground control

points, choosing a transformation method, and specifying a coordinate system. It can

also be used to rectify—transform or warp—an image to match the image coordinate

system specified. Another important use of the Georefrence dialog box is to verify or

validate a georeference and see how it compares to its image extents online. The

Georeference dialog box also allows you to edit the existing referencing information of

an image and can be used to display and examine precise pixel coordinates, projected

or geodetic, and point elevations (for DEM images).

To reference or rectify an image, control pairs need to be created. A control pair is

created when a control point has its pixel coordinate related to a corresponding real-

world coordinate. Control points can be entered on the image view or manually

specified. World coordinates can be entered using an input coordinate format (e.g. in

latitude/longitude for a projected image) or by assigning world coordinates using an

online map service.

A referencing solution is calculated when sufficient control pairs are added for the

transformation method being used and an image coordinate system is specified.

Associated errors (the difference between computed values and the values specified)

are displayed for each control point. Modify control points in order to minimize the

referencing error before referencing or rectifying the image.
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Use the Validate tool to check how accurate your referencing is. If it is not accurate,

try modifying control points to minimize error.

Topics covered in this section

Using Georeference



Georeferencing Images 165

© 2015 Avenza Systems Inc.

Using Quick Georeference

Coordinate Formats

Georeference Preferences

7.1 Using Georeference

Requirements

Index colour mode is not supported. Any referenced or unreferenced image can be

used with the Georeference dialog box—verify a referenced image or reference an

unreferenced image.

Georeference Workflow

In general, the steps for georeferencing an image are as follows:

1. Add control points. Through the image view or import into the Control Point List.

2. Assign world coordinates (WX and WY) to each control point (PX and PY) to

create a control pair. Enter manually or assign world coordinates using an online

map service.

3. By default, the Georeference dialog box is set to reference an image without

rectification. If you want to rectify the image, choose an appropriate

transformation method (rectify is generally used to scale, stretch, rotate, and

distort an image).

4. Choose an appropriate image coordinate system. Specify one or use Solve/Find

Best and choose one from a list of estimated coordinate systems.

5. Check total world error of control points and adjust as necessary. 

6. Validate the accuracy of the georeference.

7. Reference or rectify the image when you’re satisfied with the registration.

Georeference Dialog Box

With an opened image (referenced or unreferenced), click the Georeference button
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in the Geographic Imager panel to open the Georeference dialog box. The image view

shows the current image and any existing control points. These control points and

their coordinate and error values (if available) are shown in the Control Point List.
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Add a Control Point Using Image View

To add control points in the image view, first click the Add Point button to enable

it. The cursor in the image view becomes a cross hair. Click within the extents of

the current image to add a control point. Pixel and coordinate locations of the

cross hair are displayed along the bottom of the image view. Points are added to

the Control Point List below the image view and are automatically assigned a name

and pixel coordinates (PX and PY). If you are assigning world coordinates online

you can add points later with the Assign World Coordinates Online dialog box open.

This way you can ensure you can identify the location online before creating the

control point.

Add Control Points from a File

To import a set defined control points, click the Import Additional Control Points

button. Supported reference point file formats include Blue Marble Reference files

(.rsf), MapInfo Tab files (.tab), Comma Delimited files (.csv). Imported control

points are added to the existing list. See Additional Georeference Features for more

information about formats. Exported CSV files created with Geographic Imager

contain the control point name, pixel location, world coordinates and the

associated coordinate system the world coordinates are entered in. 

 When a CSV file contains control points that don't have coordinate

system information, the imported points will be assigned the image's

coordinate system. If no image coordinate system is specified, it will be

assigned "Image CS" until one is specified.

Enter World Coordinates Manually

For each control point, enter the corresponding real-world coordinates (WX and
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WY) in the Control Point List to create a control pair. Double-click the Coordinate

System, WX or WY cell of a control point to enter or edit its world coordinates

manually in the Edit Location dialog box.

You can specify a control point coordinate system using the Coordinate System

hyperlink. Any coordinate system can be used to specify coordinates. If it is

unknown, entering X and Y values will use an Image Coordinate System. It is

common for lat/long values in WGS 84 coordinates are used. See the Coordinate

Formats section to learn about the types of coordinate formats that can be

entered. 

World coordinates can be sourced from information displayed on the image itself

(such as grids or graticules), from external sources (e.g. survey, corresponding

maps, etc), or from online map sources.

 The display format of world coordinates in the table is set in

Georeference Preferences. 

Assign World Coordinates Online

A control point must be created prior to assigning it a world coordinate online. Click

the Assign World Coordinates Online button to assign real-world WGS 84

coordinates using an online map service (an Internet connection is required). In the

Add World Coordinates Online dialog box, choose an unassigned control point

location in the Matching Point Location drop-down list, then click the corresponding

location on the online map to assign it a world coordinate. It is best practice to

zoom in to the image to ensure the point is in the correct location. You can

create/move/edit or delete a control point at any time with the Assign World

Coordinate Online dialog box open.
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Both the online map window and image view in the Georeference dialog box can be

navigated at the same time, often side by side. To navigate the online map, pan

and zoom with the mouse (and mouse wheel) or use the navigation control slider.

Optionally, enter street or city names into the Place search bar to find places

quickly. To navigate the image view of the Georeference dialog, use Ctrl (or

Command) and the mouse wheel to move left or right, use shift and the mouse

wheel to move up or down, use Alt (or Option) and the mouse wheel to zoom in or

out, and use the keyboard shortcuts to quickly switch between tools. (Keyboard

shortcuts for tools can be seen by hovering over each button.)

World coordinates in the Control Point List are updated after assigning matching

points in the Assign World Coordinates Online dialog box. When a control point has

both pixel coordinate and world coordinate entered, it is considered a control pair.

When at least four control pairs are valid and an image coordinate system chosen,

an image extents border is drawn in the Assign World Coordinates Online dialog box.

Edit a Control Point

When adding control points, some inaccuracy can occur and may result in larger

than desired error values. Editing the location of control points can greatly improve

the error statistics to fine tune the georeferencing. Modifying control points in the

Control Point List or directly in the image view. To edit the world coordinates,
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double-click the corresponding world coordinate cells or click the Assign World

Coordinate Online button.

Delete or Disable a Control Point

To delete a control point in the image view, right-click one to open the context

menu and choose Delete Selected Point. Optionally, choose Disable Selected Point

to disable the control point and prevent it from being used in the calculation for

georeferencing

To delete a control point in the Control Point List, click a control point row to

select it and click the Delete Selected Control Points button. To disable a

control point in the Control Point List, under the Use column, click the

corresponding check box to uncheck it.

Reference an Image

By default, the Georeference dialog box is set to reference an image without

rectification. Georeference requires a minimum of three valid control points to

exactly locate an image to a spatial location. When more than three control points

are used, residual errors are introduced. These errors should not be seen in a

negative light as they can provide feedback on the accuracy of the reference. It is

common to use more than three control points because if one control point is in

the wrong location, it can greatly affect the reference. Thus, even though the

residual error may increase as you add more control points, the overall accuracy of

the reference may increase as well.

Rectify Using a Transformation Method

To rectify an image, click the Rectify using check box and choose a

transformation method. The control points are used to build a polynomial

transformation that will shift the image from its existing location to the correct

spatial location. Depending on how many control points are valid, one method may

be better than another. Depending on the method, a minimum number of control

points are required:

Format Control Points

Required 

Used to

Affine (3 pts) minimum 3 Reference/

Rectify



Georeferencing Images 171

© 2015 Avenza Systems Inc.

Linear Polynomial (3 pts) minimum 3 Rectify

Quadratic Polynomial (6

pts)

minimum 6 Rectify

Cubic Polynomial (10 pts) minimum 10 Rectify

Quartic Polynomial (15 pts) minimum 15 Rectify

Quintic Polynomial (21 pts) minimum 21 Rectify

An affine method preserves collinearity (i.e. preserves points, straight lines and

planes) and ratios of distances (e.g. the midpoint of a line segment remains the

midpoint after transformation). In this sense, typical maps you are working with are

affinely referenced to their respective plane of projection and may only need a

slight shift to improve referencing. Rectifying an image using the affine method will

perform a transformation and create a north-up image without correcting any

distortion.

Higher transformation methods than affine have the ability to correct complex

image distortions, also known as rectifying. However, it is not common to use

transformations higher than third-order. Higher-order methods require more control

points and will require more inputs, processing, and adjusting to achieve an

acceptable result. In general, if your image needs to be scaled, stretched, and

rotated, use a lower-order method (quadratic). If the image must be distorted

even more (i.e. bent or curved) it may be more appropriate to use a third-order

method.

While an image with a large set of control points should provide the best results,

using an affine or a second-order method may not take advantage of the additional

control points. In general, your control points should be accurate, have good

coverage across the image, and are well spread out when attempting to rectify.

Having the sufficient number of points does not guarantee that the highest degree

polynomial available will result in a plausible solution; a trial-and-error approach

may be appropriate to obtain the best results.

 All control points will be maintained and can be edited until the

document is closed, rectified or transformed. Maintaining the control

points will allow you to make adjustments until the desired referencing

is achieved. Control points are not saved with the image itself. To save
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control points to a file, use Export Control Points.

 Control points are maintained in the coordinate system they are

entered.

Choose an Image Coordinate System

With a sufficient number of control pairs and a chosen transformation method, the

next step is to choose an image coordinate system. If you know the image

coordinate system, click the Specify hyperlink and choose a coordinate system. If

you do not know the image coordinate system, click the Solve button to see a list

of suggested coordinate systems. The Solve feature is only available for

referencing. When rectifying and using a transformation method, click the Find

best button to see a list of coordinate systems to rectify the image to.

When you click the Solve or Find best button, a list of coordinate systems that

are estimated based on calculations made with the selected transformation method

and control pairs provided is shown. The table is initially sorted by descending rank.

A rank of 0.00 or 1.00 means that it is a highly suitable coordinate system based

on the control pairs you specified, however, it doesn't necessarily mean the

reference is perfect. The Rotation column shows how much rotation the image is

subject to for a selected coordinate system. The Shearing column shows how

much the image will be skewed for a selected coordinate system. Selecting a

coordinate system is based on additional information such as your knowledge of the

image, geography that the image represents, and your project requirements. It is

recommended to view and compare combined error before selecting a coordinate

system to reference or rectify to.
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To use a coordinate system as the reference solution, select it from the list and

click OK. In the Control Point List, errors are populated in the error columns for

each control point. Try to minimize combined error by removing or adjusting control

points with high error. Each time you remove or modify a control point's

coordinates to minimize error, the Solve or Find best coordinate system list may be

different and results could have improved. It is an iterative process to achieve the

best results.

The following are the types of errors provided:

Format Extension

PXY Error Total pixel coordinate error

PX Error X pixel coordinate error

PY Error Y pixel coordinate error

WXY Error Total world coordinate error
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WX Error X world coordinate error

WY Error Y world coordinate error

Forward Residual Error in pixel units

Sum of Error in pixels (X and Y individual errors)

Inverse Residual Error in the same units as the image coordinate

system

Sum of Error in units of the coordinate system (X and

Y individual errors)

Interpret Residual Errors

When there are enough control pairs to compute a georeferencing solution, residual

errors for each control point are calculated. A residual error is the computed

difference between an observed source coordinate and a calculated source

coordinate. It is the measure of the fit between the true locations and the

transformed locations of the output control points.

A high residual error indicates possible error in either the observed source

coordinates or the reference coordinates of the reference point in question. The

forward residual is displayed in the same units as the spatial reference. The inverse

residual is displayed in pixel units. All residuals closer to zero are considered more

accurate.

When the error is particularly large, you may want to remove and add control

points to adjust the error. As a general rule, apply several different transformation

methods, select/deselect questionable points, and select the method and

reference points that yield the minimum residual error, assuming that the defined

reference points are correct.

Advanced Options

Click the Enable Advanced Options check box to enable the Remove Shearing

and Square Pixels options. Enable the Remove Shearing check box to remove any

shearing that may result (averages the X and Y rotation values and makes them

the same). Enable the Square Pixels check box to ensure that the X and Y pixel

dimension size is equal. The combination of these options will affect both pixel

coordinate and world coordinate errors.
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Validate (Show point online)

When a georeference solution has been applied to the image, you can use the

Validate tool to visually check how close your georeferencing is. Click the Validate

button and click a location on the image view. An online map service will open and

a corresponding placemark is placed on the web map with its WGS 84 Lat/Long

coordinates displayed. The extent (red outline) is also displayed on the web map to

show the extents of the image. You can continue to click the preview image to

validate locations and review them on the online map. Like the Assign World

Coordinates dialog box, the zoom of both the image view and the online map can

be independently changed.

 The Validate tool is disabled when the georeferencing solution is not

complete.
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View Image Extents Online

You can use View Image Extents Online to see the extents (red outline) of the

image on a web map. It is a useful tool to help verify how close the extents are

from image to real world.

 The View Image Extents Online tool is disabled when the

georeferencing solution is not complete.

Additional Georeference Features

Import Control Points Formats

A CSV or TXT file can be formatted with the following syntax so that Geographic

Imager will recognize the values when importing it into the Georeference dialog

box. 

Format Syntax

CSV pixel X value, pixel Y value, ground X value, ground Y

value

TXT pixel X value [TAB] pixel Y value [TAB] ground X value

[TAB] ground Y value
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 Importing a file with mixed delimiter formats is not supported.

 Log file format cannot be imported.

Export Control Points

Click the Export Control Points button and save the points using the available

export reference formats: log files (.log) and comma delimited (.csv).

The exported log file will contain all of the reference point pixel and world

coordinates (including used and unused points), referencing method, residual error

values, and points used. The exported comma delimited file will include pixel name,

reference point pixel, world coordinates and coordinate system of the world

coordinates, no error values or indication if the point is used and unused.

Context Menus

In the image view, for any control point, right-click to open a context menu that

allows you to delete the selected point, disable the selected point, or copy the

coordinate values. 

When copying coordinate values, several formats are copied to the clipboard. For
example, pasting the values into a text editor will result in the following:

220 288 42.3697 -71.0520

236898.936174

902231.024778

220, 288 represents the pixel coordinates (PX/PY)
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42.3697, -71.0520 represents the geodetic base coordinates (Lat/Long)

236898.936174, 902231.024778 represents the world coordinates (WX/WY)

In the Control Points List, right-click any control point entry to open its context

menu. You can delete or disable the point as well as center at or zoom to the

point.

Right-click any column heading in the Control Points List to open the Show/Hide

Columns context menu. In the Show/Hide Columns dialog box, uncheck any of the

columns to hide them in the Control Points List.
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Unreference

Click the Unreference button to remove all control points and any reference

information associated with the image within Adobe Photoshop. The unreference

action can’t be undone within the same work session (i.e. you can’t step backward

using Adobe Photoshop history). This does not delete any reference information in

the actual file unless you overwrite it during a save or export.

View DEM/DTM Elevation Values

To view the elevation value of a DEM or DTM, it must be imported using a DEM

schema. In the Georeference dialog box, actual elevation values are displayed

below the image view. Move the mouse cursor to any position within the image

view to see the values (updated in real time). Note that after applying Terrain

Shader, the elevation value will not be available.

Related topics

Transforming Spatial Images

Coordinate Formats

Using Quick Georeference

Georeference Preferences

7.2 Using Quick Georeference

An image can be georeferenced using one reference point and the pixel or image size,

two reference points, copy from an existing document or copy from a file. Certain

conditions and information are needed using this approach.

To start, click the Quick Georeference button in the Georeference dialog box. Choose

one of the four Quick Georeference options:

By Two Reference Points (North/South aligned)

By Tie Point (North/South aligned)

Copy From Document (same size/reference)

Copy From File (same size/reference)

By Two Reference Points (North/South aligned)



Geographic Imager 5.0 Help180

© 2015 Avenza Systems Inc.

Requirements to use two points:

Two reference point coordinates are known, however these points must not

contain the same coordinates in either the pixel (X/Y) or world (WX/WY) values.

The image is not rotated (image is North/South aligned).

Using this method changes the mode back to Standard. In this process, the four

corner coordinates of the image are generated to define the referencing. Points

that were not chosen to be used in the georeferencing are discarded. No dialog

box opens for this method, the changes are implemented immediately.

 Placement of the two reference points used for Quick Georeference

should be far apart to achieve a better reference.

By Tie point (North/South aligned)

Requirements to use one tie point:

One reference point coordinate is known (pixel and world location).

The image is not rotated (image is North/South aligned).

The pixel size or image size in world units is known.

Pixel size or image size must be in world units (geodetic or projected). Change the

method to enter either pixel size or image size.

Quick georeference by one tie point and existing document uses a georeferenced

image as the source to georeference an unreferenced image (as long as the
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second condition above is met). An existing document must have the same

coordinate system and pixel size but does not have to contain the geographic

extents of the image being georeferenced. Select By tie point and existing

document from the drop-down list to use this method.

Copy From Document (same size/reference)

This method copies all the geographic details from a georeferenced image into an

unreferenced image. An open georeferenced document must contain the same

geographic details as the image being georeferenced:

Geographic extents (top left and bottom right corner coordinates)

Image size

Pixel size

Rotation

 When Quick Georeference is used, the precision needs to be set to

the longest pixel value. When the precision is less than the pixel value,

the pixel value may be modified. When it is modified, the image will not

be able to be mosaicked with other images of the same pixel value. 

Copy From File (same size/reference)

This method copies all details from a georeferenced image to the current image.

This is similar to the Copy From Document method, except that the source

document does not have to be opened in Adobe Photoshop. Choose a supported

file format and appropriate reference file to use for georeferencing and click Open

to load its control points and coordinate system information.

7.3 Coordinate Formats

Different coordinate formats can be used when adding world coordinates in the Control
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Points List. The coordinate format depends on whether the coordinate system

specified is projected or geodetic. For projected coordinate systems (e.g. UTM Zone

17N), world X and Y coordinates are entered in the units of the coordinate system

(e.g. meter, kilometer, feet). For geodetic coordinate systems (e.g. WGS 84), world

coordinates are entered as degrees of latitude and longitude. Depending on what

coordinate format you want to enter coordinates as, choose a coordinate format type

from the Input Format drop-down list. You can control how coordinates are displayed

in the Control Points List by changing the Lat/Long Format drop-down list in 

Georeference Preferences.

Coordinate format Coordinate format

style

Input/Display

Decimal degrees (D+[.d*]) Input and display

Delimited Degrees Minutes

Seconds

(D+ MM SS[.s*]) Input and display

Delimited Degrees Minutes

Seconds with symbols

(D° MM' SS[.s*]") Display only

Delimited Degrees Minutes

Seconds with symbols & suffix

(D° MM'

SS[.s*]" [NESW])

Display only

Degrees.Minutes (D+.MM) Input and display

Degrees.Minutes with symbols (D+° MM') Display only

Degrees.MinutesSeconds (D+.MMSS[s*]) Input and display

Packed DMS with decimal point ((D)DDMMSS[.s*]) Input and display

Packed DMS ((D)DDMMSS[s*]) Input and display

 
Items in [ ] are optional, * means zero or more digits, + means one or

more digits.

Degrees coordinate format examples:
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Lines of latitude run east-west (e.g. the Equator) and lines of longitude run north-

south (e.g. Greenwich Meridian). Positive degree values represent north latitudes and

east longitudes. Negative degree values represent south latitudes and west longitudes.

Directions can be entered either with positing/negative values or using the letters N,

S, E or W preceding or following the numerical values, separated or not with a space.

Valid delimiters for Delimited Degrees Minutes Seconds format are: 

space, hyphen (-), colons (:) or underscore (_) : e.g. 43 41 48.98N, 43-41-48.98N,

43:41:48.98N or 43_41_48.98N

d (degree), single quote (minute), double quote (second): e.g. 43d41’48.98"N 

Packed formats require the use of two digits for degrees of latitude (e.g. 1°N must be

written 01) and 3 digits for degrees of longitude (e.g. 1°E must be written 001).

7.4 Georeference Preferences

Georeferences Preferences contains options that can help customize the interface.

Click the Preferences button to access Georeference Preferences.

Error Detection Tolerance

The standard deviation is calculated from the residual errors of the control points.

It is a statistic that indicates how much the control points match with the

computed values (depending on the chosen transformation method). Enable the

Show errors greater than number of standard deviations option to change the
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multiplier coefficient. Depending on the accuracy of the control points, the

multiplier coefficient and the transformation method used, points that fall outside

of the standard deviation range are considered as error. To set the threshold to

tolerate more error, change the multiplier coefficient to a larger value. To set a

threshold that will tolerate less error, change the multiplier coefficient to a smaller

value. Points that do not comply with the tolerance range (standard deviation

multiplied by coefficient) will be shown in red.

This method of error detection can be turned off by unchecking the Show errors

greater than number of standard deviations option. This will ensure all the control

points are listed in black.

 The values displayed in the Error Detection Tolerance correspond to the

PXY error and the WXY error respectively. As the tolerance level is changed

these values will update indicating the maximum tolerance value allowed.

Values that exceed the maximum tolerance will be displayed in red in the list

of GCP points.

Control Point and Label Colours

Choose colours for the control points and control point labels in the image view.

Lat/Long format and Geodetic Precision

Use the Lat/Long preference to change how world coordinates are displayed in the

Control Point List. In addition, use the Geodetic Precision preference to change

how many decimal places are displayed. A degree precision of one decimal place

(e.g 0.1 decimal degrees) has a qualitative scale of a large city, while a precision

of six decimal places (e.g. 0.000001 decimal degrees) has a qualitative scale of

individual humans. An example is displayed as to how these preferences affect the

display of geodetic coordinate values.

Projected Precision

Adjust the value in the Projected precision to change the number of decimals a

projected coordinate displays. Each coordinate format has its own default minimum

and maximum decimal precision. The default decimal precision is 6.

Related topics

Georeference Editor Preferences
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7.5 Georeference Tutorials

7.5.1 Georeference an Image Tutorial

The orthoimage used for this tutorial is of an area of Lafayette, Indiana, US courtesy

of the Indiana Spatial Data Portal. The image has no georeferencing, however for the

purpose of this tutorial, it has six green arrows indicating the positions of where you

will place control points while you georeference it.

1. In Adobe Photoshop, browse to the tutorial folder and open Lafayette.jpg from the

Tutorial Data folder.

On the Geographic Imager panel, the Reference file field is not specified because no

corresponding reference file is present in the image folder. Similarly, there is no

coordinate system specified.

2.On the Geographic Imager panel, click the Georeference button. 

The image was originally in a NAD83 / UTM Zone 16N projected coordinate system.

You can enter world coordinates as projected coordinates, but to make it simpler you

can enter world coordinates as latitude and longitude in the WGS 84 geodetic system.

3. To the left of the image preview, use the navigation controls to pan and zoom to

green arrow 1 located at the upper-left corner of the image.

4. Click the Add Point button and click precisely at the tip of the green arrow on the

image preview (zoom-in more if necessary).

http://gis.iu.edu/
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This adds the first control point named Point 1 at a pixel location of 352,489. A
new row is added in the control point table. You'll add a world coordinate to Point 1
to create a control pair. Good locations to place control points are at identifiable
locations like road intersections, building corners or property boundaries.

5. In the control point table, double-click the Coordinate System, WX, or WY cell.

6. Choose the WGS 84 coordinate system, and enter:

Lat: 40.417492

Long: -86.860779

7.Click OK.

The world coordinates are added to the point and the table is updated.

8.Using the navigation controls, go to green arrow number 2 at the upper-right corner

of the image. 

9. Click the Add Point button and click precisely at the tip of second pushpin.

10. In the control point table, enter the world coordinate for Point 2 as follow:

Lat: 40.417492

Long: -86.860779
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To add the control points for the third and fourth points, you'll import a CSV file.

11. Click the Import Additional Control Points button. Navigate to the Tutorial Data

folder, select Lafayette_point3and4.csv and click Open.

The control points — Point 3 and Point 4 — are added to the table and the image

view. The CSV file includes both pixel and world coordinates. You can move the image

view to see the green arrows for the third and fourth control points. You'll continue to

add the fifth and sixth control points.
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12. Add a control point for green arrow 5.

13. Click the Assign World Coordinates Online button.

The Assign World Coordinates Online dialog box opens a web map. The purpose of this

feature is to find the matching location on the web map to assign it to the fifth

control point. 

14. Make sure Point 5 (UNASSIGNED) is chosen from the Matching Point Location

drop-down.

15.Click the SATELLITE button to switch to a satellite web map view.

16. Using the other points as a proximity reference, find the location of the fifth

control point. (It's at the intersection of Sagamore Pkwy and Kossuth St). When

you have found this location, click the exact location you want to use as a world

coordinate (in the middle of the intersection). Click Yes to assign the world

coordinate to Point 5.
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You can navigate and interact with both the Georeference dialog box and Assign

World Coordinates Online dialog box at the same time.
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17. Repeat the same procedure for the sixth (and final) control point.

The reference Method is set by default to Affine which requires a minimum of three

points. Affine is used for referencing images and higher methods are generally used for

rectifying images. It is recommended to use as many control points as necessary to

calculate a good reference (six or more control points is good practice).

18. Click the Solve button.

The Solve feature calculates the optimal coordinate system to use based on the

control points you specified (that's why six control points were used). These

coordinate systems are very similar with similar combined errors. While anyone of

these could be used, it's best to use the coordinate system that matches data in

your own project. In this case, remember that the image was originally in a NAD83 /

UTM Zone 16N projected coordinate system.

19. In the coordinate system list, select NAD83 / UTM zone 16N and click OK.
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The control point table contains several columns on the positioning error of each

control point (in pixel or world units).

To reduce the error values, you could navigate and adjust the position of control

points. Look at the error columns in the control point table to see if this improves the

positioning accuracy. In addition, use the Validate tool and View Image Extents Online

to check how close your georeferencing is.

20.Use the Validate tool to check the accuracy of your referencing.

When using the Validate tool, you can still interact with the Georeference dialog box

at the same time.

21. Click Reference to complete the georeference. If a message appears, click

Continue to reference the image.
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The image is now georeferenced. The Geographic Imager panel indicates a reference

file named Lafayette.tfw and the coordinate system (NAD83 / UTM zone 16N). The

World (tfw) reference file format is the default reference format. It can be changed

in Geographic Imager Preferences.

 

22. To save the reference file and image file (although the image itself has not been

modified), choose File > Save in the Adobe Photoshop main menu. The reference

file, Lafayette.tfw, is saved in the same folder as the image file. Alternatively, use

Save As to save as a different format, including TIFF (which will save the image as

a GeoTIFF).

7.5.2 Quick Georeference Tutorial

Quick Georeference is a fast method to georeference an image. This method requires

two conditions:

The image is not rotated (image aligned to True North).

Only two points are needed to georeference, however these points must not

contain the same coordinate in either the X or Y pixel or world unit (i.e. two points

cannot be aligned on the same X or Y axis on either the image or world system).

In this tutorial, you're going to Quick Reference an image to the WGS 84 coordinate

system.
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1. In Adobe Photoshop, open Americas_4.tif from the Tutorial Data folder.

The image is unreferenced. It also meets the two conditions noted above - it isn't

rotated and is aligned to True North.

2. In the Geographic Imager panel, click the Georeference button. 

3.On the Georeferencing dialog box, to the left of the image view, click the Add

Control Point button. Click anywhere on the image view to add a point.

Point 1 is added to the control point list. You'll adjust the pixel coordinates (PX and

PY) and add world coordinates (WX and WY).

4.Double-click the PX cell and enter 599. Double-click the PY cell and enter 0.

5.Double-click the Coordinate System, WX, or WY cell.

6. Choose the WGS 84 coordinate system. Enter 35.917 into the Lat box and enter -

50.064 into the Long box, then click OK.
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The world coordinates are updated in the control point list

7. Add a second point to the image view. This time, use the pixel coordinates: PX = 0,

PY = 456; and use the world coordinates:  Lat = 6.731, Long = -88.417.

Now that two control point pairs are ready, you'll next use the Quick Georeference

feature.

8. Click the Quick Georeference button and select the option By Two Reference

Points (North/South aligned).

An additional control point is added to the control point list and image view. Its world

coordinates were calculated based on the existing two control point pairs. A minimum

of three control points are required to reference the image. Next, you'll choose the

image coordinate system.
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9.Click the Image Coordinate System Specify link.

10. On the Choose Coordinate System dialog box, click the [No Coordinate System

Specified] link.

11. In the Specify Source Coordinate System dialog box, expand the Coordinate

Systems > Geodetic > World category, select the WGS 84 coordinate system and

click OK.

12. Click OK to close the Choose Coordinate System dialog box.
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The image coordinate system is updated and the image is now ready to complete

referencing.

13. Click Reference to complete the georeference.

The document has been successfully georeferenced.

7.5.3 Rectify an Image Tutorial

Rectification or "rubber sheeting” changes the geometry of a raster image using
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multiple control points that provide georeference control. Depending on the chosen

geometric transformation (referencing) method, the correct process can decrease

geometric distortions, reorient and rescale an image so that its lines are parallel to the

axes of a specified geographic coordinate system.

In this example, you’ll take a historic map of an unknown projection and georeference

and rectify it to the WGS 84 coordinate system. The map has intersecting lines of

longitude and latitude which will serve as good locations for control points. A

sufficient number of ground control points distributed evenly across an image will need

to be specified. To rectify the image, the Quadratic transformation method will be

used.

1. In Adobe Photoshop, open Dakotas.jpg from the Tutorials Data folder.

Notice that the image is not georeferenced. Next, you’ll import existing ground control

points, move several of them to the correct position, and add two additional points to

complete referencing.

2. In the Geographic Imager panel, click the Georeference button. 
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Next, you'll add some control points.

3. Click the Import Additional Control Points button. Browse for dakotas_gcp.csv,

then click Open to add them to the Georeference dialog box.

Six ground control points appear in the image view as well as the control point list.

For the purpose of this tutorial, four of the points have already been placed in the

correct location. Next, you’ll move two control points (Point 1 and Point 3) to their
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correct positions. Notice that Point 1 has a world X and Y coordinate of -104.049 and

49.000 decimal degrees.

4.On the image view, zoom into Point 1 (top-left area of the image). Enable the 

Select Points button, then click and drag Point 1 to where the 49° line first

perpendicular line intersect (see the following graphic).

Point 1 is now in the correct position of approximately -104.000 and 49.000 decimal

degrees.

In the reference list, notice that Point 3 has a world coordinates of -97.000 and

49.000 decimal degrees. You'll move Point 3 to the correct position as well.

5.On the image view, zoom into Point 3 (top-right area of the image). Move Point 3 to

where the 49° line intersects with the 97° line.

Point 3 is now in the correct position of approximately -97.000 and 49.000 decimal

degrees. Next you’ll add two more ground control points and then choose the

appropriate reference method.

6. Click the Add Point button. Pan to the top-center area of the map. Click where the

lines of 101° and the 49° intersect. (If necessary, use the Select Points tool to
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move it into the proper position.) In the control point list, double-click the WX or

WY cell.

7.On the Edit Location dialog box, enter 49 into the Lat box and -101 into the Long

box, then click OK.

Point 7 has its world coordinates updated.

8.With the Add Point button still enabled. Pan to the bottom-center area of the map.

Click where the lines of 101° and the 43° intersect. For Point 8, double-click the

WX or WY cell. Enter the world coordinates of 43 into the Lat box and -101 into

the Long box, then click OK.
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With eight control point pairs, you can use a higher order method to rectify the

image. 

 Having a sufficient number of control points does not guarantee the

result will be a plausible solution; a trial-and-error approach may be

appropriate to obtain the best results. See Using Georeference for more

information about georeferencing and polynomial methods.

Next you'll specify WGS 84 as the image coordinate system and then choose a

method to complete the rectification.

9. Click the Image Coordinate System Specify link.

10. On the Choose Coordinate System dialog box, click the [No Coordinate System

Specified] link.

11. In the Specify Source Coordinate System dialog box, expand the Coordinate

Systems > Geodetic > World category, select the WGS 84 coordinate system and

click OK.
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12. Click OK to close the Choose Coordinate System dialog box.

13. To rectify, click the Rectify using check box and and choose Quadratic

Polynomial (min 6 points).

The Quadratic Polynomial method uses at least six ground control points to calculate

better georeferencing. The pixel and world error values will have minimized

(horizontally scroll the reference list to see error values.) WGS 84 is being used as the

image coordinate system because of the easily recognizable longitude and latitude

lines as reference. Using a combination of the quadratic polynomial method and WGS

84 coordinate system will help rectify this image into a useable georeferenced map.

14. Click OK. Click Proceed to rectify the image when the command window appears.
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15. To finish the image rectification, click Transform.

The image uses the Transform tool to complete the rectification. After the Transform

tool finishes, the image is rectified to the WGS 84 geographic coordinate system.

Notice that the lines of longitude and latitude on the map are straight. To verify the

georeference, use the Validate tool in the Georeference dialog box.
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8 Mosaicking Images

Data providers and government agencies provide many types of rasters including

orthophotos and DEM files, many of which are available without charge. Often, these

rasters are tiled and must be merged to generate a single and seamless coverage area.

Using Geographic Imager, you can mosaic images to create a single composite spatial

image.

The Mosaic feature creates a single composite georeferenced image from multiple input

georeferenced images, including DEM files. Available documents for the mosaic process

are allowed to have different properties such as coordinate system, pixel size and

rotation angle. These documents are transformed to match the properties of the

destination document. Advanced transformation options may be used when performing

a mosaic that requires a coordinate system transformation, resampling to match pixel

size or rectify a rotation.

Mosaick ing four images together, where the destination document has a projected coordinate
system. The result is a mosaic that has a projected coordinate system of the destination

document.

 Transformations during mosaic are not supported when the destination

document contains a rotation angle. To mosaic into a destination document

containing rotation the available documents to be mosaicked must have the

same coordinate system, pixel size and rotation angle.

8.1 Using Mosaic

Requirements

Mosaic requires images to be georeferenced. Images that have no coordinate system
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specified can still be mosaicked, however is assumed that all images being mosaicked

have the same coordinate system with the same pixel size. This is because a

transformation cannot be performed if no coordinate system is specified.

If the destination document contains a rotation, the input images must also contain

the same angle of rotation, coordinate system, and pixel size or else a transformation

can’t be applied. Remove the rotation of the destination document to mosaic images

with rotation.

If an image is flattened with white space where transparency should be, it is

recommended to convert that background layer to a layer and remove the whitespace

to ensure the mosaic will be seamless between the input images.

Input images with a different coordinate systems than the destination document will

be transformed to match the destination document.

Mosaic Dialog Box

Open all the georeferenced image files (at least two) required to make the mosaic.

The document that is active/selected will be the destination document, all other

documents can be mosaicked into the destination. Click the Mosaic button in the

Geographic Imager panel.

Mosaic button
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Destination Document, Available Documents, and Mosaic

Documents

The Mosaic dialog box displays the destination document and destination coordinate

system at the top. The Destination Document displays the active document. The

Available Documents list displays all open documents that can be included in the

mosaic. Images that do not satisfy the mosaic conditions of the destination document

(e.g. non-georeferenced image) cannot be included in the mosaic and are displayed in

gray with the reason why it is incompatible.

Images that meet the mosaic conditions of the destination document can be added to

the Mosaic Documents list using the transfer buttons - Transfer All or Transfer

Right. At least two documents are needed to create a mosaic image (the destination

document and at least one document in the Mosaic Documents list). All documents in

the Mosaic Documents list will be used in the mosaic. To remove a document from the

Mosaic Documents list, click the Transfer Left button. Mosaic documents can be

reordered by using the Up and Down buttons. The document at the top of the

Mosaic Documents list will be the first layer at the top of Adobe Photoshop Layers

panel after the mosaic is created.

Mosaic Options

Maintain Layers Enable to maintain mosaic documents as layers. 
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Place Mosaic Layers

Above Destination Layer

Input mosaic documents will be positioned above

the destination document. Mosaic and

destination documents order can be viewed in

the Layers panel.

Layer Blending Mode Apply an Adobe Photoshop blending mode for the

mosaic. Learn more about Photoshop blend

modes.

Mosaic Alpha Channels Enable to include all alpha channels in the

mosaic process.

Crop to Destination

Extents

Enable to crop to the extents of the destination

document. When this option is enabled, any

documents outside the destination extents are

disabled from being included in the mosaic.

Advanced Transformation Options

The Advanced transformation options frame is enabled when a transformation during

Mosaic is required (the destination document has a coordinate system that differs

from the mosaic documents). 

Layers

There are several options to handle layers of the mosaic document’s layers during

their transformation into the mosaic:

Leave intact Maintains the original layer structure of mosaic

documents being mosaicked

Merge raster layers Combines only raster layers while maintaining

vector layers, for example text and

transparency. Choose this option to guarantee

seamless edges between different layers,

especially if they don’t have overlapping

margins.

 Shaded relief effects will be

disappear after transformation is

https://helpx.adobe.com/photoshop/using/blending-modes.html
https://helpx.adobe.com/photoshop/using/blending-modes.html
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performed using "Merge raster

layers".

Merge layers Combines all layers into one layer, maintaining

transparency.

Resampling Methods

There are several options for resampling the image during transformation:

Nearest Neighbor

(preserve hard edges)

Takes the value of the pixel that is closest to

the transformed location in the source image.

This is the fastest method in terms of

processing time and is the method to use to

preserve a colour panel during image

transformation. It is also the best method to

preserve original colours in some non-RGB

colour modes, such as CMYK, by avoiding the

internal conversion to/from RGB.

Bilinear Takes a weighted average value of the four

pixels closest to the transformed location in

the source image. This method results in a

smoother image than the nearest neighbor

method but at the expense of more processing

time.

Bicubic (best for smooth

gradients)

Takes a weighted average value of the sixteen

pixels closest to the transformed location in

the source image. 

 A coordinate system transformation will resample an image, therefore

any image analysis or classification should be performed prior to a

transformation.
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Precision and Strip width

To provide necessary transformation performance, Geographic Imager transforms

one horizontal strip of the image at a time. Change the Precision to adjust the strip

width being transformed:

Maximum (slow; best for

World Projections)

Recommend when performing transformations

on images with the extent of the world.

High Uses a strip width of 10 pixels—high quality

results and slightly slower transformation

performance. 

Normal The default setting using a strip width of 50

pixels—a reasonable value for the majority of

raster imagery combining good quality results

and high transformation performance. 

Medium (fast) Uses a strip width of 250 pixels—good quality

results and faster transformation performance.

Custom Set a custom strip width.

Some images may be optimized by setting a custom strip width, which may be

especially true when working with very small/world scale data, high latitude/polar

area imagery or projections that introduce severe spatial distortions. If the result

contains visible horizontal stripping artifacts or transparent gaps, choose a smaller

strip width or the Maximum precision setting. Choosing a smaller strip width will

result in a higher-precision transformation, but the transformation process may be

slower. Alternatively, for low-deformation, large-scale data or for a quick preview

of transformation results, a larger strip width can be used. 

For example, if an image being transformed displays a spherical curve, a smaller

strip width may be necessary to maintain a smooth image edge. If a larger strip

width is used there may a be a stepped edge to the image.

Mosaic Results

When the Maintaining layers using blending mode option is enabled, the mosaic

documents will be grouped into image specific subfolders (the subfolder is named after

the image file name). Disabling the Maintain layers using blending mode option will
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respect the Merge layers setting in the Advanced Transformation frame (only when a

transformation is performed). When Mosaic layers above destination layer is enabled,

the input mosaic layers are placed above the destination document layer.

The mosaic can be treated like any other spatial image (e.g. toggle visibility, lock

layers, adjust colours). Other Geographic Imager tools can be used on the mosaic

such as Georeference, Transform, Tile and GeoCrop. However, some functions may

merge the layers, while others will keep the mosaic layers intact.

Important Notes and Limitations

 Unsupported image colour modes for the destination document are

Indexed Colour, Bitmap and Adobe Photoshop Multichannel. The colour mode

of the resulting mosaic is the colour mode of the destination document.

 Images with multiple channels will maintain them. However, channels will

be merged regardless of the channel type. Alpha channels will always

maintain order when merged (e.g. the alpha channel in the first position will
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be merged). When mosaicking images that contain mismatched alpha

channels, it is recommended to manage the alpha channels prior to mosaic.

 It is recommend to perform any coordinate system transformations as

early as possible during the image editing process to minimize potential

adverse effect on a complex layer structure.

 Shaded relief effects will be merged when a transformation is performed

using the Merge raster layers option.

 Images that are mosaicked or combined using the Adobe Photoshop

Photomerge operation will not retain georeferencing information.

 When mosaic documents don't have any overlap and a transformation is

being performed in the mosaic, gaps are likely to be seen.

 When mosaic documents don't have any overlap and a transformation is

being performed in the mosaic, gaps are likely to be seen.

Related topics

Opening Images with Advanced Import

Transforming Spatial Images

8.2 Mosaic Tutorial

In this tutorial, you'll mosaic several images of different coordinate systems together

to create one image that contains a projected coordinate system.

1. In Adobe Photoshop, open the Americas_1.tif, Americas_2.tif, Americas_3.tif

and Americas_4.tif files from the \Tutorial Data\Americas folder.

2.On the Americas_4.tif document, click the Reference file Specify link on the

Geographic Imager panel. Choose Americas_4_reference.tfw, and click Open.
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The Reference file is loaded, but the Americas_4 document still needs coordinate

system information.

3. Click the Coordinate System Specify link on the Geographic Imager panel, click the

Same As check box and choose Americas_1.tif (WGS 84) from the drop-down

list.

4. Click OK.

5.Make the Americas_2.tif the active document and click the Mosaic button on the

Geographic Imager panel.
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Notice that Americas_2.tif is in the Lambert Conformal Conic projected coordinate

system. It will be the destination document, meaning other images will be transformed

to the same coordinate system and then mosaicked. Available documents can have

different coordinate systems, different pixel sizes or contain rotation and still be

mosaicked. The images will inherit the coordinate system and pixel size of the

destination document.

 Transformations during mosaic are not supported when the destination

document contains a rotation. To mosaic into a destination document

containing rotation the images to be mosaicked must have the same

coordinate system, pixel size and rotation angle.

A list of available documents for mosaicking are displayed in the Available Documents

list of the Mosaic dialog box. You will specify the Mosaic Documents next.

5. Click the Transfer All button to move all available documents into the Mosaic

Documents list.
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The Advanced Transformation Options allow you to resample documents, set strip size

and leave the layers intact or merge them. In this tutorial, leave them as their default

settings.

6. Click OK to begin processing the mosaic.
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The image is mosaicked in the Americas_2.tif document in a Lambert Conformal Conic

projected coordinate system.
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Inspect the Adobe Photoshop Layers panel. Notice that the other documents are now

mosaicked in the Americas_2.tif document. The layers are kept intact because you

specified it to be with the Keep source data on separate layers option. You can

individually make layers visible or invisible or lock them. This makes for image editing

more flexible. To flatten the entire image, choose Layer > Flatten Image.
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9 Tiling Images

The Tile feature creates multiple images from a single image. Tile an image using one of

two available methods: by number of tiles or by size of tiles. If the original image is

georeferenced, the multiple image files will be accompanied by a reference file (or an

internally referenced format such as GeoTIFF, BigTIFF or TIFF). Tiles can be named

sequentially, by row and column numbers, or based on corner coordinates.

One image tiled into 9 equal image tiles.

9.1 Using Tile

Requirements

Any image, whether it is a spatial image or not, can be tiled using the Tile function. It

is recommended that all images be flattened before tiling. If a multi-layered image is

tiled without flattening first, it will result in each tile containing all of the layers from

the original image. In some cases this may result in blank layers in one or more of the

resultant tiles if all layers do not contain image content that covers all image pixels.

 Any non-georeferenced images can be tiled; however, the output files

will contain no georeferencing.

Tile Dialog Box

With an open image, click the Tile button in the Geographic Imager panel to open the

Tile dialog box.
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Tiling Schema

The Tile dialog box displays two options for creating tiled images: By Number of Tiles

or By Size of Tiles.

By Number of Tiles

This option creates a series of equally-sized georeferenced image tiles from the

original image. Specify the number of horizontal and vertical tiles. The total number

of tiles are displayed in the Destination frame. Using this option creates tiles that

are divided evenly into the extent of the image. Notice the horizontal and vertical

dimensions of each tile is shown in the read-only (blue shaded) boxes.

By Size of Tiles

There are two options for creating tiles by a specific size: by number of pixels or

by ground units of the coordinate system of the current image. For instance, if an

image is in a coordinate system using meters, then the ground units option would

be meters. Specify the horizontal and vertical tile dimensions. The total number of
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tiles are displayed in the Destination frame. Creating tiles by size may create

smaller edge tiles that vary in size.

Overlap

Specify the amount of overlap that each tile has with its adjoining tiles. The

amount of overlap for each tile can be set to either the number of pixels, ground

units, or by a percentage (of the tile). The amount of overlap may be the same for

both horizontal and vertical directions or different in each direction. This option is

especially useful to guarantee gap-free mosaicking of individually transformed tiles.

Destination

Total Files

Displays the total number of tiled image files that will be created for the current

tiling operation. This value is updated as the number or size of each tile changes.

Check the Keep images open check box to keep the tiled images open after the tile

process is completed. It is unchecked by default.

Keep Images Open

 By default, this option is unchecked. Check this option to let tiles remain open,

however, having many tiles open may cause Adobe Photoshop performance issues.

Naming

There are four naming conventions for tiled image files: Sequential Numbering,

Separate Row/Column Numbers, Top - Left Corner Pixel Coordinates, and

Top - Left Corner Ground Coordinates. To specify a file name and folder location

to save the tiles, click OK in the Tile dialog box after all settings have been made.

The Sequential Numbering option begins numbering at the first tile in the top-left

corner of the image and continues left to right, numbering each tile starting with

the number 1 (e.g. tile-image_1.tif, tile-image_2.tif, etc). Both reference files and

TIFF files are suffixed with the sequential tile number.
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The Separate Row/Column Numbers option suffixes both row and column

number of the position of each tile, beginning at the top-left corner and moving left

to right. The row is the first number and the column is the second number. Both

rows and columns start numbering at 1 (e.g. tile-image_1_1.tif, tile-image_1_2.tif,

tile-image_2_1.tif, tile-image_2_2.tif, etc).

The Top - Left Corner Pixel Coordinates option suffixes the top-left pixel

coordinate of each tile to the file name. In the four-tile example below, the pixel

coordinates are shown for each file. The number of decimal places in the file name

can be adjusted in the Precision box.

The Top - Left Ground Pixel Coordinates option suffixes the top-left ground

coordinate of each tile to the file name. In the four-tile example below, the ground

coordinates (in meters) are shown for each file.



Geographic Imager 5.0 Help222

© 2015 Avenza Systems Inc.

Reference File Format

The Reference File Format drop-down list contains all the georeferenced files that

can be written. Use any external reference file format to save with any Adobe

Photoshop format: World files, Blue Marble Reference, MapInfo TAB and ERS. Other

supported internal referenced formats are ArcInfo ASCII Grid, BIL, ECW, Geospatial

PDF, GeoTIFF/BigTIFF/TIFF, NITF, ERDAS IMAGINE Raster, USGS DEM, and MrSID.

Important Notes

 When tiling an image whose resolution is greater than 72 dpi, ECW and

NITF output files will result in 72 dpi. ECW and NITF formats do not support

change in storing and restoring resolution values.

 When creating greater than 200 tiles, the Keep images open option will

be disabled.

9.2 Tile Tutorial

In this tutorial, you'll create tiles from a single image.

1. In Adobe Photoshop, open Americas_mosaic.tif from the \Tutorial Data\Americas

folder. 

2.On the Geographic Imager panel, click the Tile button. 

3. In the Tile dialog box, choose the By Number of Tiles option, and enter 3 into both

the Horizontal and Vertical text boxes. 
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In the Destination frame, the total number of files that will be created is listed as 9.

4. In the Overlap frame, enter 5 into both Horizontal and Vertical text boxes. Ensure

Pixels is chosen in the Units drop-down list. 

This creates an overlap of 5 pixels for each adjacent image.

5. Choose Separate Row/Column Numbers from the Naming drop-down list.

Each image will contain the name of the original image plus a reference to the row and

column to which it represents.

6. Choose GeoTIFF/BigTIFF/TIFF from the Reference File Format drop-down list.
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7.Click OK. 

8. Create a new Tiles directory to save the tile images in. In this case, use the default

file name (Americas_mosaic_1_1.tif) and click Save.

9.When the TIFF Options dialog box appears, click OK to accept the default settings.
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Any TIFF options are applied to all subsequent files (in this case, nine files). These

options are good to use if you need to optimize or compress your TIFF images.

10.When the tile process is completed, navigate to the destination directory and view

the tile images.
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The naming separate row/column numbers format is appended to the file name: the tile

America_mosaic_1_1.tif belongs in the first row and first column;

America_mosaic_1_2.tif in the first row and second column; and

America_mosaic_1_3.tif in the first row and third column, and so on.
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10 GeoCropping Images

Use GeoCrop to crop georeferenced images based on defined crop areas. There are

several ways to specify a crop area: 

manually

by pixel

by geodetic or projected coordinates

by using another document

by using a coordinate system envelope

by proximity

by extents of a vector file. 

When crop parameters are specified, the preview image in the GeoCrop Dialog box will

update to show the preview crop area. Cropped spatial images retain georeferencing.

The Advanced Import uses the features of GeoCrop to import large images without

having to open them first. An image cropped with layers (e.g. mosaic image) will

maintain its layers structure and alpha channels.

GeoCrop can be based on pixels or geodetic or project coordinates.
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10.1 Using GeoCrop

Requirements

Any image can be cropped using GeoCrop. However, only georeferenced images will

enable certain options in the GeoCrop dialog box. Images without georeferencing can

only be cropped manually or by specifying pixel values.

To use the Crop to Coordinate System Envelope option, the current image must be

georeferenced.

To use the Crop to Another Document option, at least one other georeferenced

document must be opened.

GeoCrop Dialog Box

With an opened image, click the GeoCrop button in the Geographic Imager panel to

open the GeoCrop dialog box.
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To GeoCrop an image, use one of the following crop options:

Manual Crop

Manual GeoCrop is the quickest and simplest method to crop an image. In the preview

image, click and drag to draw a crop area—a dashed red border defines the crop

extent. The area outside of the crop area is shaded in gray. Use the cursor

coordinates below the preview image to more accurately crop an image. The crop

area can be only as large as the extent of the image and only one crop area can be

defined at a time.

 You can also use the Adobe Photoshop Crop Tool which is fully

supported and maintains georeferencing.

Crop By Pixel or Coordinate
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Specify Pixel, Ground Unit, Geodetic or Projected in the Unit Type drop-down list to

define a precise area. If an image is unreferenced, only Pixel can be specified for

cropping unit (the Unit type drop-down list is disabled). When Pixel unit type is

chosen, the crop area is measured in actual pixel values from the image. In the case

that a reference file exists but no coordinate system is specified, Ground Unit can be

chosen from the Unit Type drop-down list. GeoCrop coordinates are dimensionless but

correspond to the same unit as the reference file (e.g. meters, feet, decimal degrees,

etc). Specify both the top-left and bottom-right corner X and Y values in the

coordinate entry boxes to define the crop area.

The Geodetic Unit type can be chosen from the Unit type drop-down list when an

image is specified to a geodetic or projected coordinate system. Pixel and Geodetic

are the only unit type options when the coordinate system is geodetic. In the

Coordinate Format drop-down list, choose from two options: Decimal Degrees or

Delimited Degrees Minutes Seconds (DMS). In the Lat/Long boxes below the drop-

down list, specify both the top-left and bottom-right corner Lat/Long values (in either

decimal degrees or DMS) in the coordinate entry boxes to define the crop area. The

preview image reflects the values entered to draw the crop area.

The Projected unit type can be chosen from the Unit Type drop-down list when an

image is in a projected coordinate system. The units specified will be the same as the

current coordinate system of the selected image (meters, feet, etc). Also note that

the Pixel and Geodetic unit types can be chosen from the Unit Type drop-down list

when an image is in a projected coordinate system. Switching unit types when a crop

area has already been defined will automatically convert the values to the new

selected unit in the coordinate entry boxes.

Crop to Another Document

This feature uses the spatial extent of another open document to define the crop

area in the current document. In the Crop to Another Document dialog box, choose an
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open document from the Same As drop-down list. The preview image updates and

draws the crop area using the extents of the document specified. It is important to

use a document that falls within the extents of the current document. If only a

portion of it falls within the image extents, it will still be cropped. If an open document

is outside of the current document’s extents, it will fail to crop and a warning will

appear.

 Other documents don’t have to be in the same coordinate system as the

image being cropped.

Crop to Coordinate System Envelope

This feature uses the envelope of a coordinate system to define the crop area in the

current document. Click the Crop to Coordinate System Envelope button to

choose a coordinate system. The preview image updates and draws the crop area

using the extents of the coordinate system envelope specified. It is important to use

a coordinate system envelope that falls within the extents of the current document.

If only a portion of the envelope falls within the extents, it will still be cropped. If a

coordinate system envelope is outside of the current document’s extents, it will fail to

crop and a warning will appear.

 To maintain a high-precision transformation, choose an appropriate

coordinate system envelope. There may be instances where by choosing a

coordinate system envelope that no datum shift exists. This may cause

imprecise results. A warning appears if this should ever happen.

Crop by Proximity

Use this feature to crop an image based on proximity from a specific base point. Begin

by setting the unit type (pixel, ground unit, geodetic or projected) and if necessary,

the coordinate format (only for geodetic coordinate systems). Choosing a unit type

changes both base point and proximity units.

In the Base Point frame, specify the X and Y values (or Lat/Long if geodetic) of the

point of which the proximity will be based on. In the Use As drop-down list, choose a

position for the base point. This position defines where the crop area is created

relative to the base point. The diagram below explains base point positioning.
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In the Proximity frame, specify x and y values (in the same units as the base point) of

which the crop area dimensions will be drawn to. If needed, check the Use same value

for both dimensions check box to create a square proximity. If the unit type is

Projected, it is possible to change the proximity units. Click the Change Units button

and choose a new measurement unit. Accept the settings and the preview image

updates and draws the crop area using the base point and proximity specified.

Crop by Vector File Extents

Use this feature to crop an image based on the geographic extents of a vector file.

Click the Crop by Vector File Extents button to select a vector dataset. Choose

from a variety of vector formats including shapefiles, KML/KMZ, GPX, and DWG. Note

that this does not crop to the boundary defined by the vector, only a rectangular

shape defined by its geographic extents.

 Esri formats such as geodatabases (GDB, MDB, MXD) and text formats

(TXT, CSV, XLS) are not supported.

GeoCrop Options

Pixel Round Options

When using a unit type other than Pixel, the coordinate values will not correspond

exactly to a round pixel value, hence creating partial pixels. Partial pixels are

created when a geodetic or projected coordinate falls between a range of pixels.
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Users may choose to keep these partial pixels, however they may make the image

unreadable other software packages.

Decide how the output image pixels are handled with one of these options:

Round to closest Partial pixel values rounded to

the closest pixel

Always use Keeps partial pixels and uses it in

the output image

Discard Drops partial pixels from the final

output image

10.2 GeoCrop Tutorial

The GeoCrop function crops georeferenced images based on defined crop areas.

1. In Adobe Photoshop, open Americas_1.tif from the \Tutorial Data\Americas folder.

2.On the Geographic Imager panel, click the GeoCrop button.

3. Choose Geodetic from the Unit Type drop-down list and choose Decimal degrees

from the Coordinate Format drop-down list.

4. In the Top-left Corner frame, enter -122.50 in the Long box and 62.50 in the Lat

box.

5. In the Bottom-right Corner frame, enter -91.50 in the Long box and 39.50 in the

Lat box.
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The top-left and bottom-right corner coordinates form a crop area designated by the

red dashed marquee. This functions similarly to the Adobe Photoshop Crop Tool except

it uses precise geographic coordinates to determine the crop extents.

6. To manually resize crop area, click a corner or edge of the marquee and drag to

resize it.
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The corner coordinate values are updated. This can be used as a quick way to crop an

image to an area of interest.

7. Click OK to complete the GeoCrop.

The image is cropped to the area specified in the GeoCrop dialog box. It's also possible
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to use the Adobe Photoshop Crop Tool to crop images. Geographic Imager will respect

crops made by the Crop Tool and maintain proper spatial referencing. The Crop Tool is

useful for situations where you prefer an spatial image to be a particular size because

it has settings for dimension and resolution (W x H x Resolution).
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11 Terrain Shading DEMs

Shaded relief is a method for representing topography on physical and digital maps in a

natural and intuitive way. 

The Terrain Shader provides options to apply colorization schema and shaded relief to

supported elevation data formats (e.g. DEM, SRTM, etc.). There are two ways to

apply a colorization schema: using a color map or an overlay image. There are also two

methods to apply a color map: stretch a gradient along the image’s DEM schema or

use a preset color map. When color map, overlay image or shaded relief settings are

applied, the preview image will update to show how the settings affect it.

Animation that shows the an image with and without Terrain
Shader applied.

11.1 Using Terrain Shader

Requirements

Any image (except 32-bit images) can be manipulated with Terrain Shader. However,

only images with elevation data can have its elevation values mapped to a color ramp

or gradient. Images that do not have elevation data has its values stretched to a

percentage of the color gradient. Terrain Shader is not available for images in Duotone

or Bitmap color modes.
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Apply Color Map and Shaded Relief Only to Selection

It is possible to apply Terrain Shader only to a selection on the image. Before

opening the Terrain Shader dialog box, use any of the Adobe Photoshop selection

tools (Marquee tool, Lasso tool, Magic Wand tool or Quick Selection tool) to create

a selection (or multiple selections of the same layer). Open the Terrain Shader

dialog box and make sure the Apply to selection only check box is checked. If

the option was unchecked, checking it will display a warning message that

indicates only color maps and shaded relief will be applied to the selected area

even though the preview doesn't show it.

Terrain Shader Dialog Box

With an opened image, click the Terrain Shader button in the Geographic Imager

panel to open the Terrain Shader dialog box.
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Colorization Schema

Click the Colorization Schema check box to enable its two main options: 1) Apply

Color Map and 2) Apply Overlay Document.

Apply Color Map

There are two available methods to apply a color map: Stretch gradient along image's

DEM schema and use a preset color map. Choose Stretch gradient along image’s

DEM schema to extend the color gradient to the minimum and maximum values of the

DEM schema. Choose a color gradient in the drop-down list to map it to the DEM

schema. The Color Gradient to Elevation map to the left of the Preview Image updates

to show how the color schema is stretched.

Choose Use preset color map to use only the colors specified in the gradient that

fall within the range of the DEM schema. This does not stretch the color gradient to

the minimum and maximum values of the schema. Choose a color gradient in the drop-
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down list to map it to the DEM schema. The Color Gradient to Elevation map to the

left of the Preview Image updates to show how the color schema is stretched.

Precision

Terrain Shader has a precision setting that affects how colors are mapped to a

DEM. The precision value is listed in the drop-down list (e.g. 0.3 m). A Regular

precision setting quickly creates an Adobe Photoshop adjustment layer and a

shaded relief layer at the cost of slightly lower precision. A Higher precision setting

creates a colorized raster layer and a shaded relief layer, however, this process

uses more memory and takes longer to calculate.

 The DEM precision (displayed in the Import DEM File dialog box) is

different that the precision used in the Terrain Shader dialog box.

Use Continuous

The Use Continuous Color option smooths the color gradient between color

stops. Uncheck the Use Continuous Color check box to use discrete color breaks.

Create Single Layer

The Create Single Layer option is enabled by default when the Higher Precision

setting is chosen. When checked, it creates a single colorization layer when

multiple DEM layers are present. When unchecked, each DEM layer will have its

own colorization layer.

Edit Selected Color Map

Click the Edit Selected Color Map button to edit how the color gradient stops and

elevations are positioned. At the top of the Edit Color Map dialog box, the current

gradient and color stops in it are displayed.
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Edit a Color Stop

The color map table shows how each color stop is mapped to a corresponding

elevation value. To adjust the position of the color stop, click and slide it left or

right. When a color stop is adjusted, the respective Elevation and Position values in

the color map table are updated. Similarly, changes made directly to the color map

table are reflected in the gradient color stop. The changes can be viewed in real

time when the Update preview image in the Terrain Shader dialog option is

checked.

To edit the color of a color stop, double-click either the color stop itself or the

color square in the corresponding row in the color map table. A selected color stop

is highlighted in the table and is designated by a black triangle in the gradient. In

the Select Color for Color Stop dialog box, use the options available to choose a

basic or custom color.
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Use Continuous Color

The Use Continuous Color option smooths the color gradient between color

stops. Uncheck the Use Continuous Color check box to use discrete color breaks.

Adjust Low and High Elevation values

Specify new values in the Low and High Elevation boxes. Changing these values will

alter the relative position (in percentage) for all color stops that are mapped to the

elevation. When a specified color stop is not within the elevation range, the text is

grayed out in the table (but can still be edited) and the color stop itself is not

shown in the gradient (negative position value). If needed, edit the Elevation value

to set it within range or set a positive Position value.

Stretch Elevation Range

Click the Stretch Elevation Range button to specify new elevation range values.

This is applied to all color stops and stretches them to the new specified range.

The color stops maintain their relative position in the color map. However, when a

specified color stop exceeds a position value greater than 100%, the text is grayed

out in the table (but can still be edited) and the color stop itself is not shown in
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the gradient. If needed, edit the Position value so that it is less than 100%.

Add a Color Stop

Click the Add Color Stop button to add a color stop to the gradient. In the Select

Color for Color Stop dialog box, use the options available to choose a basic or

custom color. After a color stop is added, adjust its position by sliding it left or

right in the gradient bar.

Delete a Color Stop

Click a color stop (in the gradient or color map table) to select it and click the 

Delete Color Stop button.

Clear Color Stops

Click the Clear Color Stops button to remove all color stops. A confirmation

warning appears to confirm your decision.

Reset Color Stops

Click the Reset Color Stops button to reset all color stops to how they were when

the Edit Color Map dialog box was first opened. This is particularly useful in

situations where you may want to return to the original settings without closing

the dialog box. A confirmation warning appears to confirm your decision.

Save Color Map

Click the Save button to save the color map. There are two options to save the

color map: update the base color map or save as a new color map. Specify a color

map name if saving as a new color map. The new color map will appear in the Color

Map drop-down list. When updating a base color map without saving it as a new

color map, it will appear as (1) Custom: [color map name].
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Delete Color Map 

Choose a color map from the Color Map drop-down list and click the Delete Color

Map button to remove it.

Import Color Map from File

Adobe Photoshop gradient and color map files can be imported as GRD and XML files.

Click the Import Color Map From File button to open the dialog box and navigate to

gradient or color map files to import. The details of the color map are opened before

import. Choose a gradient from Color Map drop-down when multiple gradients and

color map files are being imported at the same time. Hover over the color stops to see

its position and color space values. The color stops can't be adjusted, however, the

gradient name can be edited. Click the Import button to only import the current

gradient or color map. Click the Import All button to import multiple files at once.

Export Color Map to File

Adobe Photoshop gradient and color map files can be exported as GRD and XML files.

An Adobe Photoshop GRD file will have its gradient automatically stretched to the

image’s DEM schema, however, will not contain elevation values for color stops.

Instead, the XML exported from Geographic Imager will contain all the information of

the color stops elevation and color settings. Click the Export Color Map to File

button and choose one of the following: 

To XML File Exports the selection in the Color Map drop-down list
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to an XML file

All to XML File Exports the entire Color Map drop-down list to an

XML file

To Photoshop

Gradient

Adds the selection to the Color Map drop-down list

A sample that shows the structure of the XML file:

Apply Overlay Image

The Apply Overlay Image option overlays another open document above the

current elevation data. The overlay must be in the same coordinate system and pixel

size as the image Terrain Shader is being applied to. The overlay image is added as a

layer above the DEM in the Layers panel.
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Apply Shaded Relief

Ensure the Apply Shaded Relief check box is checked (unchecked by default).

Shaded relief can be applied whether Colorization Schema is enabled or disabled. The

preview image is immediately updated to reflect the Angle and Intensity settings.

The Angle setting represents the lighting angle at which the elevation is rendered.

Edit the value (degrees) in the Angle box or rotate the jog dial to the right of it.

Shaded relief is commonly used with an overlay document (see the main topic

example). The lighting is global and affects the entire image. The default Angle setting

is 45 degrees, a commonly used lighting angle.

The Intensity setting represents how soft are hard the lighting effect is. Edit the

value in the Intensity box or use the slider. A lower intensity value creates a softer

looking shaded relief (below left) while a higher intensity value creates a sharper

looking shaded relief with more shadows and contrast (below right). The default
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Intensity value is 2; with a minimum of 0 and a maximum of 100.

Shaded relief not applied.
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Shaded relief applied.

Results

After successfully applying a color map, the Adobe Photoshop color mode will change

to RGB (and will maintain the respective 8 or 16 Bits/Channel). Depending on the

precision setting chosen, an adjustment layer or full raster layer will be created along

with a separate layer for the shaded relief in the Adobe Photoshop Layers panel. They

can be hidden to reveal only the color map, the shaded relief or the elevation layer.
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Layers when regular precision is used.  Layers when higher precision is used.

Layers after an overlay image is used.

Important Notes

Color mode compatibility

Terrain Shader is not supported with the following Adobe Photoshop color modes:

Bitmap

Duotone

Indexed Color
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Multichannel

Applying color to images that do not contain elevation data

Color maps will only work correctly if the image was converted from a DEM by

Geographic Imager (or using a similar software). If an image is generated from a

DEM by some method that is unknown to Geographic Imager, there is no guarantee

that color maps will work correctly. For example, an image that may use white

(which is often the highest value) to represent low value areas, Geographic Imager

and Adobe Photoshop will incorrectly apply color corresponding to the highest value

to such areas. To prevent this from happening, use images converted by

Geographic Imager.

Color map and DEM schema folder locations

Default color maps are stored in ColorMappings.xml in the following folder:

Windows: C:\Program Files\Avenza\Geographic Imager\Color Mappings

Mac: /Avenza/Geographic Imager/Georaphic Imager Plug-in/Color Mappings

     

Custom color maps are stored in CustomColorMappings.xml in the following folder:

Windows: C:\ProgramData\Avenza\Geographic Imager

Mac: /Avenza/Geographic Imager/Geographic Imager Plug-in

Custom DEM schemas are stored in CustomDEMSchema.xml in the following folder:

Windows: C:\ProgramData\Avenza\Geographic Imager

Mac: /Avenza/Geographic Imager/Geographic Imager Plug-in

Related topics

Opening DEMs

11.2 Terrain Shader Tutorial

Import DEM File

Geographic Imager will detect when elevation data is being opened in Adobe

Photoshop. The Import DEM File dialog box will automatically open where you can

specify a DEM schema and other settings.

1. In Adobe Photoshop, browse to the Tutorial Data folder and open Namu

Water.dem from the \Tutorial Data\Americas folder.
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2. In the Import DEM file dialog box, click the Create New Schema button.

This opens the Edit DEM Schema dialog box. The Schema Name is already populated

with the name of the file. It also populates the Lowest and Highest Elevation values

according to the DEM’s data range.

3. Since these values are acceptable, they do not need to be modified. Click OK.
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4. The Select Schema now reflects the data range of the DEM.

5. In the Import DEM file dialog box, click the Advanced button.

The value -32767.00 in the Display as transparent pixels list is a predefined value that

represents no data. This value can't be deleted and is common to all DEM files. To

display elevations as transparent pixels, populate this list with elevation values.

6. Click the Add new value button. Double-click <new value> and enter a value of 0. 
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7.Click OK to close the Advanced DEM Schema Settings and click OK to accept the

settings of the Import DEM file dialog box to finish the import.
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The chosen custom DEM schema maps the range of elevation to the Adobe Photoshop

grayscale color-space, displaying the highest contrast possible. A transparent area is

visible where all elevations with a value of 0 that was specified in Advanced DEM

Schema Settings.

The elevation value of 0 is considered water for this DEM. Since the area that

represents water is now transparent, it is now very easy to create a background layer

and apply a different color to it (remember that the color-space is grayscale). In the

next exercise, you will apply a gradient map to the elevation data layer using the

Terrain Shader and also create a background.

8. Keep this document open for the next Terrain Shader tutorial.

Terrain Shader

Terrain Shader is used to style images with elevation data. You can quickly create a

gradient map adjustment layer using predefined or custom color maps.

1. Continue working with Namu Water.dem from the previous Import from DEM

tutorial.

2.On the Geographic Imager panel, click the Terrain Shader button.

3. Click the Colorization Schema check box to enable its frame options. The Apply

Color Map option is chosen and automatically applies the first color map (or the last

color ramp used) in the list. If it’s different than what you see in your dialog box,

choose the World color map.
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The Create Single Layer option is checked by default which creates one gradient map

adjustment layer. Unchecking this option will create a gradient map adjustment layer

for each layer. The Use Continuous Color option is also checked by default. It ensures

the color ramp has smooth transitions between colors instead of discrete colors.

4. Click the Import Color Map From File button in the Colorization Schema frame

(third button to the right of the color map).Choose the file Colour Ramp

Examples.grd from the Tutorial Data folder.

5. Choose Elevation 3 from the Color Map drop-down list and click Import.
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6.Choose Elevation 3 from the Color Ramp drop-down list and then click the Edit

Selected Color Map button.

The Edit Color Map dialog box shows how the elevation is mapped to the color ramp.

Hover over the color ramp to see how the elevation values correspond to the chosen

color ramp.
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7.Right-click the color swatch of the table entry for Color Stop 1 (at the top of the

list) and click Edit Color Stop. Alternatively, click the color chip slider on the color

ramp.

8. In the Select Color for Color Stop dialog box.  Enter new color values of Red: 204,

Green: 198, Blue; 181. 

9. Click OK to close the color dialog box. Click OK again to close the Edit Color Map

dialog box.
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10. Click the Apply Shaded Relief check box. Change the angle to 40 and adjust the

Intensity to 35.

11. Click OK.
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Your customized color ramp is applied to the DEM. In the Layers panel, notice that

the original DEM (and background) is maintained. The shaded relief and color map

layer are at the top of the layers list.

To add a background, simply create a new layer and position it at the bottom of the

Layers list.

12. Create a new layer and rename it to Background. Use the Adobe Photoshop Paint

Bucket Tool and fill the layer with a blue color (R: 100, G: 130, B: 175).
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12 Exporting Spatial Images

Save Image Files with Georeferencing

When saving images that are considered Geographic Imager added formats, it will

save reference information internally. Formats that contain internal reference, include:

GeoTIFF, BigTIFF, DEM TIFF, Geospatial PDF, ERDAS IMAGINE Raster, ECW, MrSID,

and NITF. When working with any of these formats, use the Adobe Photoshop Save

command to save the image and to update the reference file.

 GeoTIFF is simply represented in the Adobe Photoshop Save As dialog

box as TIFF (*.TIF, *.TIFF) and geospatial PDF is represented as Photoshop

PDF (*.PDF, *.PDP). Depending on the originating image format, certain

format types may not be available during save.

When saving images to any Adobe Photoshop format, an external reference file will

automatically be created. For example, when saving a georeferenced image to a non-

geospatial format (e.g. JPEG), Geographic Imager creates an external reference file

(e.g. World File). To save to any of the supported image formats, use the Adobe

Photoshop Save As command and choose the appropriate format in the Format drop-

down list. 

During a Save As process, each supported format may have its own native Adobe

options dialog box. For example, when saving as a GeoTIFF, the TIFF Options dialog

box will appear. When saving as Photoshop PDF, the Save Adobe PDF dialog box will

appear. The following Geographic Imager format option dialog boxes will appear for

BigTIFF/DEM TIFF, ECW, DEM, USGS DEM, ASCII GRID, and MrSID formats. Geographic

Imager added formats may also have its own options dialog box.

Example: Options dialog box when exporting to ArcInfo ASCII Grid.

When saving a non-spatial image format (e.g. JPEG or PNG), an external reference file
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is created in the same name. For example, an image with the file name

VancouverCity.jpg will have an external reference file called VancouverCity.tfw (World

reference format). Geographic Imager automatically updates associated reference files

based on the latest transformation settings when saved. Change the default external

reference format in Geographic Imager Preferences.

 Caution: When saving an image after a Geographic Imager function is

performed, Geographic Imager automatically updates the reference file. In

this process, the original reference file is overwritten. In order to avoid

damaging the original image and reference files, use the Save As command

with a new file name or file location rather than using the basic Save

command.

 When saving to BigTIFF format, an image that has more than four color

bands cannot be saved using the JPEG image compression option. For

BigTIFF images in RGB or Grayscale color mode, using the JPEG image

compression option only supports 8 bit RGB, RGBK or grayscale with less

than four bands. Caution should be used when saving to BigTIFF using a

script because it is possible to use the JPEG image compression option

(doing so will produce incorrect results).

When saving to BigTIFF format with JPG compression enabled, the file size

may be differ significantly when compared to saving to the TIFF format with

JPG compression enabled. The image quality is on par between both

formats.

 When saving a DEM format with the Alpha Channel check box checked,

the result will be that no alpha channels is saved. Digital elevation model

formats like DEM, BIL and ASC don't support alpha channels.

 Saving a USGS DEM format with the floating precision option creates files

that may not be fully supported by some legacy DEM applications (values

may be misread as integer).

Export Coordinate System Data

The defined coordinate system can be exported as a WKT Definition File (.wkt) or Esri
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Projection file (.prj) through the Geographic Imager panel options menu. Select Export

Coordinate System from the panel options menu to access the Export dialog box. 

Some reference files that do not store the coordinate system information (e.g. world

file .tfw) will benefit from a WKT Definition File or Esri Projection file. These files stores

all the parameters of the coordinate system that was exported.

Some projections are not supported when saving to a reference file and will not store

the coordinate system. It is highly recommended to export a coordinate system file as

well. See Reference Formats. 

Export a Reference File

The defined coordinate system for a georeferenced image can be exported as a

reference file through the Geographic Imager panel options menu. Go to Export

Reference File from the options menu and choose one of the follow reference file

formats to export to:

Reference file

format

Reference file format

extension

Blue Marble

Reference File

.rsf

ER Mapper .ers

GeoTIFF* .tif

MapInfo TAB

File

.tab

World Files .tfw, .tifw, .wld, .jgw, .pgw, 

.sdw, .eww, .blw, .dmw, .bp

w

* The GeoTIFF option is only available when the current document is TIFF.

Exporting a reference file to GeoTIFF is another way to convert a non-

spatial TIFF to GeoTIFF.

Export functionality may also be used to change the referencing file format of an

image. The georeferencing information should be first exported into the desired

reference file format, then click the Reference File link in the Geographic Imager panel
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to specify it as the new reference.

 If referencing of an image was changed after export, only the current

referencing file will be updated; previously exported reference files will not

be deleted or updated. The current reference file will be used and the old

reference file will not. Keep this in mind when reopening images.

Topics covered in this section

Quick Save to Format

Export to Web Tiles

Export to PDF Maps

Upload to PDF Maps Store

12.1 Quick Save to Format

The Quick Save To Format command provides the ability to save a georeferenced

image as another format. It functions similarly to the Adobe Photoshop Save As

command, except that it uses default settings to expediate the save process (no

options dialog box will appear). Go to Geographic Imager panel options menu and

choose Quick Save to Format.

Quick Save to Formats and Default Save Settings

These are the available formats and their default save settings when using Quick

Save to Format:

Format Default save settings
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BigTIFF Image Compression = LZW, Pixel Order = Interleaved

DEM TIFF Image Compression = LZW, Pixel Order = Interleaved

USGS DEM Metadata = unchecked, Precision = Integer

ArcInfo ASCII

Grid

None

BIL None

ECW Reduction = 75

ERDAS IMAGINE

Raster

Block Size = 64, Pixel Type = Default

Geospatial PDF Default Adobe Photoshop Save settings

GeoTIFF Image Compression = LZW, Pixel Order = Interleaved

MrSID Format = MrSID Generation 4, Compression Method: Ratio

(20:1), Block Size = 64, Target Thumbnail Size = 32

NITF No Settings

Quick Save to GeoTIFF Notes

Quick Save to GeoTIFF cannot be used with Adobe Photoshop Multichannel images.

Instead, convert to RGB mode first (it will keep the additional channels), then save.

Quick Save to Geospatial PDF Notes

The Quick Save to Geospatial PDF command exports any open image with a specified

coordinate system to the Adobe Acrobat Geospatial PDF format. There is no external

reference file associated with it because it retains all of the georeference information

within the PDF itself. It is exported using the Adobe Acrobat PDF 1.7 specification

which is fully compatible with Adobe Acrobat 9 and later.

The Adobe Acrobat Analysis Tools allow viewing and marking coordinates, viewing

attributes, measuring distances, perimeters and areas. With Acrobat Pro and Pro

Extended, the measurement tool is always enabled. To enable this tool in Acrobat

Reader 9 (standard), the file must first be opened in Acrobat Pro to enable

annotations on the PDF (menu Comments > Enable for commenting and analysis).
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 32-bit images are not supported when exporting to geospatial PDF.

Quick Save to MrSID Notes

Quick Save to MrSID is only available on Windows. An installation of Lizardtech

GeoExpress is required to output to MrSID format. Refer to Lizardtech support (http://

www.lizardtech.com/support) and documentation for more information about the

MrSID format.

Visit the Avenza website for more information about the MrSID writer and to purchase

data cartridges and Lizardtech GeoExpress licenses (http://www.avenza.com/

geographic-imager/lizardtech-geoexpress).

Quick Save to DEM TIFF Notes

Only 16-bit grayscale modes are supported when saving as DEM TIFF format

DEM raw values are saved

GeoTIFF DEM must be imported using Advanced Import.

Quick Save to USGS DEM Notes

The USGS DEM quick save only supports 16-bit grayscale image mode. 

Saving a rotated USGS DEM is not supported.

12.2 Export to Web Tiles

Use Export Document to Web Tiles to generate image tiles that can be used for online

map purposes. Google Maps, Bing Maps, OpenStreetMap, Tile Map Service, and MapBox

formats are supported.

Requirements

Web Tiles are always shown in a north-up Pseudo-Mercator coordinate. Documents in

other coordinate systems will be temporarily transformed to the Pseudo-Mercator

coordinate system and then exported to web tiles. Geographic Imager will return the

document to its original coordinate system after export.

http://www.lizardtech.com/support
http://www.lizardtech.com/support
http://www.avenza.com/geographic-imager/lizardtech-geoexpress
http://www.avenza.com/geographic-imager/lizardtech-geoexpress
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Export to Web Tiles Dialog Box

Click the Export to Web Tiles button in the Geographic Imager panel to open the

Georeference dialog box.
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Using Export Document to Web Tiles

Map Provider

Map tiles are created based on the map provider and can generate web tiles

compatible with Google Maps, Microsoft Bing Maps, OpenStreetMap, Tile Map

Service, and MapBox.

Google Maps, Bing Maps, and OpenStreetMap map providers each generate web

tiles and an HTML file which consists of a web map with the tiles in place. The

HTML file can be further edited to suit specific needs or to reference exported tiles

at a different location. The MapBox map provider generates an MBTILES file that

can be used with the MapBox service. The Tile Map Service map provider

generates web tiles and an XML file (which must be referenced by a URL).

Name and Folder

Specify a path and a file name to save to. Web tiles and associated files are saved

to the same location. A path is provided by default, click the Browse button to

choose a different path.

Zoom Level tab

Choose a maximum zoom to use for the maximum detail level in the exported tiles.

The Zoom levels box indicates the number of zoom level to use and determines the

minimum zoom. The Maximum zoom drop-down list provides a number of zoom levels

from Level 1 to Level 23 and an associated resolution in measurement units to

pixel. Higher resolution levels will create more web tiles (indicated by the Total tiles

value). A minimum of 1 zoom level is required up to a maximum of 23 zoom levels.

Options tab

Web tiles can be exported to two image formats types: PNG and JPG. Depending on

the image format chosen, each format has specific options availabe in the Options

tab. The Compression option is only available for the PNG format, with a

compression range of 0 to 9 (where 0 is the lowest and 9 the highest). The Quality

option is only available for the JPG format, with a quality range of 1 to 12 (where 1

is the lowest and 12 the highest). Depending on the compression or quality value,

generated web tile file sizes will vary. Use the Opacity slider to choose the

transparency of the web tiles. 0% is completely transparent and 100% is
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completely opaque.

Choose an Image resampling method to resample web tiles. The resampling method

assigns color values to any new pixels based on the color values of existing pixels.

By default, the Adobe Photoshop resampling method will be used. You can change

the default resampling method in Adobe Photoshop preferences.

The following are available image resampling methods:

Image

resampling

method

Description

Automatic Chooses the best interpolation method for the

image.

Preserve details

(enlargement)

A good option for enlarging an image.

Bicubic

Smoother

(enlargement)

A good method for enlarging images and

produce smoother results.

Bicubic Sharper

(reduction)

A good method for reducing the size of an

image with enhanced sharpening.

Bicubic (smooth

gradients)

A slow but more precise method that is good

for smooth gradients.

Nearest

Neighbor (hard

edge)

A fast but less precise method and preserves

hard edges.

Bilinear Adds pixels by average colour values of

surrounding pixels. Medium-quality results.
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 The Image resampling options may differ depending on your Adobe

Photoshop version.

Google Maps tab

These options only apply when the Google Maps map provider is chosen. The

available Google Map controls are added to the web map aid in navigation. Uncheck

options to disable them so that they are not included in the HTML file.

Option Description

Map type selector An option to choose standard Map view or a Satellite

view

Scale bar A scale bar at the lower-left of the map

Zoom A zoom slider widget

Overview map An overview map available at the lower-right  of the map

(collapsed by default)

Pan A pan widget

Street View The Google Street View feature

Advanced

Use the Export reference file option to output an associated georeference file with

each tile in World or Blue Marble Reference format. This option is disabled by default

and does not output any reference files.

 World formats do no support coordinate systems. Choose Blue Marble

Reference if there is a need to include the coordinate system information.
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12.3 Export to PDF Maps

Use Export to PDF Maps to generate map packages that can be directly uploaded to

the PDF Maps Store, an in-app map store for the PDF Maps app on iOS, Android, and

Windows Phone. You can also generate map packages and load them on your own

devices through iTunes File Sharing or the Android file system, Dropbox, or specify a

URL to your own location. When maps are uploaded using the Upload to PDF Maps

feature, it is put into the Prepare for Review state on the PDF Maps Store.

All maps submitted to the PDF Maps Store are reviewed to ensure they are referenced

accurately, perform as expected, and contain appropriate content. As you plan and

create your maps, be sure to keep our review and design guidelines in mind so that

you can get through the map review stage.

Requirements

While any document with a specified coordinate system can be exported as a map

package using Export to PDF Maps, you must have a PDF Maps Store vendor account

to use Upload to PDF Maps. Visit www.pdf-maps.com/vendors for more information on

how to be a PDF Maps Store vendor.

Exporting to PDF Maps app

Getting your maps ready for the PDF Maps app is a two part process depending on

how you send or load the map package.

Scenario

1

1. Use Export to PDF Maps to create map packages.

2. Use Upload to PDF Maps to prepare map packages and upload for

submission review.

The advantage of using Upload to PDF Maps is the ability to easily

populate details of your maps within Adobe Photoshop without

having to go to the PDF Maps vendor site.

Scenario

2

1. Use Export to PDF Maps to create map packages.

2. Go to the PDF Maps Vendor website to upload and prepare map

packages for submission review.

Scenario

3

1.   Use Export to PDF Maps to create map packages.

2. Use iTunes File Sharing or the Android file system, Dropbox, or

http://www.pdf-maps.com
https://www.pdf-maps.com/vendors/
http://www.pdf-maps.com/vendors
https://mapstore.avenza.com/vendor/login/
https://support.apple.com/en-us/HT201301
https://support.google.com/nexus/answer/2840804?hl=en
https://www.dropbox.com
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specify a URL to transfer your map packages to your device.

This scenario doesn't upload map packages to the PDF Maps Store.

It only loads map packages to your mobile device. It is a good way

to quickly test your maps without having to go through the review

process of the PDF Maps Store.

With an open image, go to File menu > Export > Export to PDF Maps. Choose a

folder to export map packages to and specify any of the available options.

Folder Browse to a directory that contains map packages

ready for export.

Convert to indexed color

mode (recommended)

Create map packages in index color mode. These

map packages create a small footprint on mobile

devices. Note that this will not retain the full

spectrum of RGB color space. It is recommended

to have this option enabled.

Image resampling The resampling method assigns color values to any

new pixels based on the color values of existing

pixels. By default, the Adobe Photoshop resampling

method will be used. You can change the default

resampling method in Adobe Photoshop

preferences.

Launch upload dialog after

creating files

This will prompt the Upload to PDF Maps dialog

after export.

Open export directory Open the file browser of the specified folder after
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after processing exporting is complete.

The following are available image resampling methods:

Image resampling

method

Description

Automatic Chooses the best interpolation method for the image.

Preserve details

(enlargement)

A good option for enlarging an image.

Bicubic Smoother

(enlargement)

A good method for enlarging images and produce

smoother results.

Bicubic Sharper

(reduction)

A good method for reducing the size of an image with

enhanced sharpening.

Bicubic (smooth

gradients)

A slow but more precise method that is good for

smooth gradients.

Nearest Neighbor

(hard edge)

A fast but less precise method and preserves hard

edges.

Bilinear Adds pixels by average colour values of surrounding

pixels. Medium-quality results.

 The Image resampling options may differ depending on your Adobe

Photoshop version.

Map Package Contents

A map package contains all of the content required to allow it to work on the PDF

Maps app. When uploading a map package to the PDF Maps Store, the ZIP file must

be accompanied by all four associated files. For example, if you have an exported map

called MtOlympus, the ZIP would be called MtOlympus.zip and its four associated files

would be called MtOlympus_preview.jpg, MtOlympus_95px.jpg, MtOlympus_233px.jpg,

and MtOlympus.csv. These files must have the same name as the ZIP file and should

not be renamed independently. A map package will not get uploaded if any of the

associated files are missing.
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When loading a map onto your device through iTunes File Sharing or the Android file

system, Dropbox, or a URL, only the ZIP file is required.

When viewing a map package folder, it will look like the following:

Map Package

Contents

Description

*.csv A comma separated value file with coordinates that define

spatial extent.

*.zip ZIP file contains a tiles folder containing the images required

to render the map in the PDF Maps app. The ZIP also

contains a thumbnail file and reference file, both of these

are required in the zip package. The zip package structure

should not be altered.

*_95.jpg Small preview image; can be customized and used on

vendor site.

*_233.jpg Large preview image; can be customized and used on

vendor site.

*_preview.jpg Main preview image; can be customized, however the image

size, color mode and name should not be modified. You can

create custom preview images to branding purposes.
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 A map package will not get uploaded if any of the map package files are

missing.

Related Topics

Upload to PDF Maps Store

12.3.1 Upload to PDF Maps Store

Use the Upload to PDF Maps Store feature to directly upload your map package zip file

to the PDF Maps Store vendor site. This makes the process of staging your maps on

the vendor site easier as you can upload multiple map packages at once. Map details

such as title, description, and price can optionally be completed in the Upload to PDF

Maps Store dialog box. You must be a registered vendor on the PDF Maps Store to use

this feature, as you're required to login through the dialog box before uploading.

Upload to PDF Maps Store Dialog Box

Login to upload

Login with your PDF Maps Store vendor account email and password. You must be

logged in before you can upload map packages for submission.

 To become a PDF Maps Store vendor, apply here https://

mapstore.avenza.com/vendor/login.

Loading Maps

Load maps from folder

https://www.pdf-maps.com/vendors/
https://mapstore.avenza.com/vendor/login
https://mapstore.avenza.com/vendor/login
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Click the Load maps from folder button to specify a folder that contains map

packages. All map packages in the specified folder are added to the map table.

Load from CSV

Load maps and map details from a CSV file. This CSV file could be one that was

manually created or one that was exported by the Upload to PDF Maps dialog box.

Export table to CSV

Export the map details to a CSV file so that the table information can be imported

and uploaded at a later time.

Editing Map Details

Populating the map details can be done easily for multiple maps prior to upload. It

is not mandatory to populate the map details prior to upload, however, it will need

to be completed on the PDF Maps Store vendor site before submitting for review.

All available fields that can be edited include:

Title Give the map a concise, but descriptive title.

Description Write a map description that may include details about

general or special map features.

Languages Choose languages that apply to the map.

Publisher Provide your company, agency or vendor name.

Published Date A general time of when the map was published (e.g. 2015

or Jan 2015).

Pricing Choose a pricing tier to sell the map at. Ranges from Free

to Tier 77 - $249.99 USD.

Search Tags Include descriptive keywords (space separated) to help

users find the map when searching.

Primary

Category

Choose a PDF Maps Store map category that pertains to

the map.

Countries Choose countries that the map area includes.
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Batch Edit Selected

You can populate multiple fields that share the same map detail. To edit selected

fields in a column, select multiple fields (Ctrl + click or Shift + click) and click the 

Edit Selected button or right-click and choose Batch edit selected. To batch

edit an entire column, click a column heading to select the column and click the 

Edit Selected button.

Edit All

See all of the editable fields of one map at once to make it easier to edit map

information. Use the navigation controls to go to the previous or next map.

Uploading Maps

When you are ready to upload map packages, click the Upload button (you'll have to

be logged in first). Check the Delete map package after successful upload check

box if you want to delete the files from the source folder after the map packages are
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finished uploading.

When you log into the PDF Maps vendor website, the maps that were uploaded will be

available and set to the Prepare state. When you have completed all the necessary

map details, you can submit the maps for review. Maps are submitted to are reviewed

by the PDF Maps team and when they are approved, are changed to the On Hold,

Ready for Sale state. Your maps can be set to For Sale at any time. Thousands of

users use PDF Maps everyday and the PDF Maps Store is a great way to sell your

maps and generate revenue.

PDF Maps vendor site.

See the PDF Maps Store help section to learn more about map status and other

details.

http://www.avenza.com/pdf-maps/support/store-help
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12.4 Export Tutorials

12.4.1 Export to Web Tiles Tutorial

The Export Web Tiles feature generates image tiles that can be used for online map

purposes. An HTML file is created with the web tiles which consists of a web map with

the tiles in already in place. Use the Web Tile Export Options dialog box to adjust tile

options.

1. In Adobe Photoshop, open boston-east.tif from the Tutorial Data folder.

2.On the Geographic Imager panel, click the Export Web Tiles button.

Before an image can be exported to web tiles, it must be in the WGS 84/Pseudo-

Mercator coordinate system. The Export Web Tiles feature will conveniently and

temporarily transform the image from Massachusetts Mainland Zone to WGS 84/

Pseudo-Mercator so that it is compatible.

3. Click Transform the image and proceed with the export.

4.On the Export Document to Web Tiles dialog box, choose Google Maps from the

Map Provider drop-down list.

5. In the Name box, rename to Boston.

6. For the Folder, click Browse and create a folder called WebTiles in the Tutorial

Data folder.
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7.On the Zoom Level tab, choose a Maximum zoom of Level 17 - 1.19 meters/pixel

and change the number of zoom levels to 17.

A total of 90 web tiles will be created. The Minimum zoom is Level 1 - 78272 meters/

pixel which is basically be a small map scale.

8. Click the Options tab. Choose PNG from the Image format drop-down and change

the Compression to 0.
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The Compression value of 0 will ensure a high image quality. You’ll leave the Google

Maps tab settings as is. (You can experiment on your own how these settings affect

the web map.)

9. Click the Advanced button. Choose a World export reference file, then click OK.

Creating a reference file is not required, but may be useful if the web tiles were to be

used elsewhere.

10. Click OK to begin the export process.

11. After the web tile export completes, navigate to the export folder you specified.
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In the export folder, several new folders were created (Z1 to Z17). These folders hold

the PNG images that make up the web tiles and represent the 17 zoom levels you

specified. Also included in the folders are TFW world reference files associated with

each tile image.

12. Double-click Boston.html to open it in a web browser.
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The Boston.html file contains the web map that includes all the tiles exported from

Geographic Imager.

12.4.2 Export and Upload to PDF Maps Tutorial

The Export to PDF Maps feature generates a map package that can be uploaded

directly to the PDF Maps Store, an in-app map store for the PDF Maps app on iOS,

Android, and Windows Phone. Uploading maps using this feature puts them into the

Prepare for Review state on the PDF Maps Store. To upload maps, you'll need a PDF

Maps Store vendor account.

1. In Adobe Photoshop, open boston-east.tif from the Tutorial Data folder.

2. From the File menu, go to Export > Export to PDF Maps.
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The Export to PDF Maps dialog box appears. You can specify a different export folder

and set options here. With the options all checked, it will convert the image to

indexed color mode, launch the Upload to PDF Maps dialog box after the export is

finished, and open the file browser to the specified export folder.

3. Click OK.

The export folder shows the map package files. When uploading to the PDF Maps

Store, all of the files in the folder are required. When loading on your device, only the

ZIP file is required.
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The Upload to PDF Maps dialog box also appears. To upload maps, you'll need to login

to your PDF Maps Store vendor account.

4.On the Upload to PDF Maps dialog box, click the Login button.

5. Enter your account email and password, then click Login.

6.On the Upload to PDF Maps dialog box, click the Load maps from folder button.

7.On the Load From Folder dialog box, choose the export folder (in this case it was

\Geographic Imager\AvenzaPDF\boston-east), then click OK.

The map package is added to the table in the Upload to PDF Maps dialog box and is

ready to have it's map details completed.
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8.Double-click the Description cell. On the Edit "Description" dialog box, enter a

description into the Description text box, then click OK.

The Description is completed with a short text description of the map.

9.Click the Edit All button.

The Edit Maps dialog box allows you to edit all map details in one convenient location.

If multiple maps are available, you can move to the previous or next one using the

navigation controls.
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10. Complete the other map details, like the following, then click OK.

These map details are the same as the details that can be completed on the PDF

Maps Store vendor site. You have the option of completing it here or on the vendor

site. In any case, map details should be accurate and complete so that users can

search for your map more easily on the PDF Maps Store.

11.Click the Upload button. 
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The icon changes in the Uploaded column to confirm that it was uploaded

successfully.

12. Click the Go to PDF Maps Store link on the Upload to PDF Maps dialog box or go

to https://mapstore.avenza.com/vendor/login/ in a web browser. Login with your

vendor account details to see your uploaded maps.

On the Maps page, you'll see the maps that you uploaded. Maps that were just

uploaded are put in the Prepare state, meaning they are still being prepared for

review. When you have entered all map details, you can submit the map for review.

When your map is in review, its state will change to In Review. The PDF Maps team

reviews maps daily and when a map is approved, it will be put into the On Hold, Ready

https://mapstore.avenza.com/vendor/login/
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for Sale state. At this point, you can set the map to the For Sale state and it will be

available on the PDF Maps Store.
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13 Automating Geographic Imager

Adobe Photoshop actions and scripts are supported in Geographic Imager and can be

automated using Javascript and actions (but currently not with Visual Basic or

Applescript).

Actions and scripts automate repetitive tasks and will greatly assist in time consuming

manual tasks. Scripts have a benefit over actions because conditional logic can be

written into them so that it can make decisions based on the current task. Scripts can

also involve multiple applications. Another benefit is that it can use variable paths

while actions only use an absolute path of the file location. Since scripts are written in

Javascript, they are cross platform compatible and will work with different computers,

whereas actions may not always work with different systems.

Scripts can be viewed and edited in any text editor such as TextEdit and Notepad as

long as the extension remains as jsx. Ideally, scripts should be created and run using

Adobe ExtendScript Toolkit supplied with Adobe Photoshop. This application provides

many debugging tools and assistance with creating scripts. Scripts can also be

created using the ScriptListener plug-in that may be installed with Adobe Photoshop.

Actions are recorded into a log and is used to create a script. Adobe Photoshop CS6 /

CC 2014 does not install the Scripting folder. Please visit to the Adobe Photoshop

Scripting site for more information: http://www.adobe.com/devnet/photoshop/

scripting.html.

Supported / Unsupported Functions

Adobe Photoshop operations used in actions or scripts will maintain georeferencing

information. Note that there are some functions that are not yet supported due to

Adobe Photoshop API limitations.

Supported Functions

ExtendScript Toolkit

Run script using File > Scripts > Browse

Run script by double-clicking script

Run script by drag-and-drop into Adobe Photoshop

http://www.adobe.com/devnet/photoshop/scripting.html
http://www.adobe.com/devnet/photoshop/scripting.html
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Run action using Action Panel

Image Processor

Create Droplet (see Compatibility)

Actions that run a script or another action

File > Automate > Batch, where the Source drop-down list is set as Folder or

Open Files.

File > Automate > Batch, where the Destination drop-down list is set as None or

Save and Close.

Scripts that run another script or action

Actions that run a script or action that run another script or action

Scripts that run a script or action that run another script or action

Unsupported Functions

Adobe Photoshop closed when using automate tools

Insert menu item from Action panel

Script Events Manager

File > Automate > Batch, where the Destination drop-down list is set as Folder.

Specifying new folder names and new file names are unsupported.

File > Automate > Batch, where the Source drop-down list is set as Advanced

Import. The action is not completed because Advanced Import parameters have

to be set manually.

Topics covered in this section

Creating Actions and Scripts

Using Scripts to Automate Geographic Imager Functions
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13.1 Creating Actions and Scripts

Geographic Imager panel buttons, links and option menu cannot be detected using

actions or scripts with the ScriptListener plug-in. 

When recording actions or scripts, use the following from the File > Automate menu:

Geographic Imager: Quick

Rectify

Used when recording an action to quick rectify

an image.

Geographic Imager: Channel

Management

Used when recording an action to change

channel management settings.

Geographic Imager: Export

Coordinate System

Used when recording an action to export the

coordinate system of an image.

Geographic Imager: Export

Reference File

Used when recording an action to export the

reference file of an image.

Geographic Imager: GeoCrop Used when recording an action to perform a

GeoCrop on an image.

Geographic Imager:

Georeference 

Used when recording an action to perform

georeferencing.

Geographic Imager: Mosaic Used when recording an action to mosaic an

image.

Geographic Imager: Quick

Save To Format

Used when recording an action to create a DEM

TIFF, USGS DEM, ECW, ERDAS IMAGINE Raster,

geospatial PDF, GeoTIFF, MrSID, and NITF.

Geographic Imager: Show

Panel

Show/hide the Geographic Imager panel.

Geographic Imager: Specify

Coordinate System

Used when recording an action to specify the

coordinate system of an image.

Geographic Imager: Specify

DEM Schema

Used when recording an action to specify the

DEM schema of an image.

Geographic Imager: Specify

Reference File

Used when recording an action to specify the

reference file of an image.
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Geographic Imager: Terrain

Shader

Used when recording an action to apply color

or hill shading to an image.

Geographic Imager: Tiling Used when recording an action to tile an image.

Geographic Imager:

Transform

Used when recording an action to perform a

coordinate system transformation.

When recording actions or scripts, use the following from the File > Export menu:

Export to PDF Maps Used when recording an action to export map

packages to PDF Maps.

Export to Web Tiles Used when recording an action to export web

tiles.

13.2 Using Scripts to Automate Geographic Imager Functions

There are two primary methods to create scripts for Adobe Photoshop. The first

method requires basic familiarity with the Adobe Photoshop object model and basic

JavaScript programming skills. For structured scripts, use functions conveniently

provided in the GeographicImager.jsxinc file that wrap low-level Adobe Photoshop calls

to Geographic Imager functionality. The second approach to create scripts involves

using the Adobe ScriptListener plug-in that records actions performed by the user

(including those of Geographic Imager) and stores the results as a ready-to-execute

text script-file. While it may allow to quickly create a script that performs the required

sequence of action, the automatically created script is somewhat harder to modify and

maintain, since it contains all the parameters hard-coded (such as paths to files). It is

also harder to read and less structured, as it directly invokes Adobe Photoshop low-

level functions by directly populating so-called Adobe Photoshop descriptors with the

parameters required for each Adobe Photoshop or Geographic Imager command. If you

choose to record your scripts using the Script Listener, you may want to carefully read

GeographicImager.jsxinc to learn about the specific parameters that can be passed to

Geographic Imager commands.

 Refer to Adobe scripting documentation, Adobe forums (http://

forums.adobe.com) and third-party sites that provide helpful information

regarding scripting Adobe Photoshop functionality.

http://forums.adobe.com
http://forums.adobe.com
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Geographic Imager installs a directory named Sample Scripts located at:

Windows 7/8 (32-bit and 64-bit)

C:\Users\Public\Documents\Avenza\Geographic Imager\Help and Tutorial Data

\Tutorial Data\Sample Scripts

Mac

/Applications/Avenza/Geographic Imager/Geographic Imager Plug-in/Help and

Tutorial Data/Tutorial Data/Sample Scripts

The Sample Scripts folder contains:

ScriptExamples.jsx Provides information on all Geographic Imager

scripting functions and samples.

ScriptBatchProcessingEx

ample.jsx

Contains an example script for batch processing.

3D Overlay Script.jsx A script to create a DEM in 3D with an optional

overlay image.

Mt Olympus.jsx Used with Geographic Imager tutorials.

Batch export to PDF

Maps.jsx

Used for exporting multiple files to PDF Maps.

 Two separate folders, StartupRegistrationScripts and IncludeScripts,

contain scripts used to enable actions and scripting for Geographic Imager.

These folders and its contents should not be renamed or deleted or else

Geographic Imager automation will not be supported. If renamed or deleted,

fix it by renaming the folders to their original names or reinstalling

Geographic Imager.

 Scripted Adobe Photoshop actions that trigger Geographic Imager dialog

boxes (e.g. saving a non-compliant document) will always assume a "show-

errors-only" mode.

 Geographic Imager dialog boxes, sub-dialog boxes or warnings that may
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appear during the execution of supported functions should respect

whatever option is passed to them. Only the option that is explicitly

scriptable through script parameters (and also displayed as action

parameters if run from an action) will be recorded. All others will assume

their default selections. This can be changed by checking the "Don’t show

again" option (wherever it applies).

 Due to Adobe Photoshop API limitations, Geographic Imager does not

automatically read georeferencing from a geospatial PDF when it is opened

using a script or action.

 Unicode characters are not supported for DEM schema names when used

in a script.

 The creation of DEM schema cannot be recorded by Adobe ScriptListener

or by using example scripts. Any DEM schema will have to be created prior

to using automation.
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14 Tutorials

This topic provides a set of links to Geographic Imager tutorials throughout the used

to perform a number of common tasks. Find the tutorial that you would like to work

through by clicking the links in the tables below.

To work through the Geographic Imager and Adobe Photoshop tutorials, you need to

access the tutorial data that was installed in:

Windows 7/8: C:\Users\Public\Public Documents\Avenza\Geographic Imager\Help and

Tutorial Data

Mac: /Applications/Avenza/Geographic Imager/Help and Tutorial Data

Most of the Geographic Imager tutorials were written in a generic way so that you

can follow the steps using your own datasets.

Geographic Imager Tutorials

Tutorial Description Link

Open Image and

Transform

This tutorial shows you how to open an

image, specify a coordinate system, and

transform the image to another coordinate

system.

Open Images

and Transform

Tutorial

Advanced

Import

This tutorial shows you how to open

multiple images simultaneously that

includes image resampling and specifying

mosaic settings to mosaic them together.

Advanced

Import Tutorial

Advanced

Import

This tutorial shows you how to open a DEM

image while specifying coordinates to crop

the image and creating a DEM schema

based on the cropped area.

Advanced

Import DEM

Tutorial

Georeference This tutorial shows you how to

georeference an image using a combination

of values entered manually and through the

online map service.

Georeference an

Image Tutorial

Georeference This tutorial shows you how to quick

georeference an image based on two

Quick

Georeference
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points. Tutorial

Georeference This tutorial shows you how to rectify an

image.

Rectify an

Image Tutorial

Mosaic This tutorial shows you how to mosaic

multiple images together, even if they are

of different coordinate systems.

Mosaic Tutorial

Tile This tutorial shows you how to tile an

image to create multiple images with a

separate row/column naming convention

and GeoTIFF reference format.

Tile Tutorial

GeoCrop This tutorial shows you how to crop a

spatial image using exact coordinates as

well as manually defining a crop area.

GeoCrop Tutorial

Terrain Shader This tutorial shows you how to open

elevation data, apply a DEM schema, and

use the Terrain Shader to apply a custom

color ramp and hill shading.

Terrain Shader

Tutorial

Export to PDF

Maps

This tutorial shows you how to create a

map package that can be uploaded to PDF

Maps.

Export and

Upload to PDF

Maps Tutorial

Export to Web

Tiles

This tutorial shows you how to create web

tiles that can be used for online web maps.

Export to Web

Tiles Tutorial

Adobe Photoshop Tutorials

The following tutorial exercises use existing Adobe Photoshop functions to manipulate

spatial imagery to create affects such as shaded relief, colour ramps, 3D elevation

models, false-colour composite and pan sharpened images. In addition, learn how to

record measurements with the Ruler Tool and resample and sharpen images.

These tutorial exercises differ from the previous set of exercises because they mainly

involve the use of Adobe Photoshop tools, functions and filters. Geographic Imager

allows non-native formats such as DEM files, MrSID, ECW and JPEG 2000 to be

imported and used with an Adobe Photoshop environment while streamlining the
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cartographic work flow.

These exercises are only basic examples of what Geographic Imager for Adobe

Photoshop is capable of doing. Combined with creative uses of both sets of tools, a

wide range of image manipulation techniques are achievable.

Tutorial Description Link

3D

Representation

with a Script

This tutorial shows you how to use run a

script to create a 3D representation of a

mountainous area.

3D

Representation

Script Tutorial

Ruler Tool and

Ruler Tab

This tutorial shows you how to use the

Ruler Tool and Measure Tab to measure

spatial images in addition to using the

Geographic Imager panel Ruler tab.

Ruler Tool and

Ruler Tab

Tutorial

Measurement

Scale

This tutorial shows you how to use

Measurement Scale.

Measurement

Scale Tutorial

False-Colour

Composite with

Multiple Images

This tutorial shows you how to create a

false-colour composite using multiple

images.

False-Color

Composite with

Multiple Images

Tutorial

False-Colour

Composite with

Channel

Management

This tutorial shows you how to create a

false-colour composite using Geographic

Imager Channel Management.

False-Color

Composite with

Channel

Management

Pan Sharpen This tutorial shows you how to pan sharpen

an image, including sharpening with

resampling.

Pan Sharpen

Tutorial

14.1 Adobe Photoshop Tutorials

14.1.1 3D Representation with a Script Tutorial

This exercise demonstrates how to use a custom script with Geographic Imager to

open a DEM, overlay it with an image and to create a 3D effect. See Automating

Geographic Imager for more details.
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1. In Adobe Photoshop, click File > Scripts > Browse. Browse to the \Tutorial Data

\Sample Scripts folder, click 3D Overlay Script.jsx, then click Load.

No images are open, so you are prompted to open a DEM. This script also works if a

DEM is already open.

2. Click Yes.

3. Browse to the Mt Olympus 3D Landscape Data folder, select MtOlympus.dem,

then click OK.

The Import DEM File dialog box appears.

4. Choose Auto-stretched from the Select Schema drop-down list and click OK.
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5. This script allows you to choose a image to overlay the DEM. If no image is chosen,

Terrain Shader can be used to create a color map for it. You’ll choose the

accompanying Mt. Olympus GeoTIFF image to overlay.

6. Click Yes.

7. Browse to the Mt Olympus 3D Landscape Data folder, select MtOlympus.tif, then

click OK.
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A 3D operation is performed to the Rocky Mountains DEM and the Rocky Mountains

GeoTIFF is overlaid on top of it. This image is still considered a dynamic object in

Adobe Photoshop and it can be controlled with the 3D panel (Window > 3D) and the

Object Rotate Tool and Camera Rotate Tool in the Tools toolbar.

The 3D panel has options to change lighting settings (such as opacity, light source,

intensity) and render settings (such as 3D options, cross section, quality). The

vertical exaggeration can be adjusted with the Object Rotate Tool and the green axis

adjustment.
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When creating a 3D representation, georeferencing is not maintained.

14.1.2 Ruler Tool and Ruler Tab Tutorial

Measurement tools can be used to record and export measurements with

georeferenced images. This exercise uses the Adobe Photoshop Ruler tool in

combination with the Geographic Imager Ruler tab located in the panel.

1. In Adobe Photoshop, choose File > Open and browse to the Landsat 7 Multispectral

folder and open Band 8 (Panchromatic), 15 meters.tif.
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This is an image of downtown Toronto. The projected coordinate system is NAD 83

UTM Zone 17N in meters. The Geographic Imager panel displays the pixel size. A

precise measurement is dependent on the pixel size. For this example, 1 pixel is equal

to 15 x 15 meters and provides a moderately accurate measurement.

 Non-square pixels prevent the recording of correct measurements when

using measurement tools. This can be rectified by using the Geographic

Imager Transform function and changing the Pixel Options to keep pixels

square.

2.On the Adobe Photoshop Tools panel, click the Ruler Tool button. (If it isn’t visible,

click and hold the Eyedropper Tool button to display the flyout menu, then choose

the Ruler Tool).

3. Click anywhere on the map and drag the Ruler Tool. Click again to complete the

measurement. A measurement line is drawn on the image.
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4.On the Geographic Imager panel, click the Ruler tab. Click the Update button.

The measurement is shown in page (pixels) and cartesian units (meters) for Segment

L1. Next you’ll use the Ruler Tool to measure another segment.

5. Click the Ruler Tool again. Hold the Alt (Windows) or Option (Mac) key and hover

over the end of the first segment. The icon changes to signify that an additional

angled segment can be drawn. Click and draw a measurement that is 90-degrees
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west of the first segment.

6.On the Geographic Imager panel, click the Update button again (in the Ruler tab).

A second segment value is updated in the panel. However, this does not record or

save your measured distance. For the above example, the distance recorded is
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approximately 4,586 meters. Your results may vary depending on how long of a ruler

line you drew. The measurements can be saved to the clipboard.

7. At the bottom-right of the Ruler tab, click the Copy to Clipboard button.

8.On your desktop, create a new text document and paste the measurements into it.

Rename the output file to measurements.txt and save it.

 Remember the resolution of the image will reflect how accurate the

measurements will be. Measurement tools can not be used with non-square

pixels because each side has a different length.

14.1.3 Measurement Scale Tutorial

The Measurement Scale can be used to record and export area measurements with

georeferenced images. This exercise demonstrates how to set a custom scale using

the Adobe Photoshop Measurement Log panel. It is recommended to use measurement

scale only for area measurements.

 Measurement features are only available with Photoshop CS6 Extended,

CC, and CC 2014 and higher.

1. In Adobe Photoshop, choose File > Open and browse to the Landsat 7 Multispectral

folder and open Band 8 (Panchromatic), 15 meters.tif.

Remember that for this image, 1 pixel is equal to 15 x 15 meters.

2. Before measuring, choose Window > Measurement Log to open the Measurement

Log panel. The panel appears either as floating or docked at the bottom of the

screen. In the panel options menu, choose Set Measurement Scale > Custom.

3. In the Measurement Scale dialog box, change the Logical Length to 15 and the

Logical Units as meters. 

The Logical Units box stores what unit the pixel size is in. A custom preset

measurement scale is useful when using images with the same pixel size.
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4.On the Adobe Photoshop Tools panel, click the Polygonal Lasso Tool. (If it isn’t

visible, click and hold the Lasso Tool button to display the flyout menu, then

choose the Polygonal Lasso Tool).

5.Draw a polygon shape anywhere on the image, making sure to complete the

polygon.

6.On the Measurement Log panel, click Record Measurements.

For the above example, the area and perimeter were recorded based on polygons

drawn. Similar to Rule measurements, recorded values can be exported to a text file.

14.1.4 False-Color Composite with Multiple Images Tutorial

Another powerful remote sensing tool in Adobe Photoshop is the ability to create a

false-colour composite image. Multispectral images contain information inside and

outside the visible electromagnetic spectrum. To use this information, the

wavelengths outside the visible spectrum need to be reassigned to the visible

spectrum so that it is visible to the human eye. This tutorial will create a false-colour

composite of downtown Toronto and surrounding suburban areas.

Often multispectral satellite images will consist of several grayscale images, with each

image containing one of the wavelengths or bands of the electromagnetic spectrum.

These images need to be combined into one image. The Adobe Photoshop function
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called Merge Channels merges images to create false-colour or true-colour

composites. You may easily identify distinct features by their unique spectral

signature.

1. In Adobe Photoshop, browse to the Landsat 7 Multispectral folder and open the

following images:

Band 2 (Green), 30 meters.tif

Band 3 (Red), 30 meters.tif

Band 4 (Near Infrared), 30 meters.tif

 When creating false-colour composites, images must be of the same

image resolution and have the same spatial extents. If the images need to

be cropped, it is recommended to use the Geographic Imager GeoCrop

function to assure that the extents of the images remain consistent.

2. From the Windows menu, choose Channels to open the Channels panel. 

3. In any of the active document windows, click Merge Channels in the Channels

panel options menu.

4. In the Merge Channels dialog box, choose RGB Color in the Mode drop-down list and
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ensure there are 3 channels. Click OK.

5. In the Merge RGB Channels dialog box specify the following channels:

Red: Band 4 (Near Infrared), 30 meters.tif

Green: Band 3 (Red), 30 meters.tif

Blue: Band 2 (Green), 30 meters.tif

6.Click OK to complete the merge.

 A reference file called Untitled-x.tfw (the x value may change

depending on if you have other reference files named something similar)

is created in the default reference format specified in the Geographic

Imager Preferences dialog box.
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A false-colour composite image with georeferencing is created. The band combination

chosen makes vegetation appear in shades of red because vegetation reflects a lot of

near infrared light. The brighter the red, the healthier the vegetation. Urban areas

appear blue-grey. The bright red areas at the top of the image belong to the

prestigious Rosedale Golf Club.

More about Landsat 7 band combinations

R,G

,B

Description

3,2

,1

The “nature colour” combination. It provides the most water

penetration.

4,3

,2

Standard “false-colour” combination. Vegetation shows in

red.

7,4

,2

The “nature-like” combination. Sand, soil and minerals show

in multitude of colour. Fires would appear in red. It provides
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clear imagery in desert region.

7,5

,3

The “nature-like” combination. Sand, soil and minerals

appear in variety of colour.

5,4

,1

Good for agricultural studies. Healthy vegetation shows in

bright green colour.

7,5

,4

Provides best atmospheric penetration. Vegetation shows in

blue. Useful for geological study.

7,3

,1

Rocks may appear in variety of colour. Good for the

geological study.

 Some multispectral images may be provided as a single image that

stores extra channels (called alpha channels in Adobe Photoshop). To

create false-colour composites from these images in Adobe Photoshop,

the channels must first be split into single gray scale images (Channels

panel option menu > Split Channels). Then channels can be merged and

reordered as described above.

14.1.5 False-Color Composite with Channel Management

Creating a false-colour composite image with an image that contains an extra band of

information (alpha channel) is best done with Geographic Imager Channel

Management.

1. In Adobe Photoshop, browse to the Landsat 7 Multispectral folder and open All

bands.tif.
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This image has all the Landsat bands (channels) already merged into it. You’ll use

Geographic Imager Channel Management to create a false-colour composite.

2.On the Geographic Imager panel, click the Channel Management button. 



Tutorials 313

© 2015 Avenza Systems Inc.

The current Color Mode is Grayscale Color which explains why the image is displayed

as such.

3.Make sure Live Preview option is enabled (Windows only). Choose RGB Color from

the Color Mode drop-down list.
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The Gray Band is assigned a channel role of Red, Band 2 is assigned Green, and Band

3 is assigned Blue. You’ll change the visibility of the Gray Band and reassign the

channel roles for bands 2, 3, and 4 to create the correct false-colour composite

appearance.

4. Click the Visibility check box for Gray Band to disable it. Click the Visibility check

box for Band 4 to enable it.

The Channel Management also takes into account roles of available alpha channels.
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5.Click the Band 4 Channel Role (it is set as Alpha 1) and choose Red in the drop-

down list. Change the Band 3 Channel Role to Green. The Band 2 Channel Role

should automatically update to Blue.

6. Click OK to confirm the reassignment of channels.

A false-colour composite image using Channel Management is created. These changes

are reflected in the Geographic Imager Channels panel.

14.1.6 Pan Sharpen Tutorial

Another useful tool Adobe Photoshop provides is the ability to intelligently resample

images. Pan sharpening (short for panchromatic sharpening) the use of a single band

to increase the spatial resolution of a multispectral image. A multispectral image

contains a higher spectral resolution of a panchromatic image, while often a

panchromatic image will have a higher spatial resolution than of a multispectral image.

A pan sharpened image represents the best of both worlds which is essentially a

sensor fusion that gives a multispectral image higher spatial resolution.

1. In Adobe Photoshop, browse to the Landsat 7 Multispectral folder and open the

following images:

Band 8 (Panchromatic), 15 meters.tif

Band 1 (Blue-green), 30 meters.tif
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Band 2 (Green), 30 meters.tif

Band 3 (Red), 30 meters.tif

In this tutorial, the panchromatic image will be combined with a multispectral image in

true colour, however, any false-colour composite combination can be used.

2. From the Window menu, choose Channels to open the Channels panel. 

3. In any 30 meter resolution active document window (Band 1, 2 or 3), click Merge

Channels in the Channels panel options menu.

 If Band 8 is chosen, Merge Channels will be disabled.

4. In the Merge Channels dialog box, choose RGB Color from the Mode drop-down list

and click OK.

5. In the Merge RGB Channels dialog box specify the following channels:

Red: Band 3 (Red), 30 meters.tif

Green: Band 2 (Green), 30 meters.tif

Blue: Band 1 (Blue-green), 30 meters.tif

6.Click OK to complete the merge.



Tutorials 317

© 2015 Avenza Systems Inc.

Since the merged image is at 30 meter resolution, it is necessary to resample it to

match the resolution of the panchromatic image (15 meter resolution).

7.With the merged document window active, choose Image > Image Size.

8. Ensure Constrain Proportions and Resample Image check boxes are checked.

Choose Bicubic (best for smooth gradients) as the resampling method.

9. In the Pixel Dimensions frame, select Percent from the units drop-down list.

10. Enter 200 in the width dimension and click OK.
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11. From the Image menu, choose Mode > Lab Color.

12. In the Channels panel options menu, click Split Channels.

The merged image is split into three images: Lightness, a and b.

The split images have a “_Lightness”, “_a”, or ,”_b” added to the end of the

document name. The a and b channels carry green-red and blue-yellow information

respectively. Our process is to substitute the panchromatic image for the Lightness

channel.

The following step involves some trial and error. The intent is to make the image

brightness and contrast match the Lightness channel as much as possible. Ignore

areas of water or vegetation and concentrate on roads and buildings. Often

panchromatic images contain data that extend into the infrared, therefore vegetation

and areas of water appear differently. The higher resolution of the panchromatic

image, the more contrast it will appear to have.

 Ignore vegetation and areas of water because panchromatic images

often contain near infrared data.

13. Make Band 8 (panchromatic), 15 meters.tif active and create a Brightness/

Contrast adjustment layer. Choose Layer > New Adjustments Layer > Brightness/
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Contrast. Click OK to accept the default name and settings.

14. In the Brightness/Contrast settings (Adjustment panel), adjust Brightness to 100

and Contrast to 35.

15. Create a second adjustment layer. Choose Layer > New Adjustments Layer >

Levels. Click OK to accept the default name and settings.

16. In the Levels settings (Adjustment panel), change the midtone input level to 0.9

and the highlight input level to 230.
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17. To properly merge channels, the layers need to be flattened first. Choose Layer >

Flatten Image.

18. In the Channels panel options menu, click Merge Channels. In the Merge Channels

dialog box, select Lab Color in the Mode drop-down list and click OK.

19. In the Merge Lab Channels dialog box specify the following channels:

Lightness: Band 8 (Panchromatic), 15 meters.tif

a: Untitled-1_a

b: Untitled-1_b
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 The Untitled documents were created from splitting the channels in step

14. Untitled documents may not be appended with the number 1, however,

be sure that the final character corresponds to the channel e.g. a =

“Untitled-4_a”.

20. Click OK to complete the merge.

21. Choose Mode > RGB to convert the image back to RGB mode.

22. Leave the document open for the next tutorial.

This exercise is a guide to enhance images for display or printing purposes, this

method involves subjective judgment to pixel colour adjustments and should not be

used for scientific purposes. The colours of the pan-sharpened image will look

different from the original RGB image because panchromatic data (from Landsat 7)

extend into the infrared, most notably vegetation and areas of water.

Resample and Sharpen

Adobe Photoshop sharpen filters can increase the detail of the image. The Sharpen

filter menu has a variety of sharpening tools. These tools also involve some trial and

error to achieve enough sharpening without overdoing it. Two sharpening filters are

explained below.

The Unsharp Mask 

This filter sharpens an image by increasing contrast along the edges of an image. It

locates pixels that differ in value from the surrounding pixels, this option can be

modified by changing the threshold. The radius of the region to which each pixel is

compared is also an option that can be modified.
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Smart Sharpen

This filter has more advanced controls not available in the Unsharp Mask filter. This

filter will allow control over the amount of sharpening that occurs in shadow and

highlight areas. The document should be viewed at 100% to get an accurate view

of the sharpening.

Amount: Sets the amount of sharpening. A higher value increases the contrast

between edge pixels, giving the appearance of greater sharpness.

Radius: Determines the number of pixels surrounding the edge pixels affected by

the sharpening. The greater the radius value, the wider the edge effects and the

more obvious the sharpening.

Remove: Sets the sharpening algorithm used to sharpen the image. Gaussian Blur

is the method used by the Unsharp Mask filter. Lens Blur detects the edges and

detail in an image, and provides finer sharpening of detail and reduced sharpening

halos. Motion Blur attempts to reduce the effects of blur due to camera or

subject movement. Set the Angle control if you choose Motion Blur.

Angle: Sets the direction of motion for the Motion Blur option of the Remove

control.

More Accurate: Processes the file more slowly for a more accurate removal of

blurring.

In the Smart Sharpen dialog box, click the Advanced option to display the Shadow

and Highlight tabs. Adjust sharpening of dark and light areas using these tabs. If

the dark or light sharpening halos appear too strong, reduce them with these

controls, which are only available for 8-bits and 16-bits-per-channel images:

Fade Amount: Adjusts the amount of sharpening in the highlights or shadows.

Tonal Width: Controls the range of tones in the shadows or highlights that are

modified. Move the slider to the left or right to decrease or increase the Tonal

Width value. Smaller values restrict the adjustments to only the darker regions

for shadow correction and only the lighter regions for highlight correction.

Radius: Controls the size of the area around each pixel that is used to determine

whether a pixel is in the shadows or highlights. Moving the slider to the left

specifies a smaller area, and moving it to the right specifies a larger area.
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1.  With the image still open from the previous exercise, choose Filter > Sharpen >

Smart Sharpen.

2. Set the following parameters in the Smart Sharpen dialog box:

Amount: 15%

Radius: 2.0 pixels

Reduce Noise (if applicable): 10%

Remove: Lens Blur

Check the More Accurate check box (if applicable)

3. Click OK.

Features appear to have more detail when compared to the image prior to sharpening.

Again, this will involve some trial and error if the results are not satisfactory,

experiment with settings if more sharpening is needed.
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15 Glossary

Advanced Import

Advanced Import provides a way to import multiple images that can comprise of

different formats and different coordinate systems.

Channel Management

Geographic Imager Channel Management allows you to control channel mapping and

assignment of channel color roles for false-composite multiband imagery. 

control pair

When georeferencing, a control point has both pixel (x,y) coordinate and world

coordinate specified is considered a control pair.

control point

In georeferencing, a point on the map with known pixel (x,y) coordinates.

coordinate system

Coordinate systems enable geographic datasets to use common locations for

integration. A coordinate system is a reference system used to represent the locations

of geographic features, imagery, and observations such as GPS locations within a

common geographic framework. 

datasource objects

Individual entries in the geodetic datasource are known as data source objects.

Different types of data objects are available for different types of definition. Objects

contained in the geodetic data source are: Angular Units, Coordinate Systems, Datum

Transformations, Ellipsoids, Envelopes, Horizontal Datums, Linear Units, and Prime

Meridians.

destination coordinate system

The coordinate system of the destination image. For example, the coordinate system

of an image after transformation. 

DEM

A Digital Elevation Model (DEM) is a representation of ground surface topography or

terrain and is generally represented as a raster or as a triangular irregular network

(TIN). DEMs are often used for shaded relief maps.
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coordinate system

A coordinate system provides the basis for identifying locations on the earth's surface.

custom coordinate system

A user defined coordinate system with custom parameters .

GeoCrop

A Geographic Imager tool that crops spatial images based on crop areas defined by

pixel coordinates, by geographic coordinates, by using a coordinate system envelope,

by proximity, or by extents of a vector file.

geodetic datasource

An extensive geodetic parameter database included in Geographic Imager. It contains

all the latest updates from the widely used EPSG Geodetic Parameter Dataset

maintained by the Geodesy Subcommittee of OGP (International Association of Oil and

Gas producers) as well as custom systems maintained by Avenza.

geographic coordinate system

Geographic coordinate system locations are defined in terms of the position on a globe

using latitude and longitude values. The angles of latitude and longitude are based on

a point at the centre of the earth. As the earth is not a perfect sphere a number of

globes (spheres, spheroids) exist in mapping each with slightly different centre points

and characteristics. As locations are defined by degrees, distances cannot be

accurately measured. The most common geographic coordinate system is the World

Geodetic System 84 (WGS84).

Georeference

A Geographic Imager tool used to reference or rectify images. The tool allows you to

reference or rectify images.

map package

A folder that contains files compatible with the PDF Maps app. A map package can be

uploaded by a vendor to be put for sale on the PDF Maps Store.

Mosaic

A Geographic Imager tool that creates a single composite georeferenced image from

multiple input georeferenced images.
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PDF Maps

PDF Maps is a mobile map application that allows users to download maps for offline

use on an iOS or Android smartphone or tablet.

PDF Maps Store

The PDF Maps Store is an in-app map store that contains more than 150,000 maps for

sale.

projected coordinate system

Projected coordinate system locations are defined using Cartesian x, y coordinates on

a flat, two-dimensional surface. This enables accurate measurements of distance,

angles and areas. Projected coordinate systems are based on a sphere (for example

WGS84) that is projected onto a flat plane. Projected coordinate systems are often

referred to as projections. Common projected coordinate systems include Universal

Transverse Mercator (UTM) and Lambert Conformal Conic.

Rectify

In the Georeference tool, the process of applying a transformation method to an

image, often to remove distortion. Image rectification may involve rotating, scaling,

and skewing the image.

Reference

In the Georeference tool, the process of aligning geographic data to a known

coordinate system.

reference file

A file that contains the relationship between source image coordinates (pixel locations)

and real-world reference coordinates (lat/long or other real-world coordinate units).

Common reference files include World files, Blue Marble Reference files, MapInfo Tab

files, and ER Mapper Reference files. Some reference file formats can hold additional

information such as coordinate system information.

scripting

A series of commands that tells Adobe Photoshop to perform a set of specified actions,

such as applying different filters to selections in an open document. Scripts automate

repetitive tasks and are often used as a creative tool to streamline tasks that might

be too time consuming to do manually.
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shaded relief

Shaded relief, or hill-shading, simulates the cast shadow thrown upon a raised relief

map.

source coordinate system

The coordinate system of the original image. For example, the coordinate system of an

image before transformation.

Terrain Shader

A Geographic Imager tool that is used to create the look of shaded relief.

Transform

A Geographic Imager tool used to specify a destination coordinate system for image

transformation (projection).

Tile

A Geographic Imager tool that creates multiple images from a single image.

web tiles

Image tiles that can be used for online map purposes. Google Maps, Bing Maps,

OpenStreetMap, Tile Map Service, and MapBox formats are supported.
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16 Technical Support Options

Consult Geographic Imager help as well as the following online options before

contacting Avenza technical support. 

Geographic Imager User Forum

The Geographic Imager User Forum is located at http://www.avenza.com/forum.

Answers to common technical questions may be found in the Common Support Issues

and FAQs category. All users with a Geographic Imager license (evaluation or

permanent) can post and read topics under the General Questions for Evaluation &

Licensed Users category. Additionally, users with maintenance have access to the

Maintenance Users category. There, users can find additional information relative to

software updates and other important details pertaining to maintenance.

Contacting Avenza Technical Support

Avenza offers a number of methods for direct communication with our qualified and

experienced technical experts. Please have your Geographic Imager registration

details handy to get prompt attention and include it in any e-mail correspondence.

Support issues are handled on a first come, first-served basis. There is a charge of

$49USD per incident for non-maintenance program users.

E-mail: support@avenza.com 

Web: www.avenza.com/support

Online form: www.avenza.com/support/form

User forum: www.avenza.com/forum

Phone:  1 (416) 487-6442

Geographic Imager Maintenance Program (GMP)

Your Geographic Imager purchase includes a one-year membership in the Geographic

Imager Maintenance Program. Enjoy worry-free use of Geographic Imager and all the

benefits of the GMP. All GMP subscriptions begin on the date of purchase.

Maintenance users can post questions under the Maintenance Users category of the

Avenza user forum where Avenza support staff will be happy to post solutions and

answers. The Geographic Imager Maintenance Program is guarantees its members:

http://www.avenza.com/forum
mailto:support@avenza.com
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Unlimited priority technical support—guaranteed same business day (9am to 4pm

EST) or next business day response

GMP only telephone support

Free Geographic Imager updates

Free Geographic Imager version upgrades

Additional discounts and offers only available to GMP members

For GMP subscribers, you will be notified about the latest news and updates about

Geographic Imager. If you purchased your Geographic Imager license from a reseller or

are the end user but not the person who purchased the software,  please contact us

at sales@avenza.com to ensure that we add your e-mail address to the GMP email

group.

Maintenance Renewal

Approximately 6-8 weeks prior to the expiration of your annual GMP subscription you

will be notified regarding renewal options. You will be contacted a minimum of five

times prior to expiration in order to ensure that you have ample opportunity to renew

or not at your discretion. You will have the option of renewing your GMP for an

additional year at the then prevailing price or canceling without penalty. Of course, if

you cancel or let your GMP lapse you will no longer be entitled to the benefits of the

program as outlined above and will thus have to purchase future upgrades at the

upgrade price.

There is a grace period of approximately 30 days from the time of the GMP expiry

during which you may still renew without penalty. All post-expiration renewals will be

backdated to the actual expiry date.

Lapsed Subscriptions

Failure to renew your GMP within 30 days from the expiry date will result in a lapsed

GMP subscription. Lapsed subscriptions may not be renewed and the licensee will be

required to purchase support and upgrades accordingly. Please direct all GMP

questions and purchase inquiries to sales@avenza.com.

Wishlist
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As either a new or experienced Geographic Imager user we value your opinions on how

we can improve our product. Let us know what functions you would like to see

incorporated into future versions of Geographic Imager. Post to our user forum with

the subject "Feature Request" at www.avenza.com/forum.
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17 Copyright Information

Copyright  ©2005–2015 Avenza® Systems Inc. All rights reserved.

Geographic Imager 5.0 for Adobe® Photoshop® User Guide for Windows® and Mac®.

Geographic Imager® is a registered trademark of Avenza Systems Inc. Adobe, Adobe

Photoshop and Adobe Illustrator are trademarks of Adobe Systems Inc. or its

subsidiaries and may be registered in certain jurisdictions. Blue Marble Geographics,

GeoTransform and The Geographic Transformer are trademarks of Blue Marble

Geographics. All other software product names and brands including trademarks or

registered trademarks are the property of their respective owners.

This manual and the software described in it are furnished under license and may be

used or copied only in accordance with the terms of such license.  The content of this

manual is furnished for informational use only, is subject to change without notice and

should not be construed as a commitment by Avenza Systems Inc. or its related

companies or successors. Avenza Systems Inc. assumes no responsibility or liability for

any errors, omissions or inaccuracies that may appear in this book.  

Except as permitted by such license, no part of this publication may be reproduced,

stored in a retrieval system, or transmitted, in any form or by any means, electronic,

mechanical, recording, or otherwise without prior written approval of Avenza Systems

Inc.

Geographic Imager is protected by U.S. Patent No. 9,063,950. Raster transformation

powered by GeoTransform (r) (c) 2015 Blue Marble Geographics. All Rights Reserved.

Portions of this computer program are copyright (c) 1995-2015 Celartem, Inc., doing

business as LizardTech. All rights reserved. MrSID is protected by U.S. Patent No.

5,710,835. Foreign Patents Pending. Portions of this computer program are copyright

(c) 2007 Leica Geosystems Geospatial Imaging, LLC. All rights reserved.  Creating

compressed files using ECW technology is protected by one or more of U.S. Patent No.

6,201,897, No. 6,442,298 and No. 6,633,688.
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18 License Agreement

AVENZA SYSTEMS INC. SOFTWARE LICENSE AGREEMENT

The software is subject to the terms and conditions detailed in the following license

agreement. Please read the following license carefully.

NOTICE: Avenza Systems Inc. ("Avenza") licenses the accompanying software to you

only upon the condition that you accept all of the terms contained in this license

agreement. If you do not agree to these terms and conditions, then Avenza is unwilling

to license the software to you, in which case you should not use the software and

remove the software from your system. By installing the software you accept all the

terms and conditions of this agreement.

LICENSE: The software which accompanies this license (the "Software") is the

property of Avenza Systems Inc. and is protected by copyright law. While Avenza

continues to own the Software, you will have certain limited rights to use the

Software after your acceptance of this license. Your rights and obligations with

respect to the use of this Software are as follows:

You may: i. use one copy of the Software on a single computer; ii. make one copy of

the Software for archival purposes, or copy the software onto the hard disk of your

computer and retain the original for archival purposes;

You may not: i. copy the documentation which accompanies the Software; ii.

sublicense, rent or lease any portion of the Software; or iii. reverse engineer,

decompile, disassemble, modify, translate, make any attempt to discover the source

code of the Software, or create derivative works from the Software.

WARRANTY DISCLAIMER: Avenza makes no representations or warranties about the

suitability of this software for any purpose. The software is provided "as is"; without

express or implied warranties, including warranties of merchantability and fitness for a

particular purpose or non-infringement. This software is provided gratuitously and,

accordingly, Avenza shall not be liable under any theory or any damages suffered by

you or any user of the Software.

DISCLAIMER OF DAMAGES: Regardless of whether any remedy set forth herein fails of

its essential purpose, in no event will Avenza be liable to you for any special,
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consequential, indirect or similar damages, including any lost profits or lost data arising

out of the use or inability to use the software even if Avenza has been advised of the

possibility of such damages.

COMPLIANCE WITH APPLICABLE LAW: You agree to abide by the copyright law and all

other applicable laws of Canada including, but not limited to, export control laws. You

acknowledge that the Software in source code form remains a confidential trade

secret of Avenza and/or its suppliers and therefore you agree not to modify the

Software or attempt to decipher, decompile, disassemble or reverse engineer the

Software, except to the extent applicable laws specifically prohibit such restriction.

TERMINATION: Avenza may terminate the right to use the Software on notice to you

(which may be delivered electronically by the same means as this Software is

distributed), and you may terminate this license at any time by destroying or erasing

your copy of the Software. Upon the termination of this license, you must discontinue

all use of the Software and remove the Software from your system. Avenza reserves

the right at any time to cease the support of the Software and to alter prices,

features, specifications, capabilities, functions, licensing terms, release dates, general

availability or other characteristics of the Software.

Geographic Imager is protected by U.S. Patent No. 9,063,950. Raster transformation

powered by GeoTransform (r) (c) 2015 Blue Marble Geographics. All Rights Reserved.

Portions of this computer program are copyright (c) 1995-2015 Celartem, Inc., doing

business as LizardTech. All rights reserved. MrSID is protected by U.S. Patent No.

5,710,835. Foreign Patents Pending. Portions of this computer program are copyright

(c) 2007 Leica Geosystems Geospatial Imaging, LLC. All rights reserved.  Creating

compressed files using ECW technology is protected by one or more of U.S. Patent No.

6,201,897, No. 6,442,298 and No. 6,633,688.

Avenza Systems Inc.

124 Merton Street, Suite 400

Toronto, Ontario, Canada

M4S 2Z2

http://www.avenza.com

(416) 487-5116
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